
 

 

 

 

 

 

 

 

Flash Floods In The Geul Catchment: 

To What Extent Could Potential 

Mitigation Measures In the Boven 

Geuldal Belgium Reduce The Effects? 
 

Research Thesis 
Final Version 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Author: Jafeth Kuiper 

1st Supervisor: prof. dr. V. Jetten 

2nd Supervisor: dr. B. Van den Bout 

Scientific Advisor: dr. N. Asselman 
 

 

13/11/2023  



 

 

Summary 
This study analyses a part of the flash floods that took place in July 2021 in the Netherlands, Belgium 

and Germany. Extreme rainfall on 13 and 14 July resulted in significant 48-hours precipitation totals, 

with in some locations even exceeding 200 millimetres of rainfall. The return period of the event is 

estimated to be approximately 500 years (Asselman & Van Heeringen, 2023). The damage in the 

Netherlands is currently estimated to be 1.8 billion euros of which the largest part is caused along the 

tributaries of the Meuse, and in particular in the Geul catchment. The Geul catchment has a surface area 

of 380 km2 and is a cross-boundary river which is partly located in the Netherlands (South-Limburg, 

52%), Belgium (42%) and Germany (6%). A report from Natuurmonumenten (2022) shows that the 

Boven Geuldal Belgium, which is the most upstream part of the Geul catchment, was a relatively large 

contributor to the flood wave. It accounts for approximately 50% of the peak discharge in the 

Netherlands, while it has only a surface area percentage of 20% of the total Geul catchment. The 

relatively high outflow percentage of 48% shows that a large part of the rainfall turned into overland 

flow in this sub-catchment, much more than Dutch sub-catchments which had outflow percentages of 

around 20%. Despite this, almost all research related to the flash floods is focused on the Dutch part of 

the Geul catchment.  

 

This study focusses on the Boven Geuldal Belgium (in short: Boven Geul) regarding the July 2021 flash 

flood event. It addresses the knowledge gap on what caused the high outflow percentage and what the 

quantitative effect of detailed flood mitigation measures would be on the outflow to the Geul. An 

important complexity comes with the effect of the measures since the effect on the outflow could be 

different from the local effect within the sub-catchment. Therefore, the main objective of this study is: 

 

“To analyse to what extent potential flood mitigation measures in the Boven Geuldal Belgium 

sub-catchment could reduce the outflow to the Geul while also addressing local flooding 

problems.” 

 

The study is divided into three parts aligning with the sub-objectives. The first part is related to Soil 

Infiltration Analysis to analyse the differences in infiltration characteristics between soils under 

different Land Use Land Cover (LULC) classes. The second concerns about how the water system of 

the Boven Geul functioned during the flood event. Here, an OpenLISEM flood model schematization 

is calibrated to the measured discharges in the sub-catchment. In the third part, mitigation strategies are 

analysed by simulating them with the calibrated model schematization. 

 

The spatial variation of different soil hydrological properties (Saturated Hydraulic Conductivity (Ksat), 

Porosity, Bulk Density, Soil Organic Matter (SOM) content) has been measured across different LULC 

classes (Maize land, Grassland, Forest) in the Boven Geul (37 samples)1. The soil samples are collected 

at the ground surface, which resulted into extreme Ksat values. The results show a clear difference 

between the soil sample values of the Bulk Density, Porosity and SOM content across the LULC classes. 

The resulting Ksat values do not show a clear difference between the Grassland samples and the Maize 

samples, which have both very high values (> 100 mm/h) and relatively small values (< 1 mm/h). The 

Ksat values of the Forest samples consistently exhibit high values (> 100 mm/h). In general, this study 

shows that the upper 6 centimetres of the soil, particularly under Forest, has a relatively high SOM 

content. This leads to a high Porosity and high Ksat, indicating that the upper part of the soil has the 

capacity to quickly infiltrate and store a significant volume of water. 

 

The calibrated OpenLISEM flood schematization of the Boven Geul has a Nash-Sutcliffe Efficiency of 

0.90 which indicates a good fit. The simulation results of this Reference Scenario show that the 

dominant overland flow mechanism is Saturated Overland Flow. The saturation of the topsoil leads to 

extreme discharge levels, explaining the high outflow percentage from this sub-catchment.  During the 

 
1 NOTE: the resulting values are not used to adjust the soil properties in the model schematization, since the results have a too 

high variance to be able to make reasonable adjustments. 



 

 

initial stage of the flood event (until 14 July 12:00), 72% of the rainfall infiltrates into the soil: 60 

millimetres of infiltration compared to 84 millimetres of rainfall. After this moment, as the topsoil 

becomes saturated, only 25% of the rainfall is infiltrated into the soil: 23 millimetres of infiltration 

compared to 91 millimetres of rainfall. As a result of this, the LULC class Grassland (surface area 

percentage: 54%) makes the largest contribution to the total runoff in the Boven Geul (60%). Which is 

significantly more than the runoff from Built-Up areas (23%), which have a surface area percentage of 

14%. 

 

Two LULC scenarios are simulated with the OpenLISEM flood schematization: a Forest and Paved 

Scenario. These scenarios are not very realistic, but they serve two reasons: (1) gaining insight about 

how the Boven Geul water system works and (2) to determine the maximum effect of potential LULC 

changes on outflow and local flooding. The Paved Scenario is a worst-case scenario in which the Boven 

Geul completely consists of hard surfaces leading to zero infiltration. In this scenario, the discharge 

levels rapidly increase to extreme levels directly from the start of the event. The difference with the 

discharge curve of the Reference Scenario shows the effect of the soil infiltration in the initial stage, 

leading to significantly lower discharge levels in the Reference Scenario. However, as the topsoil 

saturates, this effect becomes less. After 14 July 12:00, the discharge curve of the Reference Scenario 

(peak discharge: 59.9 m3/s) starts to resemble the discharge curve of the Paved Scenario (peak 

discharge: 79.6 m3/s) relatively closely. The Forest Scenario on the contrary, in which all Grassland and 

Cropland is turned into Forest, leads to much more infiltration because of the higher Ksat and Porosity 

of the Forest soils. The Forest Scenario decreases the peak discharge from 59.9 m3/s to 22.3 m3/s, which 

shows the great potential that Forest has in reducing the peak flows. 

 

The proposed Dam Strategies aim to reduce the peak outflow of the Boven Geul by delaying and storing 

excess discharge at several locations along the channel where it poses minimal to no harm. The Dam 

Strategies consist of multiple small dams across the river floodplain including a culvert that allows a 

certain maximum discharge. In this way, the Dam Strategies do not affect the discharge wave at low 

and moderate discharge levels. In fact, they only address the extreme discharge levels. The simulations 

show that the Dam Strategies are very effective in reducing the peak outflow from the Boven Geul. 

Dam Strategy 2, consisting of 7 small dams, results in a peak discharge reduction from 59.9 m3/s to 

36.2 m3/s and consequently, significantly decreases flooding along the channel. However, the Dam 

Strategies do not significantly decrease the number of flooded buildings, meaning that they are not very 

effective in addressing local flooding problems. 

 

In conclusion, this study demonstrates that flood mitigation strategies in the Boven Geul Belgium have 

great potential in reducing the peak outflow to the (Dutch part of the) Geul. The results show that the 

proposed mitigation strategies significantly reduce the peak outflow from the Boven Geul. Additionally, 

the strategies significantly reduce flooding along the Boven Geul channel, even at several critical 

locations. However, they are not effective in addressing local flooding problems within the Built-Up 

areas. Therefore, the main recommendation for future research is to investigate the impact of combining 

strategies (Dam Strategies, Afforestation) that further reduce the outflow with strategies that mitigate 

local flooding issues within Built-Up areas (e.g. retention ponds). 
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1 Introduction 

1.1 Motivation and Background 

Flooding is one of the most impactful natural disasters in the world, affecting many people and regularly 

causing devastating damage (Munich Re, 2022; WHO, 2022). In the period 1998-2018, more than 2 

billion people were affected worldwide by floods (WHO, 2022). In 2021, floods resulted in 

approximately 77 billion euros of losses. The effects have already increased significantly over the last 

decades and they will only increase more in the future due to climate change, a growing population and 

more economic activities in flood-prone areas (IPCC, 2022; Jongman et al., 2012; WMO, 2021). 

According to Winsemius et al. (2015), the global losses could be 20 times as much by the end of the 

century when no action is taken. 

 

1.1.1 Flash Floods 
Flash floods are one of the most common type of floods and are usually caused by short intense rainfall 

events (WHO, 2022). The intense rainfall leads to overland flow when it exceeds the surface’s 

infiltration capacity and/or the storage capacity. This can happen at any location both rural and urban, 

it does not necessarily take place close to a river (Prokešová et al., 2022). Flash floods are usually 

happening in smaller catchments (less than 1000 km2) with short response times (Marchi et al., 2010; 

Prokešová et al., 2022). They are happening within a short time frame after a precipitation event and 

the short response time and excessive rainfall result in quickly rising water levels (Bout & Jetten, 2018b; 

Camp, 2022; Kobiyama & Goerl, 2007). This makes it difficult to prepare and react to them. Especially 

hilly urban areas are vulnerable to flash flooding. The impervious surfaces result in a larger runoff 

volume and the elevation differences, road grids and sewer networks make the surface runoff even 

quicker causing deeper and faster rising water levels (Bout & Jetten, 2018b; COMET, 2011). The 

frequency and intensity of these flash floods are only increasing in the future as a result of urbanization 

and intensifying rainfall due to climate change (IPCC, 2022; WHO, 2022). The long-term variability in 

flash flood processes must be understood to prevent increasing damage in the future. 

 

Several factors determine the intensity of a flash flood. The dynamics are strongly related to the rainfall 

characteristics, but the hydrologic response to rainfall is also dependent on the storage and infiltration 

capacity of the ground surface, and the degree to which water is slowed down. This is influenced by the 

soil properties, geology, land use/land cover (LULC) and other catchment characteristics (Bout & 

Jetten, 2018b; COMET, 2011; Prokešová et al., 2022). The greater the storage capacity of the ground 

surface, the more water can infiltrate, leading to reduced overland flow and a slower hydraulic response 

of the catchment. The soils storage capacity is mainly determined by the soil moisture, soil depth and 

geology (COMET, 2011; Sen, 2022). The deeper the soil and the more permeable the layer of rock 

underneath the soil, the higher the storage capacity. The soil moisture determines how much water still 

can infiltrate in the soil before the soil is saturated. In flash floods, it is common that overland flow 

occurs before the storage capacity is reached. This is when the rainfall intensity exceeds the infiltration 

capacity of the ground surface (COMET, 2011). The infiltration capacity mainly depends on soil 

properties (hydraulic conductivity, soil moisture), LULC and the slope (Cretu et al., 2006). The soil 

hydraulic conductivity determines the ability of water to pass through the soil, which differs dependent 

on the level of saturation (Campbell et al., 2022; Pacle, 2022). LULC influences how covered and 

compacted the underlying soil is. For example, urban areas often consist of paved surfaces which do 

not allow water to infiltrate (Bout & Jetten, 2018b). And usage of heavy machinery on croplands can 

lead to soil compaction, decreasing the infiltration rate of the soil (Sen, 2022). Natural vegetation like 

grassland and forest generally has significantly higher infiltration rates. Overland flow during flash 

floods can lead to high water levels downstream in lower elevated areas. The height of these water 

levels depends on how much the water is slowed down on its way. This is determined by factors such 

as surface roughness, slope, human interventions and other obstacles.  
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1.1.2 July 2021 Flash Floods in the Netherlands, Belgium, Germany and 

Luxembourg 
This study focusses on the flash floods that happened in July 2021 in the Netherlands, Belgium, 

Germany and Luxembourg. Extreme rainfall on 13, 14 and 15 July resulted in significant 48-hours 

precipitation totals, with some areas even exceeding 200 mm (Asselman & Van Heeringen, 2023). 

Figure 1.1 shows the spatial variation of the precipitation sums between 13 July 10:00 and 15 July 

10:00. The event was extremely rare both because of its large extent and its large precipitation sums 

(Klein, 2022). The most extreme rainfall fell in Belgium and Germany causing devastating damage and 

fatalities. These floods were the second-most costly natural disaster of 2021, with costs estimated to be 

38 billion euros at the end of 2021 (Christian Aid, 2021). The largest losses were in Belgium and 

Germany, which also had 240 fatalities. The damage in the Netherlands is currently estimated to be 1.8 

billion euros (Waterschap Limburg, 2022). The largest part of this damage is caused along the tributaries 

of the Meuse, and in particular in the Geul catchment (ENW, 2021). 
 

 

Figure 1.1. Precipitation sums (mm) between 13 July 10:00 and 15 July 10:00 (48-hour sum) during the Flash Flood Event 

in 2021 (Source: (Asselman & Van Heeringen, 2023)) 

The Geul catchment, which is the area of interest in this study, is a cross-boundary river which is partly 

located in the Netherlands (South-Limburg, 52%), Belgium (42%) and Germany (6%) (see Figure 1.2) 

(Klein, 2022). It has a surface area of 380 km2 and a steep slope compared to rivers in the rest of the 

Netherlands (de Moor & Verstraeten, 2008; van Heeringen et al., 2022). During the July 2021 floods, 

the average amount of rainfall in the Geul catchment was equal to 128 mm in 48 hours. This corresponds 

to a return period of 900 years with average Dutch statistics, but when considering orographic effects 

(higher rainfall amounts are more common in hilly terrain than in flat areas) the return period would be 

about 500 years (Asselman et al., 2022). According to Asselman et al. (2022), the frequency of these 

type of events could increase in the future to a factor 3 in 2050 and even a factor 6 in 2080 as a result 

of climate change.  
 

What is remarkable, is that the Belgium part of the Geul catchment generated much more water than 

the Dutch part. The flood wave resulting from the rainfall consisted for about 65-75% of water coming 

from upstream Cottessen (a measuring station at the border between Belgium and the Netherlands) 
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(Natuurmonumenten, 2022). The most upstream part of the Belgium part of the Geul catchment was 

the largest contributor with 50% of the water of the flood wave (also at least 50% of the discharge peak), 

while it covers only 20% of the surface area of the total catchment. This is the sub-catchment Boven 

Geuldal Belgium, which is upstream of the Kelmis measuring station (see Figure 1.2). The runoff per 

unit area for this part is estimated to be 2.5-3.5 times more than the Dutch part (Natuurmonumenten, 

2022). There are some significant differences in characteristics between the Boven Geuldal Belgium 

and the Dutch part of the Geul catchment which probably influenced the runoff. These have been 

extensively described by Natuurmonumenten (2022). The Boven Geuldal Belgium mainly consists of 

an impermeable geological subsurface and very shallow soils, while the geological subsurface of the 

Dutch part is much more permeable and the soils are thicker. On the contrary, there is more natural 

vegetation (grassland and forest) in the Boven Geuldal Belgium compared to the Dutch part, which is 

favourable for the infiltration. The higher runoff contribution of the Belgium part is probably a 

combination of the shallow soils on impermeable rocks and the higher amount of rainfall.  

 

Figure 1.2. Elevation Map and Location of the Geul Catchment (Source: (Klein, 2022)). 
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1.1.3 Measures Regarding Flash Floods 
Measures regarding flash floods generally focus on reducing the overland flow and the peak discharge 

levels downstream. This can be done by increasing the infiltration into the soil, the storage capacity or 

by slowing down or temporarily storing the water (Gunnell et al., 2019). Traditional protection 

measures such as dikes and flood barriers do not work for a part of the problem because these prevent 

rivers from overflowing, while flash floods already cause problems before the water reaches the river. 

These traditional protection measures could effectively mitigate local river flooding issues; however, 

they result in a higher downstream discharge, increasing flooding problems in downstream areas. The 

following sections describe mitigation measures that are common for flash floods. 

 

Land Use Land Cover Changes 

Land Use is the way how humans use the land and Land Cover is related to the physical material that 

is actually present at the earth’s surface (EEA, 2022) (EPA, 2022). The Land Use and Land Cover 

(LULC) play a significant role in determining the extent of water infiltration and how much the water 

is delayed, thereby exerting a substantial impact on overland flow and runoff during a flash flood. This 

impact differs per LULC class. Generally, the infiltration rate of soils increases from Cropland to 

Grassland to Forest (Robinson et al., 2022). Changes in LULC could thus help to reduce the effects of 

flash floods. However, they could also increase the effects of flash floods when for instance natural land 

use is replaced by hard surfaces, which have very little to no infiltration. The increasing urbanization is 

an important LULC change negatively influencing the effects of flash floods. 

 

The downside of using LULC changes as flood mitigation measures is that land is owned by someone. 

Implementing LULC changes on this land is a very costly and complicated process, which is dependent 

on the willingness to cooperate of the landowner. Another increasingly popular measure related to land 

use is to increase the infiltration rate of cropland by adjusting agricultural techniques and methods 

(Basche & DeLonge, 2019). 

 

Water Retention Basins 

Water retention basins are designed to store and slow down the water during intense rainfall events 

(NWRM, 2022) (van Heeringen et al., 2022). They thus function as a buffer during flash floods in order 

to reduce the water levels downstream. In the past decades, Waterschap Limburg made approximately 

400 water retention basins (“regenwaterbuffers”) in South Limburg (Van Heeringen et al., 2022). They 

are constructed at locations where water concentrates; this can be in a tributary of the Meuse, for 

instance the Geul or Roer, but also in a valley, natural depression or system of ditches. The water 

retention basins in the Netherlands are mainly designed to slow down water to flatten the peak discharge 

rather than storing water, since the storage capacity is not that much (around 1500-3000 m3) 

(Winteraeken & Spaan, 2010). They are designed such that a full reservoir empties within 24 hours by 

releasing water through a culvert. An additional function of the water retention basins in the Netherlands 

is capturing sediment before it causes additional damage. The construction of these water retention 

basins was a long process for which first land consolidation was used (Baas, 2021). It is quite time 

consuming because every water retention basin is different and made for local circumstances. In the 

Belgium part of the Geul catchment there are no water retention basins (Klein, 2022). 

 

Room for the River 

Room for the River is a program that has created more room for the main rivers in the Netherlands in 

order to reduce the flood risk; by using and altering the flood plain, to make better use of natural high 

water storage conditions (Rijkswaterstaat, 2022). This concept of making more room for rivers is also 

a potential mitigation measure for tributaries such as the Geul. The Geul river could for example be 

widened at some locations or it could be flooded at locations where it would result into little problems. 

This will help to reduce flooding problems downstream. 

 

  



5 

 

1.2 State of the art  

1.2.1 Studies Related to the July 2021 Floods in the Geul Catchment 
The July 2021 floods resulted in a lot of research related to this rare event. Many experts investigated 

what exactly happened during the event, why this happened and what possible measures could reduce 

the effects of such an event in the future. Shortly after the floods, ENW (2021) presented a first fact-

finding study about the event, the causes and the consequences. Deltares presented an initial analysis in 

2022 covering four case studies, commissioned by Waterschap Limburg (Asselman et al., 2022). This 

report investigates at a more detailed level what happened during the event and what measures could 

be possible. The underlying technical reports on the two case studies in the Geul catchment (Valkenburg 

and Geulmonding) give a more elaborate description and analysis (de Jong & Asselman, 2022; van 

Heeringen et al., 2022). Thereby, possible measures are specified in more detail and their effects are 

quantified. Natuurmonumenten (2022) has conducted an analysis of the entire Geul catchment in which 

they evaluate the runoff contribution from the various sub-catchments and make qualitative 

comparisons between these sub-catchments based on factors that influence the overland flow. This 

report considers the entire Geul catchment, including the Belgium part, unlike the case study reports. 

Additionally, the report includes a qualitative analysis of Nature Based Solutions (NBS) that could be 

effective per sub-catchment area. It should be pointed out that all these reports are all mainly qualitative 

or based on basic calculations because of the short time span within which the analysis had to be done. 

In January 2023, Deltares presented an elaborated water system analysis related to the July 2021 flash 

floods. This study is very complete and contains detailed analysis of what happened during the event in 

the Dutch catchments in Zuid-Limburg (Geul, Roer, Geleenbeek) and how the water systems 

functioned. Thereby including quantitative analysis of several measures. As for the Belgium studies, 

they primarily concentrate on the Vesdre catchment in Belgium since most of the damage occurred 

there. 

 

The July 2021 floods are also the topic of research in several MSc theses. The impact of many different 

measures for the Dutch part of the Geul catchment has been quantified by Van Dijk (2022). Suijkens 

(2022) identified a lack of knowledge regarding the quantitative effect of private flood mitigation 

measures and addressed this gap by quantifying this effect for the Dutch part of the Geul catchment. 

Klein (2022) developed a hydrological model of the entire Geul catchment that can predict the 

hydrologic response to extreme precipitation events reasonably well (grid size: 600m x 925m). The 

individual contributions of different sub-catchments and their rainfall-runoff relationships are compared 

with this model. Mohammed (2022) also developed a hydrological model of the entire Geul catchment, 

but at a much higher resolution of 30 metres. This model is used to quantify the effects of potential 

measures such as buffers, afforestation and room for the river. Tsiokanos (2022) looked more into the 

past and did a trend analysis for the Geul catchment in order to investigate how climate variability and 

land use changes have impacted the runoff (since 1970). 

 

1.2.2 Studies Related to Effect of Potential Mitigation Measures on Flash 

Floods 
The following sections provide a short interview of research that is done to the effects of potential 

mitigation measures (LULC changes, water retention basins) on flash floods. On the one hand, they 

emphasize that extensive research has been conducted on the effects of potential mitigation measures. 

However, they also highlight that these effects are dependent on the characteristics of a catchment.  

Every catchment is unique and requires a local analysis of what measures would be effective.   
 

Studies Related to Effect of LULC Changes on Flash Floods 

The effects of LULC changes regarding runoff and flash flooding have been researched a lot. The effects 

of different land use classes and dominant changes in the past (such as urbanization) have been the topic 

of many studies (Adane et al., 2022; Bathurst et al., 2011; Brown et al., 2005; Farahmand et al., 2007; 

Hundecha & Bárdossy, 2004; Kumar & Dhorde, 2020; O’Connell et al., 2004; G. Yang et al., 2010; L. 

Yang et al., 2013, 2015). Also the effects of potential LULC changes in the future (such as afforestation) 
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have been studied thoroughly (Bulygina et al., 2009, 2011; Jackson et al., 2008; Maciej Serda et al., 

2012; McIntyre et al., 2014; Salazar et al., 2012). The general impact of LULC changes is understood, 

but the exact effects of LULC changes remain complex, because of their dependence on multiple factors 

(O’Connell et al., 2004). For example, Bathurst et al. (2011) concluded that the effect of forest cover 

on peak discharge reduction is dependent on the characteristics of the hydrological event and the size 

of the catchment. Additionally, Salazar et al. (2012) identified the antecedent soil moisture condition 

and the spatial distribution of the LULC changes as significant factors. Other catchment characteristics 

such as soil type and relief also play a significant role in the effect of LULC changes between different 

catchments. Every catchment is unique, which makes the quantification of LULC change effects not 

universally applicable.  
 

Studies Related to Effect of Water Retention Basins on Flash Floods 

The concept of water retention to reduce effects of floods is widespread and considered in many studies 

(Bartos & Kerkez, 2019; Reinhardt et al., 2011; Rohmat et al., 2022; Salazar et al., 2012; Tügel et al., 

2020). The design of water retention measures differs a lot. Water retention basins differ in scale and 

are made based on local circumstances. It could be newly constructed, but a natural depression or 

retention volume behind existing obstacles could also be used. Generally, water retention basins help 

to reduce the effects of flash floods, but their specific effects are very dependent on the location and 

characteristics of the catchment. Steep valleys could for example obstruct the potential retention 

capacity. Thereby, the design of water retention basins can be different based on local circumstances 

and needs. In the Netherlands, the water retention basins mainly aim to slow down water to flatten the 

peak discharge curve rather than storing water (Winteraeken & Spaan, 2010). 
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1.3 Problem statement 

Wicked problems are very complex problems with many interdependent factors. They do not have a 

definitive solution, and the proposed solutions are not characterized as true or false but rather as good 

or bad (Rittel & Webber, 1973). The wickedness of problems can be expressed along two dimensions: 

the degree of knowledge uncertainty and the degree of consensus among the relevant stakeholders 

(Alford & Head, 2017). The wickedness could decrease by addressing the knowledge uncertainty and/or 

improving the consensus among the relevant stakeholders about potential solutions.   

 

The wickedness of the problem situation after the flash floods of July 2021 in the Geul catchment 

primarily arises from knowledge uncertainties. There are a lot of knowledge uncertainties regarding 

what exactly happened during the event and how effective potential mitigation measures could be in 

reducing the flash flood effects. Several Dutch analyses already contributed significantly to these 

uncertainties in knowledge, but they focused only on the Dutch part of the Geul catchment and/or did 

not have a high level of quantitative detail. The following paragraphs discuss the specific knowledge 

uncertainties that still exist, as well as several factors that further complicate the problem. 

 

There is still a significant knowledge gap around what exactly happened in the Belgium part of the Geul 

catchment during the flood event and why this part had such a substantial contribution to the flood 

wave. Especially the sub-catchment Boven Geuldal Belgium, in which approximately 50% of the 

rainfall turned into outflow from the sub-catchment (Natuurmonumenten, 2022). This sub-catchment 

has completely different characteristics than the Dutch part of the Geul. However, it remains unclear 

what specific processes caused this high runoff percentage, and understanding them is crucial for 

evaluating suitable mitigation measures. It could be that it is very difficult to significantly reduce the 

runoff from the Boven Geuldal Belgium because it is mainly dependent on fixed factors such as 

geology, soil type and depth, and relief. 

 

Another important knowledge uncertainty is regarding the quantitative effects of potential flood 

mitigation measures in the Boven Geuldal Belgium, and the extent to which the outflow to the Geul can 

be reduced. Current research investigates only general mitigation measures which are mostly located in 

the Dutch part of the Geul. Local characteristics could however affect the effectivity of these measures. 

The measures could for example be highly effective in the Dutch part of the Geul, while they are not 

effective or feasible in the Boven Geuldal Belgium. Another important complexity related to the 

implementation of measures is the potential contradiction between their impact on local flooding within 

the Boven Geuldal Belgium and the outflow from the sub-catchment. It could be that a measure 

significantly reduces the outflow from the Boven Geul, benefitting the entire Geul catchment; while it 

does not improve, or potentially aggravates, the situation within the sub-catchment itself.  

 

An important factor contributing to the knowledge uncertainties is that there is a lack of detailed 

quantitative information regarding this problem situation, which is also a common issue for other flash 

flood problems. A lot of studies currently done are mainly qualitative or based on models with low 

resolution and basic calculations with a lot of assumptions and no fieldwork.  
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2 Research Objectives and Questions 
This study focusses on the Boven Geuldal Belgium regarding the July 2021 flash flood event. The 

wickedness of the problem is addressed by decreasing the knowledge uncertainties related to what 

happened in this sub-catchment during the event and the quantitative effects of potential mitigation 

measures. The study considers the effects of potential flood mitigation measures on both the outflow to 

the Netherlands as well as the local flooding problems in the Boven Geuldal Belgium. The main 

objective is: 
 

“To analyse to what extent potential flood mitigation measures in the Boven Geuldal Belgium sub-

catchment could reduce the outflow to the Geul while also addressing local flooding problems.” 
 

Sub-objective 1: To determine the variation in soil hydrologic properties across different Land Use 

Land Cover classes (maize, grassland, forest) in the Boven Geuldal Belgium. 

1.1 What values are measured for the soil hydrologic properties (saturated hydraulic conductivity, 

bulk density, porosity and soil organic matter content) per each of the LULC classes (maize, 

grassland, forest) in the Boven Geuldal Belgium? 

1.2 What differences are observed in soil hydrologic properties between the various LULC classes?  
 

Sub-objective 2: To determine with an OpenLISEM flood schematization how the water system of the 

Boven Geuldal Belgium functioned during the flash flood event of July 2021. 

3.1 What parameterization of OpenLISEM results in the discharge curve that most closely replicates 

the measured discharge of the flood event?  

3.2 What are the dominant parameters and processes in the calibrated OpenLISEM flood 

schematization regarding the runoff and outflow in the Boven Geuldal Belgium? 

3.3 What are the most adverse and favourable effects of potential LULC changes on local flooding 

and the outflow of the Boven Geuldal Belgium? 
 

Sub-objective 3: To evaluate the effect of potential mitigation measures for the Boven Geuldal Belgium 

regarding both local flooding and the outflow from the sub-catchment. 

4.1 What is the effect of the design of a water storing and delaying flood mitigation strategy on 

local flooding within the Boven Geuldal Belgium and the outflow from this sub-catchment? 

4.2 Is there a contradiction regarding the flood mitigation strategy between what is optimal within 

the Boven Geuldal Belgium and what is optimal for the entire Geul catchment? 
 

Fieldwork is conducted to gain insight into the catchment and to measure the values of various soil 

properties, thereby assessing the influence of Land Use Land Cover (LULC) on these properties2. 

Fieldwork is also used to visit flooded locations, inspect the surface drainage networks with bridge and 

culvert locations and it later served to identify potential locations where proposed mitigation measures 

would be feasible without causing harm to properties and infrastructure. Moreover, interviews were 

done with several stakeholders (see Section 5.5). 
 

In order to be able to make detailed quantifications, a high-resolution model schematization of the 

Boven Geuldal Belgium is developed for the flash floods of July 2021. This is done at 20 metres 

resolution with the OpenLISEM software. The schematization is calibrated to measured discharge data 

of the flood event available for the outlet point of the Boven Geuldal Belgium. The schematization is 

then used to determine what processes were dominant in the Boven Geuldal Belgium during the flood 

event; and to evaluate the effect of potential mitigation measures. Two extreme LULC scenarios are 

simulated to gain insight in how the catchment functions and to determine how effective potential LULC 

changes could be in reducing local flooding and outflow. The study focusses on a flood mitigation 

strategy focusses that delays and stores water in the landscape at locations where this poses minimal to 

no harm. The concepts of these scenarios and strategies are explained in Chapter 4.  

A detailed description of the methodology is given in Chapter 5. 

 
2 NOTE: the resulting values are not used to adjust the soil properties in the model schematization, since the results have a too 

high variance to be able to make reasonable adjustments. 
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3 Study Area Description 
The Boven Geuldal Belgium catchment (from now also referred to as just ‘Boven Geul’) is the most 

upstream part of the Geul catchment, a tributary of the Meuse. The Boven Geul has a surface area of 

74.6 km2 and is located mainly in Belgium (90.5%) and partly in Germany (9.5%). Figure 3.1 shows 

the boundaries of the Boven Geul catchment together with the river network, sub-catchments and towns. 

The Boven Geul consists of four main branches that all come together close to the outlet point of the 

catchment, where it proceeds as the Geul which eventually reaches the Netherlands. These branches 

divide the Boven Geul into four sub-catchments called the Grünstrasserbach (5.7 km2), Hohnbach (26.9 

km2), Göhl (30.9 km2) and Tuljebach (10.4 km2). At the outlet point of the Boven Geul catchment, there 

is a measurement station close to Kelmis (see the red point in Figure 3.1). Kelmis, Raeren and Lontzen 

are the three municipalities that are located in the Boven Geul catchment. The following sections 

elaborate further on characteristics of the Boven Geul, water management in (the Boven Geul) Belgium, 

the measurement station and the floods of July 2021 regarding the Boven Geul.  
 

 

Figure 3.1. The Boven Geul Belgium Catchment with the River Network (in blue), the Measurement Station at the Outlet 

point (red point), the different Sub-Catchments and the Towns (black points). 
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3.1 Characteristics 

3.1.1 Land Use Land Cover 
Figure 3.2a shows the Land Use Land Cover (LULC) map of the Boven Geul catchment consisting of 

six general LULC classes. Figure 3.2b shows a pie chart with the corresponding surface area percentage 

per LULC class. What is remarkable, is the huge amount of grassland (54%) and forest (23%) present 

in the Boven Geul. Both LULC classes are favourable related to flooding because of their high 

infiltration rates. It should be pointed out that almost all grassland (> 95%) is indicated as ‘meadow and 

forage’ in the crop parcel map of Wallonia (Geoportail Wallonie, 2021). This cultivated form of 

grassland is probably more compacted due to the use of heavy machinery, which results in a lower 

infiltration rate than natural grassland (Hamza & Anderson, 2005; Schrama et al., 2013).  

 

Another noteworthy aspect is the relatively small proportion of surface area covered by cropland 

(4.1%). Maize is the dominant crop occupying 92% of all the cropland. The distribution of surface area 

among cropland, grassland and forest represents a significant contrast with the Dutch part of the Geul 

catchment. The Dutch part contains much more cropland (~30%), but less grassland (~40%) and in 

particular less forest (~12%) (Natuurmonumenten, 2022). 
 

a 

 

 

 

b 

Figure 3.2. The Land Use Land Cover Map of the Boven Geul Catchment (a). The pie chart at the right (b) shows the 

corresponding surface area percentage per LULC class. 

3.1.2 Soil & Geology 
Geology and particularly the soils have an important impact on the response of a catchment to flash 

floods, because of their (indirect) influence on the infiltration and storage capacity of the ground surface. 

Figure 3.3 shows the soil map of the Boven Geul Belgium, which consists of a Belgium and German 

part. The soil classes are translated from French and German respectively. What stands out, is that the 

largest part of the catchment is covered with loamy and loamy-stony soils. These kinds of soils have a 

moderately high infiltration capacity. As for the geology, the Boven Geul catchment lies mainly on 

impermeable rocks and partly on poorly permeable rocks (Natuurmonumenten, 2022). The soils upon 

these rocks are relatively shallow, providing limited storage capacity. During the field visit, the rocks 

were visible at the surface at multiple locations.   
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Figure 3.3. The Soil Map of the Boven Geul, consisting of a Belgium and German part. This is a simplified and combined 

version of the soil maps from the Wallonia Geoportal and NRW Geoportal. The soil classes are translated from French and 

German (Geoportail Wallonie, 2005; Geoportal NRW, 2016) 

3.1.3 Elevation & Slope 
Figure 3.4 shows the Digital Elevation Model (DEM) (a) and the corresponding Slope map (b) of the 

Boven Geul. The DEM ranges from higher elevations of 300 – 360 meters close to the boundaries of 

the Boven Geul to lower elevations of 175 – 200 meters close to the outlet point. In the southwest of 

the catchment there is a large plateau that has similar elevation (275 – 300 meters). During the field 

visit, the flatness of this area was noteworthy, particularly in contrast to the rest of the Boven Geul. 

Another notable aspect of the DEM and slope map is that it clearly shows how the river has carved itself 

into the landscape. The resulting valleys can be characterized as relatively narrow with particularly 

steep slopes of more than 20%, and at some parts even more than 40%. This was also evident during 

the field visit. 

 

a b 

Figure 3.4. The Digital Elevation Model (DEM) (a) and the Slope Map (b) of the Boven Geul Belgium Catchment at 1 meter 

resolution. 
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3.1.4 Drainage Systems 
Drainage systems are an important factor influencing the runoff of water. They can intercept water that 

has infiltrated into the soil and accelerate its subsurface flow to the river. During a field visit from 

Natuurmonumenten (2022), it became evident that in several grassland plots, the channel was entirely 

absent, and water was discharged through ditches and partially via an underground culvert (see Figure 

3.5). There is a strong likelihood that the grassland plots adjacent to the culvert also have been drained, 

which then discharges into the culvert/ditch. According to a civil servant from the Municipality of 

Kelmis, it is known for a few plots that drainage is present (see Appendix F.2). However, it is unclear 

whether this drainage is still operational and to what extent it is present in the rest of the catchment.  

 

 

Figure 3.5. Drainage ditch located in the Hohnbach in the Boven Geuldal Belgium (Source: (Natuurmonumenten, 2022)) 
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3.2 Water Management in Wallonia 

The water management structure in Wallonia consists of different parties being responsible for different 

parts of the river. The rivers are subdivided into different categories, which are shown in Table 3.1. 

Every category has its own manager, who is responsible for that river and who is allowed to make 

changes to it. The Service Public de Wallonie (SPW) is responsible for the navigable rivers and the 1st 

category of the non-navigable rivers. The province and municipalities are responsible for the 2nd and 3rd 

category respectively. And the unclassified rivers are managed by local residents owning that portion 

of land. The difference between 2nd and 3rd category rivers is defined by the limits of former 

municipalities. Nowadays, the municipalities consist of multiple of those older municipalities. There 

are multiple points where the river category, and thus the responsible manager, changes in the middle 

of a municipality. Figure 3.6 shows how the different parts of the Boven Geul river network are 

categorized. The Boven Geul river network primarily comprises 2nd category rivers, with some 

segments being classified as 3rd category, along with unclassified rivers. The Boven Geul turns into a 

1st category river at the confluence of the main branches near the outlet point of the catchment. 

 
Table 3.1. Overview of the Different River Categories in Wallonia and the Corresponding Responsible Parties. Based on 

information from a meeting with Local Comité la Gueule and  (SPW Wallonie, 2023) 

Category Limits  Manager 

Navigable rivers Rivers classified as navigable SPW Mobility and 

Infrastructure 

Non-

navigable 

rivers 

1st category From the point where the upstream 

catchment area reaches 5000 ha to the 

confluence with a navigable waterway. 

SPW Agriculture, 

Natural Resources 

Environment 

2nd category From the limit of the former municipality 

to the point where the upstream catchment 

area reaches 5000 ha. 

Province 

3rd category From the point where the upstream 

catchment area reaches 100 ha until the 

limit of a former municipality. 

Municipality 

Unclassified From the source until the point where the 

upstream catchment area reaches 100 ha. 

Local Resident 

 

 

Figure 3.6. Map showing the Division of the Boven Geul River Network into the Different Water Management Categories of 

Wallonia. 
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3.3 Measuring Station at Outlet Point near Kelmis 

Figure 3.7 shows the outlet point of the Boven Geul and the location of the measuring station near 

Kelmis. The Boven Geul Belgium flows under the bridge (width: 12 meters, height: 8 meters) and turns 

into the Beneden Geul Belgium downstream of it. The measuring station is located at the downstream 

side of the bridge and is operated by the Service Public de Wallonie. The measuring station is probably 

a stilling well, which is visualized by Figure 3.8. A pipe is positioned between the river and the well in 

such a way that the water level in the well equals the river level. In this way, the measurements are not 

influenced by waves and sediment. A rating curve is then used to translate the water level into a 

discharge. 
 

 

Figure 3.7. Location of the Measurement Station at the outlet of the Boven Geul Belgium near Kelmis. (A) shows the bridge 

under which the Boven Geul flows towards the Beneden Geul Belgium (The opening has a width of 12 meters and a height of 

8 meters). (B) shows the measurement station. (photos: Jafeth Kuiper) 

 

Figure 3.8. Visualization of a Stilling Well Measuring Station. (Source: (Hutter et al., 2014)) 

 

 

3.4 Flash Flood Event July 2021 in Boven Geul Belgium 

The Boven Geul Belgium catchment experienced some significant damage and water nuisance from the 

July 2021 flood event, but it was very little compared to other river catchments in Belgium such as the 

Vesdre. Figure 3.9 shows visual content that is made by citizens during the flood event in 2021. 

According to the Municipalities of Kelmis and Raeren (see Appendix F.2), a substantial number of 

roads experienced flooding (see pictures 1, 3, 4, 6 in Figure 3.9), and some house basements were also 

affected. However, most houses remained relatively unaffected, as they are often situated slightly higher 

than their direct surroundings. Thereby, the channel overflowed at several locations resulting, for 

instance, in adjacent gardens being inundated (see pictures 2 and 7 in Figure 3.9).  
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The most severe flooding occurred near the outlet point at the confluence of the main branches, where 

the channel significantly overflowed (see pictures 1 and 5 in Figure 3.9). This led to the inundation of 

a substantial amount of grassland, and according to the Municipality of Kelmis, several houses were 

also inundated with interior water levels of approximately 50 centimetres (4 houses close to location 1 

in Figure 3.9). Based on information from civil servants of the Municipalities Kelmis and Raeren (see 

Appendix F.2), this location is the sole area where water is reported to have entered the houses 

themselves, apart from some flooded basements in Eynatten. Furthermore, directly downstream of the 

outlet point, the flash floods also caused the flooding of several houses.  
 

 
Figure 3.9. The River Network of the Boven Geul catchment together with pictures that are taken during the flash floods in 

July 2021. The numbers link the pictures to their locations in the catchment.  

(1) shows a significantly flooded channel, with the grasslands (at the right) also submerged, (2) shows a flooded channel 

leading to the inundation of a garden, (3) shows a flooded road, (4) shows a flooded square and road resulting from a 

flooded channel, (5) shows pictures of a large grassland area that is inundated as a result of a flooded channel, (6) shows a 

flooded road under which the channel flows, (7) shows an inundated garden as a result of a flooded channel.  

Photos made by citizens (Sources: Munic. Kelmis and Raeren & (Grenzecho, 2021))   
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Figure 3.10 shows the 5-minute discharge values of the Kelmis measuring station during the July 2021 

Flash Floods including precipitation values of the KNMI. The discharge levels start to increase once 

the rainfall event starts. From approximately 14 July 2021 12:00, the discharge level increases to an 

extremely high level while the rainfall intensities have not worsened (peak: 55.7 m3/s). Thereby, during 

periods of lower rainfall intensities, the discharge levels do not significantly recede. Another 

noteworthy aspect of the discharge curve is the long period of extended runoff that continues after the 

rainfall event has stopped.  

 
 

 

Figure 3.10. The 5-Minute Discharge Values of the Kelmis Measuring Station during the July 2021 Flash Floods. The 

precipitation values are from the KNMI radar rainfall dataset. 
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4 Scenarios and Strategy 
This study focusses mostly on strategies that aim to delay and store the water by allowing controlled 

channel overflow at locations where this poses minimal to no harm. This will result in reduced peak 

outflow from the Boven Geul catchment. Furthermore, the effects of two extreme Land Use Land Cover 

(LULC) scenarios on runoff and local flooding are analysed: (1) in order to increase the understanding 

of the Boven Geul hydrological system and (2) to analyse how effective LULC changes could be in the 

Boven Geul. The following sections provide a further description of the specific LULC Scenarios (4.1) 

and the specific strategies (4.2) that are considered. 

 

4.1 Land Use Land Cover Scenarios 

The Boven Geul catchment has quite favourable land use in terms of infiltration with approximately 

54% of the catchment consisting of Grassland and 23% consisting of Forest (see Figure 3.2). There 

seems to be little room for LULC changes that improve infiltration and decrease runoff. This study 

analyses a very extreme LULC Scenario (“Forest Scenario”) to determine what maximum potential 

reduction in outflow and flooding could be achieved with LULC changes. The Forest Scenario is a best-

case scenario in terms of infiltration and assumes that all Grassland and Cropland in the Boven Geul is 

converted to Forest. Figure 4.1a shows the LULC map corresponding to this scenario. 

 

The other LULC Scenario is called the Paved Scenario, which is a worst-case scenario by considering 

the entire Boven Geul catchment to be covered by hard surfaces (zero infiltration). It shows the 

maximum effect of urbanization on the outflow and flooding in the Boven Geul. Together with the 

Forest Scenario, it defines the boundaries between which LULC Changes could influence the outflow 

and flooding in the Boven Geul. Moreover, this scenario helps to understand how the hydrological 

system of the Boven Geul works. For example, the differences with the Reference Scenario indicate the 

effect of the soil storage capacity on the outflow curve. Figure 4.1b shows the LULC map corresponding 

to this scenario, which is completely covered by Built-Up area. 

 

 

a 

 

b 

Figure 4.1. The Land Use Land Cover Maps for the Forest (a) and Paved Scenario (b). Both maps have the same legend, 

which is shown in figure a. 
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4.2 Strategy Concept 

The specific strategy that is explored in this study aims to reduce the peak outflow from the Boven Geul 

by delaying and storing the water at several locations along the channel. This is realised by multiple 

small dams across the river channel with a culvert inside of them.  Figure 4.2 illustrates the cross-section 

of the channel with and without a dam. The dam consists of a 2-meter elevation and a culvert through 

it allowing a maximum discharge. The small dams are placed at locations where the valley can be 

flooded relatively harmlessly. It is important to note that at lower and medium discharges these dams 

do not pose an obstruction. This strategy really focusses on the extremer discharge levels. At these 

discharge levels, when the channel discharge exceeds the maximum discharge capacity through the 

culvert, the dams are forcing the channel to overflow. This causes the channel discharge to be constant 

and removes the peak. It lasts until the moment that the water level behind the dam is higher than the 

dam and the dam will overflow. The dams are not too high to prevent the upstream flooded area from 

becoming too large. One of the principles of this approach is to not have too much impact at one location 

but to distribute the impact among the different branches of the Boven Geul. Hereby, it is important to 

also position some dams more upstream and not only focus on the most downstream part of the Boven 

Geul. 

 

 

Figure 4.2. Illustration of the Cross-Section of the Channel with and without a Dam. The Dam (lower illustration) consists 

of a 2-meter elevation with a culvert through it. 
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5 Research Methods and Design 
Figure 5.1 shows the overview of the methodology in this study. The colours represent the objective to 

which the methods correspond. Section 5.1 describes the fieldwork that is executed in the Boven Geul 

Catchment. Section 5.2 explain the laboratory tests that are done with the collected soil samples. Section 

5.3 then describes the development of the OpenLISEM schematization to simulate the flood event in 

the Boven Geul catchment. Next, Section 5.4 discusses the parameterization of the scenarios and 

strategies that are simulated with this OpenLISEM schematization. Lastly, Section 5.5 describes the 

meetings that are organized with the Municipalities of Kelmis and Raeren in order to reflect on the 

flood event in the Boven Geul and the feasibility of implementing potential flood mitigation measures. 

It is important to note that the laboratory results are not used to adjust the input of the OpenLISEM 

schematization, since the results have a too high variance to make reasonable adjustments. 

 

 

Figure 5.1. Overview of the Methodology used to address the Research Objectives and Questions. The colours represent the 

objective corresponding to the method. 
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5.1 Fieldwork 

Fieldwork has been carried out from 12 to 21 December 2022 in the Boven Geuldal Belgium Catchment. 

This fieldwork consisted of visiting flooded locations, getting familiar with the catchment, measuring 

channel and culvert dimensions, and taking soil samples. And on top of that, meetings with the 

organization Contrât de Rivière Meuse Aval (Comité la Gueule) and the municipalities of Kelmis and 

Raeren. The details of these meetings are further discussed in Section 5.5. 

 

All the locations at which photos are taken during the fieldwork period are shown in Figure 9.1 in 

Appendix A.1. The following sections elaborate on the methodology of measuring channel and culvert 

dimension and the collection of soil samples.  

 

5.1.1  Measuring Channel & Culvert Dimensions 
Figure 5.2 shows all the locations at which measurements of channel, culvert and other crossing 

dimensions are done. The channel measurements consist of a width and a depth, and the crossing 

measurements (bridge, culvert, pipe; from now on referred to as culverts) consist of the necessary 

dimensions to be able to calculate the cross-section. Culverts are points at which the water in the channel 

is confronted with a maximum cross section through which it can flow. They could form a bottleneck 

in case of extreme discharges in the channel, which makes it important to include them in a flood model. 

The cross-section of most of the culverts (some were not accessible) is determined by measuring the 

dimensions. This information is used to calculate a maximum discharge capacity which is used in the 

flood model (see Section 5.3.3). 

 

The channel dimension measurements are done at different locations along the Boven Geul river, both 

upstream in the catchment and downstream close to the outlet point. This includes the bridge at the 

outlet point, the confluence of the different main branches of the Boven Geul and the channel 

dimensions at different locations close to the start of the Boven Geul. This information is used to 

determine suitable dimension parameters for the flood model in Section 5.3.4. 
 

 
Figure 5.2. Location of Measurements of Channel, Culvert and other Crossing Dimensions. 
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5.1.2 Collection of Soil Samples 
Soil samples are collected in the Boven Geul catchment in order to determine the saturated hydraulic 

conductivity, bulk density, porosity and the soil organic matter content in the laboratory. The collection 

of soil samples is done at 20 and 21 December 2022. The following sections elaborate on the sampling 

strategy of how the soil sampling locations are selected; and on how the soil samples are taken. 

 

Sampling Strategy 

Figure 5.3 shows the three sample zones (1ab, 2, 3) that are selected to take the soil samples. The soil 

samples are taken at the three LULC classes Forest, Grassland and Maize land in order to analyse the 

variation in soil properties among these land uses. The samples are taken at Maize land because it covers 

92% of all the cropland in the Boven Geul. The sample zones are selected based on the criteria below. 

Table 5.1 gives a brief description of the different sample zones. 

• Possibility to reach and enter the sample location. 

• The sample zones contain together an equal representation of the different LULC classes. 

• The different dominant soil types of the Boven Geul are included within the sample zones.  

• The sample zones have a different location across the catchment and along the Boven Geul 

river. 
 

Table 5.1. Description of the selected Sample Zones for Soil Sampling. 

Sample zone Description 

1ab Located in the Hohnbach relatively close to the outlet point. Mainly covered by 

Maize and partly by Grassland. Mainly covered by the dominant loamy soil, and 

partly by the dominant loamy-stony soil. 

2 Located in the Göhl in the middle of the catchment, including some steep slopes. 

Mainly covered by Grassland and Forest. Mainly covered by the dominant loamy-

stony soil, and partly by the dominant loamy soils and the slightly stony loamy soils. 

3 Located at the start of one of the branches of the Göhl, at a high altitude in a flat 

environment. Mainly covered by Forest. Entirely covered by the dominant loamy 

soil. 

 

The location of the soil samples within the sample zones is determined with a random grid sampling 

strategy to prevent bias while trying to catch spatial variability. The sample zones are covered by a 

raster with 9 small grid cells in each of the raster grid cells. The exact location of each sample is 

determined with a random number generator (1-9). The detailed steps are explained in Appendix A.2. 

There is chosen to take 45 samples: 15 samples on each of the LULC classes Forest, Grassland and 

Maize. This number is a balance between on the one hand having sufficient samples to catch the (spatial) 

variability and on the other hand the amount of labour and time it costs. Due to circumstances, only 38 

samples could be collected: 15 at Maize, 12 at Grassland and 10 at Forest. Figure 5.3 shows the locations 

of the collected soil samples as orange dots.  
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Figure 5.3. The Location of the Soil Samples. The orange dots show the location at which the soil samples are taken. The 

black boxes show the selected sample zones in which a random sampling strategy is applied. 

 

Taking Soil Samples 

The 38 soil samples are taken at the sampling locations of Figure 5.3 with the use of sample rings (see 

Figure 9.3a) that have a sharp and blunt side. The sharp side is directed towards the soil and with the 

use of a sample ring holder (Figure 9.3b) and a hammer, the sample ring is carefully pushed into the 

soil. The sample ring is then excavated using a small shovel, followed by removing excess soil from 

the top and bottom using a small hacksaw. Plastic lids are used to close the sample ring and it is kept 

save in one of the sample boxes. The goal is to take an undisturbed sample of the soil surface (without 

the vegetation on top of it) in order to analyse this in the laboratory. The detailed steps are provided in 

Appendix A.3. 
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5.2 Laboratory Analysis 

The laboratory analysis of the soil samples consists of three tests: the infiltration (Ksat) test, the Bulk 

Density and Porosity test, and the Soil Organic Matter content test. The following sections describe 

how these tests have been carried out. 

 

5.2.1  Infiltration (Ksat) Test 
The Saturated Hydraulic Conductivity (Ksat) of the soil samples is determined with a Laboratory 

Permeameter from Eijkelkamp. The steps of this procedure are exactly followed as described in the 

corresponding Standard Operating Procedure (SOP) manual. The Constant Head Method and the 

Falling Head Method are two methods with which the Ksat can be determined with the use of the 

permeameter. The constant head method is applicable for all soils except for very poorly permeable 

soils such as clay and peat. The falling head method is mostly used for very poorly permeable soils and 

is less accurate because it assumes a linear process. The constant head method is chosen since the 

samples consist of loamy soils. Equation 5.1 shows the corresponding formula with which the Ksat is 

calculated. The method is executed with a constant water head (h) and under saturated conditions. A 

timestep (t) is determined based on how fast the water is flowing through the sample. The test is finished 

when the measured volume per timestep is constant for at least 5 timesteps. The average volume is used 

as input for Equation 5.1. 

 

𝐾𝑠𝑎𝑡 =
𝑉𝑠𝑎𝑡 × 𝐿

𝐴 × 𝑡 × ℎ
 

 

𝐾𝑠𝑎𝑡 Saturated Hydraulic Conductivity [cm/h] 

𝑉𝑠𝑎𝑡 Volume measured in the burette per timestep when the sample is  

saturated (1 ml = 1 cm3) 

𝐿, 𝐴 Constants, the height (L [cm]) and cross-section (A [cm2]) of the sample rings 

𝑡 Length of the timestep [h] 

ℎ The constant head during the procedure: water level difference between  

the water level in the container and the water level in the sample holder. 

Eq. 5.1 

 

5.2.2  Bulk Density and Porosity Test 
The Bulk Density and Porosity are determined by measuring the saturated and oven dried weight of the 

soil samples and then using Equations 5.2 and 5.3. The saturated weight is determined with a scale 

directly after removing the sample from the permeameter. The entire ring then consists of soil and pores 

that are filled by water. After this, the samples are oven dried at 105 °C for approximately 48 hours. 

The sample is weighed again and with the difference in weight, the pore volume can be determined 

(Equation 5.3). The samples are placed in metal containers to make sure no soil is lost. The metal 

containers and rings are weighed afterwards and subtracted from the total weight.  

 

𝜌𝑑𝑟𝑦 =
𝑀𝑑𝑟𝑦

𝑉𝑠𝑜𝑖𝑙
=

𝑀𝑑𝑟𝑦

𝑉𝑟𝑖𝑛𝑔
 

 

𝜌𝑑𝑟𝑦 Dry Bulk Density of the soil sample [kg/m3] 

𝑀𝑑𝑟𝑦  Oven Dried Weight of the soil sample [kg] 

𝑉𝑟𝑖𝑛𝑔 Volume of the sample ring [m3] 

 

Eq. 5.2 

 

 

 

 



24 

 

𝑝𝑜𝑟𝑜𝑠𝑖𝑡𝑦 =
𝑝𝑜𝑟𝑒 𝑣𝑜𝑙𝑢𝑚𝑒

𝑡𝑜𝑡𝑎𝑙 𝑣𝑜𝑙𝑢𝑚𝑒
=

(
𝑀𝑠𝑎𝑡 − 𝑀𝑑𝑟𝑦

𝜌𝑤𝑎𝑡𝑒𝑟
)

𝑉𝑟𝑖𝑛𝑔
 

 

𝑀𝑠𝑎𝑡 Saturated Weight of the soil sample [kg] 

𝑀𝑑𝑟𝑦 Oven Dried Weight of the soil sample [kg] 

𝜌𝑤𝑎𝑡𝑒𝑟 Density of water (= 1000 kg/m3) 

𝑉𝑟𝑖𝑛𝑔 Volume of the sample ring [m3] 

 

Eq. 5.3 

5.2.3 Soil Organic Matter Content Test 
Soil Organic Matter (SOM) is the organic matter component of soil consisting of plant and animal 

tissues in different stages of decomposition (Fenton et al., 2008). It influences the infiltration capacity 

of the soil by improving water infiltration. The Loss-on-Ignition (LOI) method stands as one of the 

most used methods for measuring the organic matter content in soils (ADHB, 2018; Hoogsteen et al., 

2015, 2018; Sullivan et al., 2019). This method makes use of the principle that SOM oxidizes above a 

temperature of 400 °C.  The weight losses observed at these temperatures can largely be attributed to 

the oxidation of SOM and the structural water losses (SWL) from clay minerals (Hoogsteen et al., 

2015). Hoogsteen et al. (2015, 2018) suggests an ignition temperature of 550 °C because at this 

temperature all SOM will be removed, while almost the entire calcite fraction remains within the soil 

samples. 

 

The soil samples are made fine with a mortar and pestle to ensure that a representative portion of the 

soil sample is transferred into the little jars in which they enter the oven. The sample trays are placed in 

the oven for a duration of 3 hours at 550 °C and the trays are turned at half-time to minimize within-

batch LOI variation (Hoogsteen et al., 2015). The samples are weighed both before and after the 

ignition. The SOM is then calculated with the mass loss (LOI) and Equation 5.4. The mass loss is 

corrected for the structural water loss of clay minerals. The suggested correction factor (bT) for an 

ignition temperature of 550 °C is 0.08 (Hoogsteen et al., 2015). The soil clay content (20%) is taken 

from the average clay content of loamy soils in the French USDA triangle, since the Boven Geul 

consists mostly of loamy soils. 

 

𝑆𝑂𝑀 = 𝐿𝑂𝐼𝑇 − 𝑏𝑇 × 𝐶 
 

𝐿𝑂𝐼𝑇 The mass loss of SOM at temperature T (%) 

𝑏𝑇 Clay correction factor for structural water loss (SWL) (kg kg-1) 

𝐶 Soil Clay Content (%) 

Eq. 5.4 
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5.3 Development of the OpenLISEM Schematization for 

the Boven Geul Belgium 

This study uses the Open-Source Limburg Soil Erosion Model (OpenLISEM; version 6.91) software3 

to simulate the flood event of July 2021 for the Boven Geul Belgium Catchment. The OpenLISEM 

schematization of this flood event is developed at 20-meter resolution. This resolution ensures a high 

level of detail without causing too long computational times. The schematization is calibrated using the 

discharges measured by the measurement station near Kelmis during the flood event. Section 5.3.1 

elaborates on OpenLISEM, after which Section 5.3.2 provides an overview of the workflow and the 

input data and Section 5.3.3 describes the data preparation for the OpenLISEM schematization. Finally, 

Section 5.3.4 describes how the calibration is done and the corresponding parametrization choices. 

 

5.3.1 OpenLISEM 
OpenLISEM is a physically based 2D numerical flood model that is very useful for simulating flash 

floods in catchments from 1 ha to several 100 km2 (Bout & Jetten, 2018b; Hessel et al., 2003; Jetten, 

2002; University of Twente, 2022). Figure 5.4 shows an overview of the most important hydrological 

processes of OpenLISEM (Bout & Jetten, 2018a)4. It consists of three parts: the soil water balance, the 

water flow, and the erosion part (this part is not included in this study). Rainfall is partly intercepted by 

for example leaves and partly infiltrated into the soil. The remaining part turns into overland flow which 

will finally reach the channel. The input is given by spatial data layers that describe the soil hydrology, 

surface properties, terrain and river channels. Figure 5.5 shows an overview of the input data layers for 

OpenLISEM. The input layers are, where needed, provided as the fraction of the surface area of a grid 

cell and combined to an average hydrological response per grid cell.  Examples of input layers that are 

given as fractions of a grid cells are vegetation cover, roads, buildings and channels. 

 

 

Figure 5.4. Most important hydrologic processes (blue) and erosion processes (red) in OpenLISEM. Overland flow can be 

both runoff and flooding. ET = Evapotranspiration. Source (Bout & Jetten, 2018a) 

 
3 https://github.com/vjetten/openlisem 
4 For more detailed information about OpenLISEM, see the manual: 

https://master.dl.sourceforge.net/project/lisem/Documentation%20and%20Manual/documentation15.pdf?viasf=1 
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Figure 5.5. Input data layers for OpenLisem (Bout & Jetten, 2018a) 

The infiltration is done with a 2-layer Green & Ampt Model. The first layer is the topsoil defined as the 

root zone (A-horizon) which contains organic matter. This layer is affected by the type of Land Use 

Land Cover on top of it. The subsoil (B-horizon) has properties that are only affected by the type of 

soil. Optionally, groundwater could develop in this soil layer. The hydrological soil parameters 

influencing the infiltration capacity of the soil are the Saturated Hydraulic Conductivity (mm/h), 

Porosity (-) and the Initial Moisture Content (-). These parameters are derived using pedotransfer 

functions as described by Saxton and Rawls in 2006. They are based on different primary soil properties, 

including sand, silt, and clay content, as well as organic matter content and bulk density. These 

properties are sourced from the open-access ISRIC database SoilGrids5, which offers this information 

globally at a 250-meter resolution across six different depths (0-5, 5-15, 15-30, 30-60, 60-120, 120-200 

cm). 

 

The water flow consists of both channel and overland flow, where overland flow includes both runoff 

and flooding. The channel flow is modelled as a 1D kinematic wave and the overland flow as a 2D 

dynamic wave. In addition to variations in pressure and momentum of the flow, the overland flow is 

influenced by the terrain slope and Manning’s ‘n’ value for flow resistance. Meanwhile, discharge is 

dependent upon channel dimensions, the bed slope and the channel-specific Manning’s ‘n’ value. 

 

Database Generator 

The Database Generator is software accompanying OpenLISEM, which substantially reduces the 

workload by automatically generating a large part of the input data using python scripts based on some 

basic input maps. This is especially useful since all the hydrologic parameters need to be provided as 

an input map for OpenLISEM. For example, OpenLISEM does not simply use a Land Use Land Cover 

map but needs hydrologic parameter maps that represent land use such as flow resistance and vegetation 

cover. The Database Generator produces these kinds of maps based on basic input maps as the Digital 

Elevation Model, Flow Network and Land Use Land Cover. It further streamlines the process by 

automatically downloading the soil data from SoilGrids and subsequently converting it to the relevant 

soil hydrologic parameter maps. 

  

 
5 See: https://Soilgrids.org 
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5.3.2 Overview Workflow and Input Data 
Figure 5.6 shows the workflow for the development of the OpenLISEM schematization of the Boven 

Geul Belgium. Table 5.2 displays the data that is used as input for the schematization. Section 5.3.3 

describes how the raw input data from Table 5.2 is prepared to use it as input data for the Database 

Generator, which then converts it into the appropriate input maps required for OpenLISEM. The 

schematization is calibrated such that the output discharge curve matches sufficiently with the measured 

discharge curve. Section 5.3.4 presents this calibration as well as the parametrization of both the 

Database Generator and OpenLISEM. 

 

 

Figure 5.6. Overview of the Workflow for the Development of the OpenLISEM Schematization of the Boven Geul Belgium. 

Table 5.2. Raw Input Data used to build the OpenLISEM Schematization of the Boven Geul Catchment. 

Data 

Group 

Input Data Year File Type Source 

Boundaries 1 Sub-Catchment Boundaries 

Wallonia 

2020 Shapefile 

(polygon) 

Wallonia Geoportal 

DEM 2 Digital Terrain Model (DTM) 

Wallonia  

2013-

2014 

GeoTIFF 

(1m) 

Wallonia Geoportal 

River 

Network 

3 River Network Wallonia 2020 Shapefile 

(line) 

Wallonia Geoportal 

4 River Network Nordrhein 

Westfalen 

2019 Shapefile 

(line) 

Open Geodata NRW 

Soil 5 SoilGrids Data 2020 Raster 

(250m) 

ISRIC World Soil 

Information 

(https://Soilgrids.org) 

Satellite 

Data 

6 Sentinel 2 Satellite Image 21 

July 2021 

2021 GeoTIFF 

(10m) 

Copernicus (Sentinel 

Data) 

LULC Map 7 Land Use Land Cover (LULC) 

Wallonia 

2018 File GDB 

Shapefile 

(polygon) 

Wallonia Geoportal 

8 Land Use Land Cover (LULC) 

Municipality Köln 

2023 Shapefile 

(polygon) 

OpenStreetMap 

(geofabrik) 

9 Crop Parcel Map Wallonia 

(situation 2021) 

2021 File GDB 

Shapefile 

(polygon) 

Wallonia Geoportal 

Buildings & 

Roads 

10 Buildings Belgium 2023 Shapefile 

(polygon) 

OpenStreetMap 

(geofabrik) 

11 Roads Belgium 2023 Shapefile 

(line) 

OpenStreetMap 

(geofabrik) 

12 Buildings Municipality Köln 2023 Shapefile 

(polygon) 

OpenStreetMap 

(geofabrik) 
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13 Roads Municipality Köln 2023 Shapefile 

(line) 

OpenStreetMap 

(geofabrik) 

Rainfall 14 KNMI Hourly Radar Rainfall 

2019-2021 Geul Catchment 

2019-

2021 

NC File KNMI* 

Measured 

Discharge 

15 Measured Discharge Kelmis 

Measuring Point (5-minute 

values; 13-17 July 2021) 

2021 Data Series Hydrometrie 

Wallonia 

* Reprojected (to EPSG 4326) and clipped to Geul Catchment by Deltares 

5.3.3 Data Preparation 
The raw input data of Table 5.2 is prepared such that it can be used as input data for the Database 

Generator. This is done with the programs QGIS v3.30.0 and Nutshell v5.141. General adjustments that 

are done for all the input data are converting it to the same projection applicable for the Boven Geul 

(EPSG 31370), resampling it to the modelling resolution (20 meters) and clipping the input maps to the 

extent of the Boven Geul Catchment. The following sections describe the details of the data preparation 

per type of input data. The detailed steps are described in Appendix B.  

 

Figure 5.7 shows the legend of the flowcharts that are used in the following data preparation sections. 

The colours represent the type of input data. The raw input data is accompanied by a number between 

brackets referring to input data number in Table 5.2. 

 

 

Figure 5.7. Legend of the Flowcharts that are  

used in the Data Preparation Sections. 

Boven Geul Catchment boundaries and DEM 

The Digital Terrain Model (DTM) of Wallonia provides Lidar elevation data at 1 meter resolution with 

an altimetric precision of 0.12m (Geoportail Wallonie, 2015). This elevation does not include elements 

on the earth surface such as buildings, bridges and vehicles. At the moment of the model development 

this was the most recent DTM version available for Wallonia. The Wallonia DTM covers Wallonia 

including close areas beyond the border in Germany. It thus also provides elevation values for the 

German part of the Boven Geul catchment, which is why this data is very suitable to use as input for 

the Digital Elevation Model (DEM) of the Boven Geul.  

 

The Wallonia DTM is used to determine the DEM of the Boven Geul, the Boven Geul catchment 

boundaries and the outlet map (see Figure 5.8). These three maps are inputs for the OpenLISEM 

Database Generator. A Local Drainage Direction (LDD) map is made in Nutshell, based on which the 

outlet point could be defined. This is the river cell that corresponds to the measuring point near Kelmis. 

The LDD and outlet map are then used together to define the Boven Geul Catchment boundaries. The 

detailed steps are described in Appendix B.1. 
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Figure 5.9 shows the resulting Boven Geul Belgium catchment boundaries and the Digital Elevation 

Model. The outlet point is shown in Figure 5.11 in the next section. 

 

 

Figure 5.8. Short Version of the Flowchart describing the creation of the Boven Geul DEM, Catchment Boundaries and 

Outlet Map. The Full Version and Detailed Steps are provided in Appendix B.1 

 

Figure 5.9. The Boven Geul Belgium Catchment Boundaries and the Digital Elevation Model (DEM) 

River Network and Culverts 

The river network of the Boven Geul Belgium catchment is determined by combining river networks 

from Germany (Nordrhein Westfalen) and Belgium (Wallonia). Both river networks are detailed river 

networks consisting of both classified and unclassified rivers. Together they give quite a complete and 

accurate representation of the existing river network. This statement is based on real life observations 

and satellite imagery; and it is the reason that existing river network data is chosen to be used instead 

of a DEM based river network. 

 

Figure 5.10 shows the short version of the workflow of preparing the final river network. The German 

and Belgium river network are combined into an initial river network. Then some smoothening and 

cleaning has been done in order to prepare it for the OpenLISEM Database Generator. This step includes 

removing loose parts and unnecessary pixels resulting from the rasterization. Figure 5.11 shows the 

resulting Boven Geul River Network in blue and the outlet point in red. The detailed workflow and 

steps are described in Appendix B.2. 
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Figure 5.10. Short Version of the Flowchart describing the creation of the Final River Network. The Full Version and 

Detailed Steps are provided in Appendix B.2. 

 

Figure 5.11. The Final River Network of the Boven Geul Belgium Catchment and the Outlet Point of this Catchment. 

 

Culverts 

Culverts are included in the OpenLISEM schematization as a maximum channel discharge. The 

maximum discharge through a culvert is a complicated process depending on multiple factors, of which 

several are not known. Therefore, an estimation is done with the help of the Chézy equation, which is 

a semi-empirical resistance equation for open channel flow. Equation 5.5 displays the equation with 

which the maximum culvert discharge is calculated. The cross-sectional area and wetted perimeter are 

determined based on dimension measurements of the culverts. The slope of the culverts is estimated 

with the 1m DEM of the Boven Geuldal Belgium. All the culverts, bridges and pipes that are measured 

are included in the schematization. 

 

𝑄𝑚𝑎𝑥 = 𝑉𝑚𝑎𝑥𝐴 =
𝐴 × 𝑅

2
3 × 𝑆

1
2

𝑛
 

 

𝑉𝑚𝑎𝑥 Maximum flow velocity through the culvert [m/s] 

A Cross-Sectional Area of the Culvert [m2] 

𝑅 Hydraulic Radius of the Culvert [m] 

Eq. 5.5 
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             Equal to 𝐴/𝑃 with 𝑃 being the Wetted Perimeter [m] 

𝑆 Slope of the Culvert [m/m] 

𝑛 Manning’s n of the culvert [-] 

             Assumed to be 0.013, typical for concrete culverts (with bends, connections 

             and some debris) (Oregon State University, n.d.) 

 

Soil Maps 

The soil maps that are needed for the OpenLISEM Database Generator are provided by SoilGrids, since 

it is the most complete and accurate soil data that is available for the Boven Geul catchment. SoilGrids 

is a system designed for global digital soil mapping (ISRIC, 2023). It utilizes machine learning methods 

to create spatial distribution maps of soil properties on a global scale. These properties are available at 

six standard depth intervals, and the system provides these maps with a consistent resolution of 250 

meters.  

 

The Database Generator downloads maps of primary soil properties6 from SoilGrids. The Bulk Density 

and Soil Organic Carbon content maps of the upper soil layer are corrected based on the Land Use Land 

Cover map (see the parameters in the two most right columns in Table 5.3). Then the Database 

Generator computes maps of the Saturated Hydraulic Conductivity (Ksat), Initial Soil Moisture Content 

and Porosity for both the upper and lower soil layer with the help of pedotransferfunctions (Saxton & 

Rawls, 2006). Further details are provided in Appendix B.3. The soil maps are not corrected by the 

results from the laboratory analysis of the soil samples since the results have a too high variance to be 

able to make reasonable adjustments. 

 

Land Use Land Cover (LULC) Map 

The Land Use Land Cover (LULC) map for the Boven Geul Belgium catchment is created based on the 

LULC maps of the Municipality of Köln (German part) and the Province Liege (Belgium part). These 

are combined into an initial version of the Boven Geul LULC map. The original LULC maps are from 

different sources; in order to make them coherent a reclassification is done into the six LULC classes 

shown in Table 5.3. The details of this reclassification are provided in Appendix B.4.  

 

The initial Boven Geul LULC map is then first updated with the information from the Crop Parcel Map 

of 2021, the year of the flood event. This map contains all the crop parcels with information on the type 

of crop that has been cultivated in 2021 (mostly grassland). After this, three missing lakes have been 

manually added based on satellite imagery. Figure 5.12 shows the resulting LULC map of the Boven 

Geul Belgium. The detailed workflow and steps are provided in Appendix B.4. 

 

Table 5.3 also shows the OpenLISEM LULC parameters that are used for overland flow and infiltration. 

The random roughness and manning n play a role in the overland flow, while the relative bulk density 

and the organic matter content addition represent the land use corrections in the soil maps of the upper 

layer. Hereby influencing the infiltration. The Database Generator uses these values to generate 

hydrologic parameter maps. The values have been taken from (Jetten, 2022), which performs an 

OpenLISEM model simulation for two sub-catchments in the Dutch part of the Geul catchment. One 

adjustment is made, which is the relative bulk density factor for grassland (from 0.95 to 1). This is done 

because most of the grassland in the Boven Geul Belgium is cultivated grassland. With all the heavy 

machinery driving on this kind of grassland, it does probably not have the looser structure that natural 

grassland potentially has.  

 

  

 
6 Sand, Silt and Clay content, Bulk Density, Gravel Content and Soil Organic Carbon Content 
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Table 5.3. OpenLISEM Land Use Land Cover (LULC) parameters for overland flow and infiltration. Random Roughness is 

a measure for microrelief and the amount of storage on the surface before runoff occurs. 

LULC Class Code Random 

Roughness 

Manning n Relative Bulk 

Density 

Organic Matter 

Content Addition (%) 

Water 1 1 0.1 0 -2 

Built-Up Area 101 0.5 0.03 1.1 -1 

Forest 506 2 0.1 0.9 1 

Cropland 520 1 0.05 1 -0.5 

Grassland 521 1 0.1 1 0.5 

Other 526 1 0.05 1.05 -1 

 

 

Figure 5.12. The Land Use Land Cover Map of the Boven Geul Catchment. 

 

Normalized Difference Vegetation Index (NDVI) Map 

The OpenLISEM Database Generator uses the NDVI map to determine the vegetation cover in the 

Boven Geul catchment. Figure 5.13 shows the workflow of creating this NDVI map, based on a clear 

Sentinel 2 satellite image of 21 July 2021 (a week after the flood event). The NDVI is calculated with 

Equation 5.6 and bands 4 and 8 of the Sentinel 2 image. The detailed steps are provided in Appendix 

B.5. Figure 5.14 shows the resulting NDVI map of the Boven Geul catchment. 

 

𝑁𝐷𝑉𝐼 =
𝑁𝐼𝑅 − 𝑅𝑒𝑑

𝑁𝐼𝑅 + 𝑅𝑒𝑑
 

 

NIR (Near Infrared): Band 8 of Sentinel 2 

Red:   Band 4 of Sentinel 2 

Eq. 5.6 
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Figure 5.13. Short Version of the Flowchart describing the Creation of the NDVI Map. The Full Version and Detailed Steps 

are provided in Appendix B.5. 

 

 

Figure 5.14. NDVI map of the Boven Geul Belgium Catchment on 21 July 2021. 

 

Buildings, Roads and Other Hard Surfaces 

Hard surfaces such as buildings and roads prevent water from infiltrating in the soil, leading to runoff. 

The OpenLISEM Database Generator needs a building and road shapefile to include this effect in the 

flood model. Besides buildings and roads, there are also other hard surfaces such as parking lots and 

sidewalks. These other hard surfaces are included in an additional hard surfaces map consisting of 

values between 0 and 1, representing the fraction of the grid cell that is covered by other hard surfaces. 

 

The sections below describe in short how the three maps are created. The elaborated steps are provided 

in Appendices B.6, B.7 and B.8. Figure 5.15 shows the resulting building and roads shapefiles, together 

with the additional hard surfaces map at 1m resolution (not yet resampled). 
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Figure 5.15. Hard Surfaces in the Boven Geul Catchment including Buildings, Roads and Other Hard Surfaces. The River 

Network is included as a Reference Map. 

Buildings 

The building shapefile of the Boven Geul catchment is created by combining Open Street Maps data of 

the Belgium and German part of the catchment. The detailed steps are provided in Appendix B.6. Figure 

5.15 displays the resulting building shapefile. 
 

Roads 

Figure 5.16 shows the general workflow of the creation of the roads map for the Boven Geul catchment. 

First, an initial roads shapefile is made by combining Open Street Maps data of the Belgium and German 

part of the catchment. Then certain roads such as tracks and paths in a forest are excluded from the 

shapefile to make sure it only consists of hard roads. The road selection is shown in Table 9.4 in 

Appendix B.7. The final step is to convert the roads from lines to polygons with the use of a certain 

road width in meters. An average road width is defined per type of road by measuring these roads at 

several locations with Google Satellite (see Table 9.5 in Appendix B.7). Figure 5.15 shows the resulting 

roads shapefile. The detailed workflow and steps are provided in Appendix B.7. 
 

 

Figure 5.16. Short Version of the Flowchart describing the Creation of the Roads Map. The Full Version and Detailed Steps 

are provided in Appendix B.7. 
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Other Hard Surfaces 

Figure 5.17 shows the general workflow of the creation of the other hard surfaces map of the Boven 

Geul catchment. Equation 5.7 describes the computation of the other hard surfaces. The main input is 

the NDVI map of the Boven Geul at 10m resolution (original Sentinel 2 resolution). The initial hard 

surfaces map is defined by taking the built-up area and determining the locations where the NDVI is 

below a certain Threshold Value. This threshold value is defined by collecting NDVI values (at least 

20) per type of area within the Built-Up LULC class (e.g., parking lots, sidewalk, green gardens, grass). 

The resulting threshold value is 0.35, which best represents the difference between the NDVI values for 

hard surfaces and areas where water can infiltrate. The resulting map has been compared to a satellite 

image and displays a good representation of the hard surfaces inside the built-up areas.   

 

The initial hard surfaces map is then converted to 1-meter resolution at which the roads and buildings 

shapefile are subtracted. The result is resampled to 20-meter resolution (by taking the sum) and divided 

by the area of a grid cell (400 m2) to convert it to a hard surface fraction between 0 and 1. Figure 5.18 

shows the resulting hard surfaces map. The detailed steps are described in Appendix B.8. 

 

Other Hard Surfaces = built-up area (where NDVI < Threshold Value)  

                                       – buildings – roads 

Eq. 5.7 

 

 

 

 

Figure 5.17. Short Version of the Flowchart describing the Creation of the (Other) 

Hard Surfaces Map. The Full Version and Detailed Steps are provided in Appendix 

B.8. 
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Figure 5.18. The Hard Surfaces Map of the Boven Geul Belgium Catchment, representing 

Hard Surfaces in the Built-Up Areas other than Roads and Buildings. 

 

 

Rainfall 

The general workflow of the creation of the rainfall files for the OpenLISEM flood model is shown in 

Figure 5.20. The detailed workflow and steps are provided in Appendix B.9 The KNMI radar rainfall 

of 2019-2021 is used as input. This is hourly radar rainfall (in mm) which is reprojected (to EPSG 4326) 

and clipped to the boundaries of the Geul catchment by Deltares. For the period of the rainfall event (13 

July 8.00 – 15 July 8.00), KNMI adjusted the rainfall radar values by available ground measurements 

of the rainfall event. It is considered the best available data for this event. 

 

The input rainfall data is provided as NC file and converted to GeoTIFF files in Jupyter Notebook. The 

OpenLISEM Database Generator then prepares the rainfall data for the OpenLISEM Flood Model. 

However, one addition has been done to the rainfall script of the Database Generator. The Geul 

boundaries to which Deltares clipped the data do not completely cover the Boven Geul catchment 

boundaries determined in this research. The rainfall script is adjusted in such a way that these missing 

values are filled with a window average. One of the resulting radar rainfall files (14 July 9.00-10.00) is 

shown in Figure 5.20. The areas with red boundaries represent areas that had missing values which are 

filled with a window average. 

 

 

Figure 5.19. Short Version of the Flowchart describing the Creation of the Rainfall Files for the Boven Geul Belgium 

Catchment. The Full Version and Detailed Steps are provided in Appendix B.9. 
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Figure 5.20. KNMI Radar Rainfall Map File of 14 July 9.00-10.00 in the Boven Geul Catchment after Extraction and 

Preparation in the Database Generator. The areas with red boundaries represent areas that had missing values which are 

filled with a Window Average. 
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5.3.4 Calibration of OpenLISEM Schematization 
The OpenLISEM schematization of the Boven Geul simulates the flood event from 13 July 8:00 until 

17 July 0:00 with 30-second timesteps. The discharge curve at the outlet point is calibrated to the 

discharge curve of the measurement station at this point. The calibration is almost completely executed 

by choices in the parametrization of the input maps (in the Database Generator). Throughout the 

calibration process, several lessons have been learned about which parameters and processes are 

important in simulating the measured discharge. Appendix C elaborately describes the important steps 

and impact of important calibration parameters on the discharge curve.  
 

There are two main processes that are very important to get an accurate calibration: 

1. Saturation Overland Flow: a calibration with dominantly Saturation Overland Flow rather than 

Hortanian Overland Flow significantly helps to accurately simulate the patterns of the measured 

discharge curve. Particularly the pattern of increasing discharge peaks over the course of the 

event, which is present while the rainfall intensities are not increasing. 

2. Delay in the water system: calibrating with a significant water delay, represented by a Channel 

Manning’s n of 0.1, results in an accurate simulation of the wide peaks and the ‘memory’7 

observed in the measured discharge curve. 
 

The most important calibration parameters are the Ksat of both soil layers, the Soil Depth of the topsoil 

(Soil Layer 1), the Initial Soil Moisture Content of both soil layers and the Channel Manning’s n. The 

soil depth of Soil Layer 2 is not very important since the total storage capacity of both soil layers is 

probably sufficient to store the amount of 175.5mm of rainfall. The Saturation Overland Flow is caused 

by the saturation of the topsoil.  
 

The following sections describe the Database Generator parametrization corresponding to the final 

calibration and the final calibration itself.  
 

Database Generator Parametrization 

Channel Dimensions and Roughness 

Table 5.4 shows the selected channel parameters in the Database Generator parametrization. The 

Database Generator determines the channel width and depth of the complete river network based on the 

dimensions at the start of the network and the outlet point. The dimensions in between are determined 

with an exponential interpolation based on the upstream area. OpenLISEM calculates with a rectangle 

channel. The channel width and depth at the outlet point are selected based on dimension measurements 

at this location. The choice of dimensions at the start of the network is a little harder since there are 

multiple starts of the Boven Geul river network. The decision for a 1-meter width and depth provides 

the most accurate representation, aligning relatively closely with the measured channel dimensions 

observed at various locations during the fieldwork. A Channel Manning’s ‘n’ value of 0.05 is a common 

value for natural channels and is adopted from (Jetten, 2022), a report about an OpenLISEM 

schematization of Dutch sub-catchments of the Geul. However, during the calibration it appeared that 

a Channel Manning’s ‘n’ of 0.1 results into a more accurate calibration, which is why this value is used. 

The stationary baseflow at the outlet is determined based on the measured discharges in case there is no 

rainfall (before the event). 
 

Table 5.4. Channel Parameters of the Database Generator Parametrization. 

Channel Parameter Value 

Outlet Point Channel Width 12.0 m 

Channel Depth 3.0 m 

Start of Network Channel Width 1.0 m 

Channel Depth 1.0 m 

Channel Manning’s n 0.1 

Stationary baseflow at the outlet  0.37 m3/s 

 
7 NOTE: the ‘memory’ in the measured discharge curve refers to the fact that the discharge levels do not return to 

low levels after a peak. 
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Soil Parameters 

Table 5.5 shows the selected soil parameters in the Database Generator parametrization. One of the 

major decisions influencing the calibration is the decision to use soil property data of depth class 15-

30cm for both Soil Layers 1 and 2. The rationale for this decision lies in the relatively shallow soils that 

are present in the Boven Geul. Furthermore, using the soil properties from the deeper depth classes of 

SoilGrids results in a too low Saturated Hydraulic Conductivity (Ksat) which negatively influenced the 

calibration. The only difference between Soil Layers 1 and 2 comes from the influence of the Land Use 

Land Cover on Soil Layer 1. The depth of the topsoil is set at 40cm, and the maximum soil depth of the 

subsoil is set at 3 meters, since the soils are rather shallow. The exact depth of the subsoil is determined 

by the Database Generator based on the Digital Elevation Model and the distance to the channel. The 

resulting average depth of the subsoil is 2.3 meters. 

 

The dominant Saturation Overland Flow is mainly achieved by setting the Initial Soil Moisture Content 

at halfway between the Field Capacity and Saturation (0.5) (see also Appendix C). This indicates that 

the soil’s water content is already relatively high at the start of the simulation, causing the saturation of 

the topsoil after some time. The Initial Soil Moisture Content is thus not determined by a warmup 

period, but functions as an important calibration parameter. 

 

The Reference Bulk Density is kept at a default value. Another choice is that the lower subsoil boundary 

is set to be impermeable because of the impermeable geological layers beneath the soil in the Boven 

Geul. Furthermore, drainage systems are not included in the OpenLISEM schematization, since it is 

unclear at what scale they are present in the Boven Geul. 

 
Table 5.5. Soil Parameters of the Database Generator Parametrization. 

Soil Parameter Value 

Depth Class of the 

Downloaded Data SoilGrids 

Soil Layer 1 15 – 30 cm 

Soil Layer 2 15 – 30 cm 

Soil Depth Topsoil 0.40 m 

Maximum Soil Depth 3.00 m 

Reference Bulk Density 1350 kg/m3 

Effective Initial Moisture Content (0 = Field Capacity; 1.0 = Saturation) 0.50 

 

Final Calibration 

Figure 5.21 shows the discharge curve of the final calibration of the OpenLISEM schematization for 

the Boven Geul catchment. The simulated and measured discharge match quite well with a Nash-

Sutcliffe Efficiency (NSE) of 0.90 (Equation 5.8). The simulation seems to capture most of the patterns 

that are also present in the measured discharge curve. Especially the height of the peaks, the ‘memory’7 

and the extended runoff of water after the rainfall has stopped.  The most extreme peak is a little higher 

for the simulated discharge. There is chosen not to perfectly fit this peak to the peak of the measured 

discharge, since this comes at the expense of the goodness of fit of other elements of the discharge 

curve. For example, decreasing the Initial Soil Moisture Content or the Ksat would result in a reduction 

of the most extreme discharge peak. But it would also significantly reduce the first peaks of the 

discharge curve (see Appendix C.2). Another important difference between the measured and simulated 

discharge is the timing of the peaks. This could be caused by different factors such as uncertainty in the 

input rainfall or another water delaying process in the catchment that is not included. 

 

Furthermore, subsurface flow of water is not included in the OpenLISEM schematization. Based on 

simulations with OpenLISEM, it seems to be too slow to significantly impact the discharge curve. 
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𝑁𝑆𝐸 = 1 −
∑ (𝑄𝑜

𝑡 − 𝑄𝑠
𝑡)2𝑇

𝑡=1  

∑ (𝑄𝑜
𝑡 − 𝑄̅𝑜)2𝑇

𝑡=1

 
Eq. 5.8 

𝑄𝑜
𝑡  Observed discharge value at timestep t [m3/s] 

𝑄𝑠
𝑡 Simulated discharge value at timestep t [m3/s] 

𝑄̅𝑜 Mean of observed discharges [m3/s] 

 

 

 

Figure 5.21. Discharge Curve of the Final Calibration of the OpenLISEM Schematization of the Boven Geul. The Simulated 

Discharge is shown in blue and the Measured Discharge is shown in orange. The Nash-Sutcliffe Efficiency is 0.90. 

Saturated Hydraulic Conductivity Maps 

Figure 5.22 shows the Saturated Hydraulic Conductivity (Ksat) maps of the Boven Geul corresponding 

to the final calibration. Figure 5.22a shows the Ksat map of Soil Layer 1 which has an average Ksat 

value of 21.1 mm/h. The effect of the LULC on this soil layer is clearly visible in this map. Especially 

by the red areas displaying the built-up areas, and the blueish areas at forested locations. Figure 5.22b 

shows the Ksat map of Soil Layer 2 which has an average Ksat value of 16.9 mm/h. The Ksat values of 

this map are only determined based on soil properties, there is no effect of LULC on the Ksat of this 

soil layer. 
 

 
a 

 
b 

Figure 5.22. Saturated Hydraulic Conductivity (Ksat) maps of the Final Calibration for the Boven Geul Belgium. (a) shows 

the Ksat map of Soil Layer 1, and (b) the Ksat map of Soil Layer 2. 
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Channel Discharge at the Outlet Point versus Total Discharge at the Outlet Point 

An important decision that is made during the calibration is to use the channel discharge at the outlet 

point instead of the total discharge at the outlet point. Figure 5.23 shows the difference between the two 

with the simulated channel discharge in dark blue and the simulated total discharge (all) in light blue. 

At the peak discharges, the channel overflows resulting in water leaving the catchment as floodwater. 

This is not included in the channel discharge, which is why the total discharge is higher during the peak 

flows. At the outlet point, the channel flows through a bridge (see Section 3.3) which means that in 

reality (flood)water can only leave the catchment through this bridge. OpenLISEM is not aware of this 

situation. The channel discharge in a flooded channel induces uncertainty due to the occurrence of 

floodwater runoff that is not directly attributed to channel discharge. It seems to give an underestimation 

of the discharge at the peak. On the other hand, the measured discharge at the outlet point is determined 

with a stilling will and a rating curve between the water level and the discharge. This rating curve also 

induces uncertainty because it does not include these extreme water levels (and the corresponding 

changing wetted perimeter). The measured discharge is thus probably an underestimation in these kind 

of flood situations. Given both uncertainties, it is decided to use the channel discharge at the outlet point 

as the most suitable parameter for calibration. 

 

Figure 5.23. Visualization of the difference in Simulated Channel Discharge at the Outlet Point (dark blue) and the 

Simulated Total Discharge (light blue). 
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5.4 Scenarios and Strategies 

Table 5.6 shows the overview of the scenarios and strategies that are simulated with the OpenLISEM 

flood model of the Boven Geul catchment. Apart from the Reference Scenario, two Land Use Land 

Cover (LULC) scenarios and two dam strategies are simulated. The dam strategies are an initial design 

to explore their impact on the outflow from the Boven Geul. The concept of the scenarios and strategies 

is explained in Chapter 4.  

 
Table 5.6. Overview of the Scenarios and Strategies that are simulated with the OpenLISEM Flood Model of the Boven Geul 

Catchment. 

Type of Scenario/Strategy Short Description 

Reference Scenario The reference scenario (equal to the final calibration) without 

any adjustments or measures. 

LULC Scenarios Forest Scenario Best-case scenario. All grassland and cropland are turned 

into forest. 

Paved Scenario Worst-case scenario. The entire catchment consists of hard 

surfaces, there is no infiltration. 

Dam Strategies Dam Strategy 1 Small dams (including a culvert with a certain maximum 

discharge) are placed across the river channel at 3 locations 

to delay the water. 

Dam Strategy 2 Small dams (including a culvert with a certain maximum 

discharge) are placed across the river channel at 7 locations 

to delay the water. 
 

5.4.1 Land Use Land Cover Scenarios 
The LULC Scenarios consist of a Forest Scenario and a Paved Scenario. The Forest Scenario is 

parameterized by adjusting the LULC map of the Reference Scenario such that all Cropland and 

Grassland is converted into Forest (see Figure 4.1a). The soil hydrologic property maps of Soil Layer 1 

are then automatically adjusted by the Database Generator based on this new LULC map. The Paved 

Scenario is parameterized by turning the entire Boven Geul catchment into built-up area with hard 

surfaces on top of it leading to zero infiltration (illustrated by Figure 4.1b). The exact changes that are 

made in terms of input data are explained in Table 9.10 in Appendix D. 

 

5.4.2 Dam Strategies 
This report explores two dam strategies, each with a different number of small dams, to analyse the 

effect of the (number of) dams on the outflow from the Boven Geul. These are an initial exploration to 

investigate how effective they can be. Dam Strategy 1 consists of three dams at the locations shown in 

Figure 5.24a. Dam Strategy 2 is similar, but it contains dams at four more locations (see Figure 5.24b). 

Appendix E shows Google Earth Photos of dam locations 1, 2, 3, 4 and 7 which helps to illustrate how 

these areas look like. The average storage capacity of the dams is approximately 15600 m3 (see Table 

9.11 in Appendix E), which is significantly more than the storage capacity of the water retention basins 

in the Dutch part of the Geul which is approximately 1500-3000 m3 (Winteraeken & Spaan, 2010).  

 

The dam locations are selected based on the following criteria: 

• The dams are located at a place where an overflowing river channel would be relatively 

harmless (e.g., next to grassland or forest). 

• The dam locations are chosen such that the area that floods because of the dam does not contain 

any buildings or roads. 

• The dams are located in different branches of the Boven Geul and at different positions along 

the river (some more upstream, some more downstream). 

• The dams are mostly in branches with a high channel discharge in the Reference Scenario, such 

that they have a significant impact on the outlet discharge. 
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The maximum discharge capacity through the culverts must not be too low because a significant part 

of the discharge is not very harmful. Therefore, there is chosen to set the maximum discharge capacity 

equal to 50% of the maximum channel discharge at that location in the Reference Scenario. The dams 

are parameterized by making the following two changes to the input data of the Reference Scenario: 

1. The elevation of the dams is parameterized by adding 2 meters to the DEM at the pixels of the 

dam location (this is done by using the ‘buffer.map’ in OpenLISEM). 

2. The culverts through the dams are parameterized by adding their maximum discharge capacities 

to the existing culverts map (chanmaxq.map in in OpenLISEM). 

 

 
a 

 
b 

Figure 5.24. Location of the Dams for Dam Strategy 1 (a) and Dam Strategy 2 (b). Appendix E shows Google Earth Photos 

of Dam Locations 1, 2, 3, 4 and 7. 

 

5.5 Semi-Structured Interviews 

Semi-structured interviews are conducted with the Municipalities of Kelmis and Raeren and Contrat de 

Rivière Meuse Aval (Comité Local Gueule). There has been contact with civil servants of the 

Municipalities of Kelmis and Raeren both at the start (Dec 2022) and end of the research (Oct 2023). 

The Comité Local Gueule is only contacted at the start of the research. This is a non-profit organization 

that aims to connect the different stakeholders involved with the river Geul. 

 

The first goal with the semi-structured interviews is to gain insight into the water management structure 

in Wallonia and the current state of water management in the Boven Geul Belgium. The second goal is 

to acquire understanding of the effects of the flood event in the Boven Geul and whether they are 

considering mitigation measures. The third is to discuss the feasibility of implementing potential flood 

mitigation measures – specifically the proposed dam strategies – in the Boven Geul. Appendix F.1 

provides the main questions that were posed. 
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6 Results 

6.1 Results of the Laboratory Soil Analysis 

Table 6.1 shows the overview of the average values of the soil samples for the Dry Bulk Density, 

Porosity, Saturated Hydraulic Conductivity (Ksat), and Soil Organic Matter content per LULC class. 

What stands out is the huge difference in average values between the different land use classes. The 

Forest samples have a very low average dry density and a high average Soil Organic Matter content. 

This is because the soil samples are taken at the surface, where there is a substantial amount of litter 

present in the topsoil. This causes a low Bulk Density. The Maize samples on the other hand have the 

highest average dry Bulk Density and the lowest average Soil Organic Matter content. There is more 

mineral material in these samples which makes them heavier. However, the extremely high average 

Ksat of Maize is what stands out, especially in relation to the average Ksat of the Grassland samples, 

which theoretically should be of similar order of magnitude. An explanation could be that the samples 

were taken in December when freezing and thawing causes macropores and fissures in the soil8. 

Sometimes farmers plough the topsoil in autumn, letting it freeze and disintegrate into smaller 

aggregates so that in the spring the topsoil needs little extra tillage to prepare a seedbed. Ma et al. (2019) 

demonstrates that the Ksat significantly increases with factors of up to 20 during the initial 4-5 freeze-

thaw cycles. The following sections give a closer look at these differences. An overview of the 

individual sample values is displayed in Appendix G. 

 
Table 6.1. Overview of the Average Values of the Soil Samples for the Dry Bulk Density, Porosity, Saturated Hydraulic 

Conductivity and Soil Organic Matter Content. 

 Average Dry 

Bulk Density 

(kg/m3) 

Average 

Porosity (-) 

Average Saturated 

Hydraulic 

Conductivity (mm/h) 

Average Soil 

Organic Matter 

Content (%) 

Maize Samples 1113 0.52 2399 6.7% 

Grassland 

Samples 

943 0.58 75 10.9% 

Forest Samples 404 0.61 1434 42.6% 

All Samples 869 0.63 1350 17.6% 

 

6.1.1 Soil Organic Matter Content 
Figure 6.1 shows the scatter plot and the boxplot of the Soil Organic Matter (SOM) content values of 

the soil samples. The SOM values are classified per each of the LULC classes. The SOM values that 

are computed by OpenLISEM and used in the schematization for soil layer 1 are shown in the scatter 

plot in dark grey9. Table 6.2 shows the median, average and standard deviation of the soil samples, and 

also the average of the model values.  

 

Several observations stand out regarding the values of the soil samples. Firstly, the SOM values of the 

Forest samples are notably the highest and have by far the widest range of values (standard deviation: 

21%). In contrast to the lower SOM values of the Maize and Grassland samples and their relatively low 

standard deviation. The high SOM values of the Forest samples demonstrate that they consist to a large 

extent of organic material, explaining the high Ksat values and low Bulk Density values. This is in line 

with literature showing a huge decrease in Bulk Density values for an increasing Soil Organic Matter 

content (Périé & Ouimet, 2007).  

 
8 NOTE: the soil samples were collected at 20 and 21 December 2022. The soils in the Boven Geul were frozen 

during the preceding week.  
9 NOTE: the results from the laboratory soil analyses are not used to adjust the model values. The model values 

are properties that OpenLISEM computes with pedotransferfunctions based on data from SoilGrids. These values 

are corrected for land use based on a chosen parameterization (see Appendix B.3). 
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Secondly, the SOM values of the Grassland samples are significantly larger than the SOM values of the 

Maize samples; meaning that the Grassland samples consist of more organic matter. This aligns with 

the findings in literature where permanent grassland has SOM values that are approximately 1.8-2 times 

higher than the SOM values of cropland (Guillaume et al., 2021; Stumpf et al., 2018). The SOM results 

of this laboratory soil analysis are however significantly higher than observed in the other studies. 

Typical SOM values for permanent grassland and cropland are approximately 6.6% and 3.4% 

respectively. A likely reason for the higher SOM values in this study is that the soil samples are collected 

from the ground surface at which more organic matter is present. 

 

The SOM values of the OpenLISEM schematization are significantly lower than the SOM values of the 

soil samples. The model values are quite constant since the only spatial variation that is included comes 

from SoilGrids, which is a global-scale interpolation. The differences between the LULC classes are 

directly caused by choices in the parameterization of the LULC classes (see Appendix B.3). This makes 

it difficult to compare whether higher field values correspond to higher model values, and vice versa. 

This is also the case for the other soil hydrologic properties. 

 

 

a 

 

b 

Figure 6.1. Visualization of the Soil Organic Matter Content values of the Soil Samples per LULC Class. The Left Graph (a) 

shows the Scatter Plot including the model values in dark grey9, and the Right Graph (b) shows the Boxplot. 

Table 6.2. The Median, Average and Standard Deviation of the Soil Organic Matter Content values of the Soil Samples per 

each of the LULC Classes. The Last Column shows the Average of the Model Values of the SOM at the Same Locations as 

the Soil Samples. 

 Soil Organic Matter Content (%) 

Soil Samples Model 

Median Average Standard Deviation Average 

Maize  6.0% 6.7% 2.0% 3.3% 

Grassland  10.4% 10.9% 2.4% 4.9% 

Forest  46.9% 42.6% 21.0% 5.3% 

All Samples 9.9% 17.6% 18.6% 4.4% 
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6.1.2 Porosity & Bulk Density 
Figure 6.2 shows the scatter plots of the dry Bulk Density (a) and the Porosity (b), and the box plots of 

the dry Bulk Density (c) and the Porosity (d). The values are visualized per each of the LULC classes 

Maize (yellow), Grassland (green) and Forest (dark green). The Bulk Density and Porosity values that 

are computed by OpenLISEM and used in the schematization for Soil Layer 1 are shown in the scatter 

plots in dark grey9.  Table 6.3 displays the median, average and standard deviation of the Dry Bulk 

Density and Porosity values per each of the LULC classes. It also shows the average Bulk Density and 

Porosity values of the model values at the same locations.  

 

The scatter plot (Figure 6.2a) and the boxplot (Figure 6.2b) of the Dry Bulk Density show clear 

differences between the different LULC classes. The Bulk Density of the Maize samples is clearly the 

highest, whereas the Bulk Density of the Forest samples is significantly the lowest by a considerable 

margin. A similar pattern can be observed in the Bulk Density values that are used in the model, 

although these values are significantly higher. The Bulk Density values of the Maize samples come 

closest to the model values. The difference is caused by the higher SOM values of the soil samples, 

which result into lower bulk densities (Périé & Ouimet, 2007). The Maize samples contain less SOM 

than the other samples, which is why they are the most similar to the model values. The extremely low 

values of the Forest soil could be explained by the substantial presence of organic matter, that loses 

cellular moisture in the lab test (oven dried), while this is in fact not pore space. According to (Périé & 

Ouimet, 2007), Bulk Density values of around 400 kg/m3 are quite common for soils that have SOM 

contents of 25% or higher.  

 

Another notable difference is that the Bulk Density values of the Forest samples are much more 

widespread than the Bulk Density values of Grassland and Maize (similar for the Porosity). Which also 

appears from the difference in standard deviation between the Forest samples (147 kg/m3) and the 

Grassland/Maize samples (~104 kg/m3). This could be explained by the variation in SOM values, which 

is also high for the Forest samples (see Figure 6.2). 

 

Higher bulk densities typically mean lower porosities. The scatter plot (Figure 6.2b) and the boxplot 

(Figure 6.2d) of the Porosity show a similar trend. The Maize samples display a significantly lower 

Porosity than the Grassland samples. In general, the Forest samples have the highest Porosity values, 

except for three of the samples (samples 22, 23, 24)10. The differences align with literature, the values 

of the Grassland and Forest samples are however significantly higher than typical Porosity values in 

literature (Shrestha & Kafle, 2020; Wubie & Assen, 2020). The differences could be explained by the 

relatively high SOM values that cause higher porosities (Sekucia et al., 2020). Some extreme Porosity 

values of the Forest samples are a little unrealistic, particularly Sample 41 which has a Porosity of 0.80 

meaning that 80% of the sample consisted of pore space. This could be explained by cellular moisture 

of the organic matter that gets evaporated in the lab test, while it is in fact not pore space. 

 

Porosity is a very constant parameter; the model values, and also the Grassland and Maize samples, 

show this constant behaviour. A comparison between the model and sample values shows that the Maize 

values are relatively comparable, more than the Grassland and Forest values. An explanation for this 

could be that the Maize samples have smaller SOM values, which are more comparable to the SOM 

values in the model. 

 

 
10 NOTE: These three samples have very high SOM values and very low dry and saturated bulk densities, which 

is contradictory to the small porosity. It remains unclear whether these values really depict the field values or 

whether this is because of a measurement error.  
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a 

 
b 

 

 
c 

 
d 

Figure 6.2. Visualization of the Dry Bulk Density and Porosity Values of the Soil Samples. The Upper Graphs show Scatter 

Plots of the Dry Bulk Density (a) and the Porosity (b). The Lower Graphs show Boxplots of the Dry Bulk Density (c) and the 

Porosity (c) of the Soil Samples. All Graphs show the Dry Bulk Density and Porosity values per each of the LULC Classes. 

The Scatter Plots also show the model values in dark grey9 

Table 6.3. The Median, Average and Standard Deviation of the Dry Bulk Density and Porosity of the Soil Samples per each 

of the LULC Classes. The 5th and 9th Column show the Average of the Model Values of the Bulk Density and Porosity at the 

Same Locations as the Soil Samples. 

 Dry Bulk Density (kg/m3) Porosity (-) 

Soil Samples Model Soil Samples Model 

Median Average Standard 

Deviation 

Average Median Average Standard 

Deviation 

Average 

Maize  1090 1113 103.3 1335 0.51 0.52 0.029 0.50 

Grassland  957 943 104.7 1229 0.60 0.58 0.039 0.54 

Forest  342 404 146.8 1055 0.69 0.61 0.14 0.60 

All  989 869 309.7 1225 0.58 0.58 0.093 0.54 
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6.1.3 Saturated Hydraulic Conductivity 
Figure 6.3 shows the scatter plot and box plots of the Saturated Hydraulic Conductivity (Ksat) values 

per each of the LULC classes. The Ksat values that are computed by OpenLISEM and used in the 

schematization for soil layer 1 are shown in the scatter plot in dark grey9. Be aware of the logarithmic 

scale of the vertical axis in the scatter plot (a). Table 6.4 shows the median, average and standard 

deviation values of the soil samples and the average Ksat of the model values at the same locations.  

 

The huge Ksat values are mainly caused by what is already highlighted in the previous sections: the 

large SOM values of the soil samples. Apart from this, the most striking aspect of the plots is the huge 

variation in the Ksat values. Particularly the Maize samples, with values ranging from below 1 mm/h 

till above 10 000 mm/h. This huge variation is probably caused by the freezing and thawing of the soil 

in the weeks before the collection of the soil samples, as explained in the introduction of this Section 

6.1. The Ksat values of the Grassland samples exhibit the most consistent behaviour of the three LULC 

classes, although the standard deviation is still relatively large with 124 mm/h. Another remarkable 

aspect is that both the Grassland and Maize samples include several Ksat values below 1 mm/h. While 

the lowest Ksat value of the Forest samples is 141 mm/h. The soil surface of the Forest is thus in general 

very permeable, while for Grassland and Maize there are some points that are poorly permeable. 

 

The Ksat values in the OpenLISEM schematization (shown in dark grey) are much more constant than 

the sample Ksat values. Mainly because these values are based on data from SoilGrids, which is a 

global-scale interpolation. The variability of the Ksat in reality is much higher, which is also illustrated 

by the variability of the Ksat sample values. The Ksat of Forest is much higher for the samples than for 

the model values, which is probably the result of the high SOM content in the Forest samples. Such a 

pattern is more challenging to observe for the Ksat of Grassland and Maize. The Ksat values of the 

samples are both significantly higher and significantly lower in comparison to the model Ksat values. 

Both the average and median of the sample values are not comparable to the average of the model 

values, although the median provides a more accurate comparison. The Ksat sample values of Sample 

15 (Grassland: 9.2 vs 11.8 mm/h), Sample 19 (Maize: 8.1 vs 9.6 mm/h) and Sample 32 (Grassland: 13.9 

vs 18.0 mm/h) are quite comparable to the Ksat model values. However, no special patterns are observed 

in the values for the Bulk Density, Porosity and SOM of those samples. 

 

Table 6.4. The Average and Standard Deviation of the Saturated Hydraulic Conductivity (Ksat) per each of the LULC 

Classes. The Last Column shows the Average Model Value of the Ksat at the Same Locations as the Soil Samples. 

 Saturated Hydraulic Conductivity (mm/h) 

Soil Samples Model 

Median Average Standard Deviation Average 

Maize  135 2399 3733 9.6 

Grassland  3.03 75 124 16.2 

Forest  887 1434 1733 42.2 

All Samples 167 1350 2700 20.4 
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Figure 6.3. Visualization of the Saturated Hydraulic Conductivity (Ksat) values of the Soil Samples per LULC Class. The 

Upper Graph (a) shows the Scatter Plot including the model values in dark grey9, and the Lower Graph (b) shows the 

Boxplots per LULC Class. Be aware of the logarithmic scale of the vertical axis in the scatter plot (a), and the different 

vertical axis values per boxplot (b-d).  
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6.2 Boven Geul: Flood Simulation Results 

6.2.1 Reference Scenario (Best Calibration) 
Figure 6.4 shows the discharge curve of the Reference Scenario in dark blue. At the start of the rainfall 

event, the discharge peak responds relatively little to the rainfall. The largest part of the rainfall is 

probably infiltrated into the soil. From 14 July 12:00 (day 195.5) the discharge starts to increase towards 

high discharges, while the rainfall intensities do not really increase. This indicates that the overland 

flow mechanism is that of Saturated Overland Flow, more than Hortanian Overland Flow: the soils are 

relatively permeable which means that the soil profile ‘fills up’ with rainfall before overflowing. The 

rainfall intensity is less important. The total rainfall in the Boven Geul is equal to 176mm and the total 

storage capacity of both soil layers is on average 283mm. This means that the total soil storage capacity 

is not the determining factor causing Saturation Overland Flow. The process that causes the Saturation 

Overland Flow is the saturation of the topsoil (Soil Layer 1) in a large part of the Boven Geul (81%). 

More water infiltrates into the topsoil than can percolate down to the subsoil, resulting in the saturation 

of the topsoil. Appendix H further elaborates on the levels of saturation and storage capacity of the soil 

layers.  

 

During the high discharge period (day 195.5-196.5) the discharge stays above 35 m3/s, even when the 

rainfall intensities are low. This is due to the delay that is present in the water system of the Boven 

Geul. After the extreme period, there is a long period of extended runoff of water while the rainfall 

already stopped, which also results from the delay in the water system. Table 6.5 shows the catchment 

totals of several flood parameters for the reference scenario. What stands out, is the large amount of 

rainfall that turns into outflow, which is approximately 48% for both the measured and simulated 

discharge. 
 

 

Figure 6.4. Discharge Curve of the Reference Scenario at the outlet point. The Measured Discharge at the same point is 

shown in orange. 
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Table 6.5. Boven Geul Catchment Totals for the Reference Scenario compared to the Measured Discharge 

Parameter Measured Reference Scenario 

Total Precipitation (mm) 175.51 175.51 

Total Interception (mm) - 0.64 

Total Infiltration (mm) - 83.81 

Total Outflow (mm) 84.07 85.88 

Total Surface Storage* (mm) - 5.18 

Total Discharge/Precipitation (%) 47.9% 48.9% 

Peak Discharge at Outlet (m3/s) 55.71 59.86 
* This consists of water stored at the surface (e.g., in natural depressions) and  

water in the channel that has not yet reached the outlet point. 

Figure 6.5 shows the accumulated precipitation, infiltration, runoff and outflow over the time of the 

simulation. What is remarkable, is that the huge increase in outflow is much later than the rainfall starts, 

while the rainfall intensity is not increasing over the event. First, the accumulated infiltration and 

precipitation increase relatively similarly. The difference is probably caused by the built-up area 

(especially buildings, roads and other hard surfaces). Then from approximately day 195.5 (14 July 

12:00), the accumulated infiltration does not follow the trend of the accumulated precipitation anymore. 

While the rainfall is not becoming worse. The infiltration only increases little after this point and the 

runoff and outflow increase a lot. Before this point, 72% of the rainfall infiltrates into the soil (60 mm/84 

mm), while after this point, only 25% of the rainfall infiltrates into the soil (23 mm/91 mm). This 

indicates that a large part of the topsoil has become saturated and that almost all rainfall turns into 

runoff. This point is similar to the point in Figure 6.4 where the discharge is increasing to extreme 

values. The difference between the accumulated Runoff and Outflow shows the delay that is present in 

the water system of the Boven Geul due to for example peak attenuation, flooding and culverts. The 

delay increases over the duration of the event because of the accumulation of more water in the system 

leading to more flooding. 
 

 

Figure 6.5. Accumulated Precipitation, Infiltration and Outflow (mm) over time for the Reference Scenario 
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Figure 6.6 shows the infiltration map (a), the rainfall map (b) and the infiltration percentage map (c) for 

the Reference Scenario. The dark green areas in the infiltration map depict areas in which a large amount 

of water infiltrates into the soil. These areas correspond mostly to the forested areas. The difference 

between the infiltration in forested areas and other areas correlates with the substantial difference in 

Saturated Hydraulic Conductivity between Forest and other land use classes in the model 

schematization (see Appendix H Table 9.15).  The lighter green (almost white) areas represent built-up 

areas characterized by extremely low saturated hydraulic conductivities. The infiltration percentage 

map (Figure 6.6c) is the combination of the infiltration and rainfall map. It shows the percentage of the 

rainfall that is infiltrated and it thus accounts for the rainfall variability across the catchment. The same 

patterns as in the infiltration map can be seen. Almost all rainfall infiltrates in the forested areas, whereas 

there is very little infiltration in the built-up areas. The following section provides more details about 

the differences between the land use classes.  

 
 

 
a 

 
b 

 
c 

Figure 6.6. Maps of the Accumulated Amount of Infiltration (a), Rainfall (b) and the Infiltration percentage 

(infiltration/rainfall) (c) for the Reference Scenario 
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Comparison between LULC Classes 

This section compares the influence of the different LULC classes on the runoff. The main LULC 

classes Built-Up, Forest, Cropland and Grassland are included in this comparison. It should be pointed 

out that the relative differences between the LULC classes are a direct result of the choices that are 

made in the parameterisation of the OpenLISEM schematization. 

 

Figure 6.7 shows the total Rainfall, Infiltration and Runoff in millimetres per LULC class. The LULC 

class Built-Up results into the highest runoff per unit area due to the low Ksat values. Remarkable is 

that Cropland and Grassland also have relatively high runoff amounts, which is caused by the saturation 

of the topsoil. On the contrary, Forest has extremely high infiltration and extremely low runoff per unit 

area. The topsoil under Forest does not saturate to the same extent as for other LULC classes. This is 

probably due to the higher storage capacity (48.7 mm) and Ksat (40.5 mm/h) of the topsoil under Forest 

compared to Grassland (38.4 mm; 19.4 mm/h) and Cropland (33.5 mm; 13.2 mm/h). The higher storage 

capacity results from the higher porosity of Forest soils and allows more water to be stored in the topsoil 

(Soil Layer 1) before saturation occurs. The higher Ksat facilitates faster percolation of water to the 

subsoil (Soil Layer 2). Appendix H shows further details about the different storage capacities and 

levels of saturation of the Forest, Grassland and Cropland soils. 

Figure 6.7 also shows that the rainfall is not spatially homogeneous and has small differences per LULC 

class.  
 

 

Figure 6.7. The Total Rainfall, Infiltration and Runoff in mm per LULC Class for the Reference Scenario. The LULC Class 

Water is not included because of its small surface area. 

Figure 6.8 shows the surface area percentage, runoff percentage and contribution to the total runoff (%) 

per LULC Class. The runoff percentage (runoff divided by rainfall) shows a similar trend as discussed 

before with very high runoff percentages across the LULC classes, except for Forest. The contribution 

to the total runoff is defined as the runoff of that LULC class (in m3) divided by the total runoff of all 

LULC classes. The LULC class Cropland has a relatively low contribution to the total runoff due to its 

low surface area percentage. Grassland stands out with the highest contribution, accounting for 60% of 

the total runoff, caused by both a substantial surface area percentage and a high runoff percentage. This 

is a significant contribution from a land use class from which a considerable amount of water would 

not typically be expected. However, it results from the saturation of the topsoil, causing almost all 

rainwater to runoff. Additionally, the Built-Up area makes a substantial contribution to the total runoff 

(~23%), mainly due to its extremely high runoff percentage. 
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Figure 6.8. The Surface Area Percentage, Runoff Percentage and Contribution to Total Runoff (5) per LULC Class. The 

Runoff Percentage is defined as the Runoff divided by the Rainfall. The Contribution to the Total Runoff is defined as the 

amount of runoff of that LULC class (in m3) divided by the total runoff of all LULC classes. 
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Flooded Surface Area 

Figure 6.9 shows the maximum water depths in the Boven Geul catchment during the Reference 

Scenario. Maximum water depths of more than 0.1m are made visible in this figure. Several 

observations stand out; firstly, most of the flooded surface areas result from the channel that is 

overflowing due to excess runoff. At some locations, this flooding is worsened because the channel 

discharge exceeds the maximum discharge capacity of a culvert. Secondly, there are several natural 

depressions in the landscape that fill with rainwater during the event, resulting in notably high-water 

depths. And thirdly, significant flooding occurs with considerable water depths (1.5-2m) near the outlet 

point at where the main branches of the Boven Geul come together. This significant flooding 

corresponds with available visual content from citizens of the flood event at this location (see Section 

3.4). The flooded area consists mainly of grassland, including four houses experiencing relatively severe 

flooding during the event with interior water levels of up to 50cm (according to the Municipality of 

Kelmis).  

 

 

Figure 6.9. Maximum Water Depth during the Reference Scenario. Maximum Water Depths of more than 0.1m are made 

visible. The Shaded Relief and Buildings Layer are added as Reference Layers. 

Figure 6.10 shows the total flooded surface area, number of flooded buildings and the flooded road 

length per water depth class. Flooding is characterized here from a depth of 5 centimetres. Buildings 

are assumed to have an average surface area of 100 m2 and roads are assumed to have an average width 

of 7 metres. The total Boven Geul consists of 7460 ha and approximately 18800 buildings and 226 km 

of road.  Although it constitutes a relatively small portion, still a significant number of buildings (1300 

in total) and road length (30 kilometres) have been affected by flooding. Remarkable is the significant 

portion of both roads and buildings that is flooded with water depths of more than 0.50m (class 6). The 

number of (severely) flooded buildings is significantly higher than what was indicated in conversations 

with the Municipalities of Kelmis and Raeren. This has probably to do with the 20m resolution which 

takes an average elevation for that grid cell, resulting in the lateral spread of the flooding which includes 

buildings. OpenLISEM is unaware of the existence of a building at that location; it only recognizes a 

fraction of a grid cell covered by a building. Consequently, if there is flooding at that grid cell, the 
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program assumes that the building is also flooded with the same water depth. In reality, buildings are 

slightly elevated compared to their surroundings and mostly located at the higher points of a grid cell 

which prevents them from being flooded.  

 

 

Figure 6.10. The Total Flooded Surface Area (a), Number of Flooded Buildings (b) and Flooded Road Length per Water 

Depth Class in the Reference Scenario. A guide value of 100 m2 per building and an average road width of 7 metres are 

assumed, since the OpenLISEM output contains surface areas. 
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6.2.2 Land Use Land Cover Scenarios 
Figure 6.11 shows the discharge curves of the Reference Scenario (blue), Forest Scenario (green) and 

Paved Scenario (dark grey). The discharge curve of the Paved Scenario is very massive and rapidly 

increases to extreme discharges directly at the start of the rainfall event. It maintains high discharges 

even during short periods of very low rainfall intensities. Notably, the extreme discharges of the Paved 

Scenario are significantly higher, although they are not exceedingly higher than that of the Reference 

Scenario. This indicates the effect of the saturation of the topsoil in the Reference Scenario. In the first 

part of the event, the soils infiltrate a substantial amount of the rainfall preventing the occurrence of 

high discharge levels. However, starting from day 195.5, as the soils become saturated, the discharge 

curve begins to closely resemble the discharge curve of the Paved Scenario.  

 

The discharge curve of the Forest Scenario shows a significant reduction in outflow compared to the 

Reference Scenario (peak discharge: 22.3 m3/s). As discussed in the previous section, the topsoil under 

Forest does not saturate such as the topsoil under Grassland and Cropland, which results into little runoff 

from Forest. The main part of the outflow in the Forest Scenario comes from the Built-Up area. The 

discharge curve illustrates the potential afforestation could possibly have in terms of discharge 

reduction. 
 

 

Figure 6.11. Discharge Curves of the Reference Scenario, Forest Scenario and the Paved Scenario. 

 

Table 6.6 shows the catchment totals of several hydrological parameters for the Reference Scenario and 

the LULC Scenarios. These values exhibit patterns that align with what could be expected based on the 

discharge curves. The Forest Scenario has a huge infiltration amount (132 mm), only 22% of the rainfall 

turns into channel discharge at the outlet. This water comes mostly from the Built-Up Areas. The Paved 

Scenario does not have any infiltration and almost all rainfall turns into channel discharge at the outlet 

(94%). The reason for this not being at 100% is because the discharge has not returned yet to its normal 

levels at the end of the simulation. And thereby, there are several natural depressions that retain water. 
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Table 6.6. Boven Geul Catchment Totals for the Reference Scenario, Forest Scenario and Paved Scenario 

Parameter Reference 

Scenario 

Forest Scenario Paved Scenario 

Total Precipitation (mm) 175.51 175.51 175.51 

Total Interception (mm) 0.64 1.70 0 

Total Infiltration (mm) 83.81 131.97 0 

Total Outflow (mm) 85.88 38.44 164.87 

Total Surface Storage* (mm) 5.18 4.40 10.64 

Total Discharge/Precipitation (%) 48.9% 21.9% 93.9% 

Peak Discharge at Outlet (m3/s) 59.86 22.27 79.59 
* This consists of water stored at the surface (e.g., in natural depressions) and water in the channel that has not 

yet reached the outlet point. 

Figure 6.12 shows the accumulated precipitation (grey), infiltration (green colours) and outflow 

(blue/purple colours) in millimetres over time for the different scenarios. The Paved Scenario has no 

infiltration, the outflow (light blue) starts to directly increase once the rainfall event starts. The 

difference in accumulated outflow between the Paved and Reference Scenario clearly illustrates the 

substantial impact of soils in reducing outflow. The significant increase in outflow for the Reference 

Scenario (blue) and Forest Scenario (purple) is much later than the rainfall event starts. At first, the 

accumulated infiltration of both the Reference (green) and Forest Scenario (dark green) are very similar 

and closely follow the accumulated precipitation. However, starting from day 195.5, the accumulated 

infiltration of the Reference Scenario clearly stops following the trend of the accumulated precipitation, 

leading to a rapid increase of the outflow. In contrast, the accumulated infiltration of the Forest Scenario 

continues to closely follow the trend of the accumulated precipitation. There is hardly any saturation of 

the topsoil for the Forest Scenario, leading to a much more gradual increase of the accumulated outflow 

in comparison to the Reference Scenario.  

 

 

Figure 6.12. The Accumulated Precipitation (grey), Infiltration (green colours) and Outflow (blue/purple colours) (in mm) 

over time for the Reference and LULC Scenarios. NOTE: the Infiltration of the Paved Scenario equals zero, which is why the 

corresponding curve is not included in this figure. 
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Flooded Surface Area 

Table 6.11 shows the total flooded surface area, number of flooded buildings and flooded road length 

for the Reference Scenario and the LULC Scenarios. Figure 6.13 shows the same information but 

classified into different water depth classes. In comparison to the Reference Scenario, the Forest 

Scenario leads to a reduction in both the overall flooded surface areas and for each distinct water depth 

class. There is much less runoff, resulting into less flooded areas. Nonetheless, even with this very 

extreme Forest Scenario there are still a lot of buildings that are flooded. This is partly due to the effect 

of the 20-meter grid cells, as discussed in the previous section. But it also indicates that there are a lot 

of local flooding problems within the built-up areas resulting from accumulated rainfall that can not be 

solved by reducing the runoff and outflow of the Boven Geul. These flooding problems need to be 

addressed with local mitigation measures. 

 

The Paved Scenario leads to a significant increase in overall flooded surface areas and for each distinct 

water depth class. Particularly notable is the large increase in numbers for the most severe water depth 

class (>0.50m). All rainfall turns into runoff, resulting in a much larger volume of water simultaneously 

present in the Boven Geul, leading to increased flooding with deeper water depths. However, given this 

very extreme Paved Scenario, still only a relatively small portion of the total surface area (9.3%), 

number of buildings (7.3%) and road length (16.4%) gets flooded in the Boven Geul catchment. 

Thereby, the total number of buildings that gets flooded during the Paved Scenario (1364) is only 

slightly more than the number of flooded buildings in the Reference Scenario (1339). A substantial 

portion of the buildings (and roads) is thus situated in higher elevated areas (compared to the 

surroundings) that are not prone to flooding, even under extreme runoff conditions. 
 

Table 6.7. Total Flooded Surface Area, Number of Flooded Buildings and Flooded Road Length for the Reference Scenario 

and the LULC Scenarios. A guide value of 100 m2 per building and an average road width of 7 metres are assumed, since 

the OpenLISEM output contains surface areas. 

Type Entire 

Boven Geul 

Flooded Surface Area (>0.05m) 

Reference Forest Scenario Paved Scenario 

Total 7460 ha 517 ha 324 ha 693 ha 

Number of Buildings 18 800 1339 864 1364 

Road Length 226 km 29.9 km 20.7 km 37.1 km 
 

 

a 
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b c 

Figure 6.13. Comparison of the Flooded Surface Areas per Water Depth Class between the Reference Scenario and the 

LULC Scenarios. (a) displays the total flooded surface area per depth class, (b) displays the number of flooded buildings per 

depth class and (c) displays the flooded road length per depth class. A guide value of 100 m2 per building and an average 

road width of 7 metres are assumed, since the OpenLISEM output contains surface areas. 
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6.2.3 Dam Strategies 
Figure 6.14 shows the discharge curves of the Reference Scenario (blue) and the Dam Strategies 1 

(yellow) and 2 (dark yellow). In the initial stage of the event all three discharge curves are similar to 

each other. As soon as the curve starts to increase towards extreme discharge levels, the dam strategies 

start to work. They restrict the discharge at the dam locations to a maximum discharge, store the excess 

water and reduce in this way the discharge peaks. The more extreme Dam Strategy 2 (including 7 dams) 

accomplishes to reduce the discharge peaks even more than Dam Strategy 1. Another notable aspect of 

the discharge curves of the Dam Strategies is how long they remain at an elevated discharge level after 

the rainfall event has stopped. While the discharge curve of the Reference Scenario reduces much faster. 

This is due to the fact that, at this point, all the water retained by the dams is still draining through the 

channel. 

There is some instability in the simulations which is primarily due to the forced maximum culvert 

discharge that interferes with the kinematic wave numerical solution of the channel flow. 

 

 
Figure 6.14. Discharge Curves of the Reference Scenario (blue) and Dam Strategies 1 (yellow) and 2 (dark yellow). The 

instabilities in the discharge curve of the dam strategies results from the difficulty OpenLISEM experiences with the culverts. 

Table 6.8 shows the catchment totals of the hydrological parameters in millimetres for the Reference 

Scenario and the Dam Strategies. The infiltration is similar, since the dam strategies do not have an 

influence on the infiltration capacity of the soils. The runoff percentage is different because the 

discharge curves of the dam strategies are still at relatively high levels at the end of the simulation. The 

dams are still delivering water that they initially held back. The most remarkable difference is the 

difference between the peak discharges at the outlet. The dam strategies manage to significantly reduce 

the discharge peak to 46.98 m3/s by Dam Strategy 1 and to 36.16 m3/s by Dam Strategy 2, which means 

a discharge peak reduction of 23.7 m3/s for Dam Strategy 2. 
 

Table 6.8. Boven Geul Catchment Totals for the Reference Scenario, Dam Strategy 1 and Dam Strategy 2. 

Parameter Reference Scenario Dam Strategy 1 Dam Strategy 2 

Total Precipitation (mm) 175.51 175.51 175.51 

Total Interception (mm) 0.64 0.64 0.64 

Total Infiltration (mm) 83.81 83.82 83.84 

Total Outflow (mm) 85.88 80.40 75.54 

Total Surface Storage* (mm) 5.18 10.65 15.49 

Total Discharge/Precipitation (%) 48.9% 45.8% 43.0% 

Peak Discharge at Outlet (m3/s) 59.86 46.98 36.16 
* This consists of water stored at the surface (e.g., in natural depressions) and water in the channel that has not 

yet reached the outlet point. 



62 

 

Figure 6.15 shows the accumulated precipitation (grey), infiltration (green colours) and outflow (blue 

colours) in millimetres for the Reference Scenario and the Dam Strategies over the time of the 

simulation. The accumulated infiltration curve is similar in all three cases, since the Dam Strategies do 

not influence the infiltration. The major difference between the Reference Scenario and the Dam 

Strategies lies in the accumulated outflow curves. As mentioned earlier, there is a clear increase in the 

accumulated outflow of the Reference Scenario (light blue) from day 195.5 onwards. The Dam 

Strategies (darker blue colours) are able to somewhat mitigate this increase, resulting in lower peak 

discharge levels. These curves clearly illustrate how the Dam Strategies effectively slow down and store 

excess water at the moment that it is needed. 

 

 
Figure 6.15. The Accumulated Precipitation (grey), Infiltration (green colours) and Outflow (blue colours) in mm over time 

for the Reference Scenario and the Dam Strategies. Note: the infiltration curves are equal for all three simulations. 

Effect on Flooded Surface Area 

The Dam Strategies effectively reduce the peak discharge levels at the outlet point compared to the 

Reference Scenario. This section analyses the local effects that the strategies have at flooding within 

the Boven Geul catchment. The maps of the maximum water depths during the simulation of Dam 

Strategies 1 and 2 are shown in the Appendix I Figure 9.36 and Figure 9.37 respectively. The main 

insight from these maps is that they illustrate how the area behind the dams gets flooded. The maximum 

water depth differences between the Reference Scenario and the Dam Strategies in Figure 6.16 give 

more valuable information. Figure 6.16a shows the maximum water depth difference map between Dam 

Strategy 1 and the Reference Scenario. Red areas indicate an increase in maximum water depth in Dam 

Strategy 1, and green areas indicate a reduction in maximum water depth compared to the Reference 

Scenario. The buildings and roads are added as a reference layer. The first notable aspect are the red 

areas behind the dams, indicating a maximum water depth increase relative to the Reference Scenario. 

The positive aspect is that within the areas of increased water depths, there are no buildings or roads. 

Furthermore, the maximum water depths along the channel downstream of the dams have been reduced 

compared to the Reference Scenario (green areas). Especially Dam 3 in the Göhl branche results in a 

significant decrease in maximum water depths. There are also some natural depressions which are 

coloured green. It is not clear why the maximum water depths at these locations decreases when 

compared to the Reference Scenario. 

 

Figure 6.16b shows the maximum water depth difference map between Dam Strategy 2 and the 

Reference Scenario. The addition of four extra dams in Dam Strategy 2 compared to Dam Strategy 1 

has led to an even higher decrease of maximum water depths along the channels downstream of the 

dams. The problematic area close to the outlet point is one of the locations that really benefits from the 

dam strategy with a reduction of maximum water depths up to 1.5 metres. Reducing the maximum water 
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depths to approximately 40 centimetres. The red areas show that the dams lead to an increase in water 

maximum water depth until approximately 200-300 metres upstream of the dam, except for Dam 2 

which increases maximum water depths for a length of 600 metres. The positive aspect is that even with 

this more extreme Dam Strategy 2, there are no buildings or roads within the areas of increased water 

depth. Instead, these areas consist of grassland and forest. 

Figure 6.16c shows the maximum water depth difference map between Dam Strategy 2 and Dam 

Strategy 1. The key finding from this map is that it visualizes how the addition of dams 5 and 7 in Dam 

Strategy 2 has relieved the pressure on dams 1 and 3. Dam 3 does not even reach its maximum capacity 

in Dam Strategy 2. 

 

 
a 

 
b 

 

c 

Figure 6.16. The Maximum Water Depth Difference Maps between the Reference Scenarios and Dam Strategies. The red 

colours indicate an increase in maximum water depth, the green colours indicate a decrease in maximum water depth. (a) 

shows the maximum water depth difference between Dam Strategy 1 and the Reference Scenario, (b) between Dam Strategy 

2 and the Reference Scenario, and (c) between Dam Strategy 2 and Dam Strategy 1. 

Table 6.9 indicates whether the dams in Dam Strategy 1 have reached their maximum water storing 

capacity. Table 6.10 does the same for Dam Strategy 2. The dams in Dam Strategy 1 have all been 

overflown, meaning that they reached their water storing capacity. However, this is not the case for 

Dam Strategy 2, where dams 3, 4 and 6 did not experience overflow. They could have stored even more 

water. 
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Table 6.9. Table indicating whether the dams in Dam Strategy 1 have reached their water storing capacity. 

Dam Strategy 1 

Dam 

Number 

Maximum Culvert 

Discharge (m3/s) 

Maximum Culvert 

Discharge Reached? (y/n) 

Dam overflown? (y/n) 

1 7.3 Yes Yes 

2 1.9 Yes Yes 

3 9.2 Yes Yes 

 
Table 6.10. Table indicating whether the dams in Dam Strategy 2 have reached their water withholding capacity. 

Dam Strategy 2 

Dam 

Number 

Maximum Culvert 

Discharge (m3/s) 

Maximum Culvert 

Discharge Reached? (y/n) 

Dam overflown? (y/n) 

1 7.3 Yes Yes 

2 1.9 Yes Yes 

3 9.2 Yes No 

4 2.1 Yes No 

5 7.4 Yes Yes 

6 14.5 Yes No 

7 6.4 Yes Yes 

 

Flooded Surface Area per Water Depth Class 

Table 6.11 shows the flooded surface areas corresponding to the maximum water depth maps from the 

previous section. What stands out is that the flooded surface area of Dam Strategies 1 and 2 is smaller 

than the Reference Scenario. The same holds for the flooded number of buildings and road length. 

Figure 6.17 presents the same information, but distinctions have been made between various water 

depth classes. Figure 6.17a shows the comparison of the total flooded surface area per water depth class 

between the Reference Scenario and Dam Strategies. Figure 6.17b and c show the same for the flooded 

number of buildings (b) and flooded road length (c). The same trend is evident as in Table 6.11. For 

each water depth class, the flooded surface area of the Dam Strategies is either the same as or lower as 

for the Reference Scenario. The same pattern is observed for the flooded buildings and roads.  
 

What should be pointed out is the slight increase in flooded buildings for Dam Strategy 2 with respect 

to Dam Strategy 1, especially in the depth class above 0.50 metres. This should not be the case, as the 

flooded areas upstream of the dams do not reach buildings. This difference is caused by a small part of 

the urban area in Kelmis where the model simulates an increase in maximum water depth for Dam 

Strategy 1 with respect to Dam Strategy 2. A part of this flooding is local flooding caused by rainfall 

accumulation and another part is inundation from the channel of the Tuljebach. The dams should not 

affect the Tuljebach, as they are in different branches of the Boven Geul. The only difference the dams 

make concerning the Tuljebach is that the river discharge values of the Göhl are less extreme at the 

point where the Tuljebach joins the Göhl. This should not result in more severe flooding of buildings 

in Kelmis and along the Tuljebach for Dam Strategy 2 compared to Dam Strategy 1. This is likely 

caused by some model instability, possibly originating from the culverts of the Dam Strategies. 

Regardless of this, Dam Strategy 2 appears more favourable for both the Boven Geul catchment, and 

the outflow compared to Dam Strategy 1.  
 

Table 6.11. Total Flooded Surface Area, Number of Flooded Buildings and Flooded Road Length for the Reference Scenario 

and the Dam Strategies. A guide value of 100 m2 per building and an average road width of 7 metres are assumed, since the 

OpenLISEM output contains surface areas. 

Type Entire Boven 

Geul 

Flooded Surface Area (>0.05m) 

Reference Dam Strategy 1 Dam Strategy 2 

Total 7460 ha 517 ha 493 ha 479 ha 

Number of Buildings 18 800 1339 1190 1207 

Road Length 226 km 29.9 km 27.8 km 27.7 km 
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a 

 
b 

 
c 

Figure 6.17. Comparison of the Flooded Surface Areas per Water Depth Class between the Reference Scenario and the 

LULC Scenarios. (a) displays the total flooded surface area per depth class, (b) displays the number of flooded buildings per 

depth class and (c) displays the flooded road length per depth class. A guide value of 100 m2 per building and an average 

road width of 7 metres are assumed, since the OpenLISEM output contains surface areas. 
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6.3 Results of the Semi-Structured Interviews 

This section provides the key findings from the semi-structured interviews, the elaborated results are 

provided in Appendix F.2. Note that the key findings and results are based on meetings with civil 

servants of the municipalities of Raeren and Kelmis and a water expert from the Local Comité La 

Gueule. 

 

Water Management in Wallonia 

The water management structure in Wallonia is significantly different from the structure in the 

Netherlands. This structure is explained in Section 3.2 and complicates water management because 

different parties are responsible for different parts of the river, and they are not very well-informed 

about each other’s activities. The water management in the Belgium part of the Geul is mainly focused 

on water quality rather than water quantity. There are for example a lot of issues with missing sewer 

system due to which untreated water flows into the Geul. Since the July 2021 Flood event, 

municipalities and other parties are exploring flood mitigation strategies. 

 

July 2021 Flood Event in the Boven Geuldal Belgium 

The main finding related to the flood event is that there was not a lot of flood damage within the Boven 

Geul catchment. The civil servants mentioned some flooded roads, basements and inundated gardens. 

There are only 4 flooded buildings which experienced interior water levels of about 50cm, close to the 

outlet point. Section 3.4 further elaborates on the flash flood effects in the Boven Geul. 

 

Actions and Measures related to the July 2021 Flood Event in the Boven Geuldal Belgium 

There are no flood mitigation measures implemented yet in the Boven Geuldal Belgium. Both 

municipalities are exploring mitigation strategies. The Municipality of Raeren is about to choose which 

mitigation measures they are going to implement, based on a study of the University of Aachen. These 

measures (e.g., water retention basins) are focused on local flooding in their municipality, which 

occurred mostly in the village of Raeren. This village is not part of the Boven Geul catchment. The civil 

servants of both municipalities mentioned that they also feel responsible for flooding problems 

downstream and that they are willing to cooperate with measures that reduce these effects. 

 

Feasibility of the Implementation of the Dam Strategies 

The dams of the dam strategies are located at land that is owned by someone. These landowners are 

mostly farmers (e.g., for Dam Locations 2, 3 and 7), but could also be other landowners or the forestry 

administration (Dam Location 1). In general, the contact between farmers and the municipalities is 

good. The willingness to cooperate with these kinds of measures differs per farmer. The younger 

farmers are generally more willing to cooperate than the older farmers. 

 

The following parties should be included in the implementation process: 

• The landowners: they should be contacted and included in the process since their agreement is 

needed. There should be a financial compensation for the landowners. 

• Other relevant authorities that should agree with changes related to the Boven Geul: Province 

of Liege (responsible for Category 2 Rivers), Walloon Region (responsible for the course of 

the river) and other municipalities. 

 

The following actions are important for the success of the implementation: 

• Early and transparent communication with the landowners (most important). 

• Compensation for the landowners. 

• Cooperation between all relevant authorities. 

• There should be sufficient money: some party needs to take responsibility and take the lead. 

 

What should be pointed out is that the civil servants of both municipalities were very interested in the 

Dam Strategies and are willing to consider these kinds of measures. 
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7 Discussion 

7.1 Reflection on the Contribution to the Wickedness of 

the Study 

This study aims to reduce the wickedness of the problem situation related to the flash floods of July 

2021 in the Geul catchment. This is done by decreasing the knowledge uncertainties related to what 

happened in the Boven Geuldal Belgium during the event and the quantitative effects of potential 

mitigation measures. The analysis of the simulations of the Reference Scenario, LULC Scenarios and 

Dam Strategies results into useful knowledge regarding the knowledge uncertainties. However, new 

knowledge does not always reduce the wickedness of a problem. This section reflects on the 

complexities that are still present. 
 

The first complexity is the complex parameterization of LULC changes. The simulated effect of these 

LULC changes is directly dependent on choices in the parameterization of the LULC classes. The Forest 

Scenario shows how effective potential LULC changes could be in terms of reducing runoff. However, 

different choices in the parameterization of the Forest LULC class could for example result in much 

more runoff. On top of that, the land where potential LULC changes may occur is owned by someone. 

Large-scale afforestation is needed to achieve a significant reduction in runoff and outflow. It is 

extremely difficult to purchase such a significant area from landowners.  
 

Another very important complexity is the local effect of mitigation measures versus their effect on the 

discharge. The Dam Strategies mainly reduce the discharge and flooding adjacent to the river channels, 

while they are not improving local flooding within built-up areas. Thereby, they increase flooding at 

the dam locations, which are located at land that is owned by someone. This makes it difficult to create 

support for the implementation of such strategies. Afforestation is a well-known flood mitigation 

measure that should reduce the flash flood effects. The Forest Scenario has a greater local effect than 

the Dam Strategies (considerably fewer flooded buildings) but also reveals that the largest portion of 

the local flooding remains unresolved with this approach. This indicates a general lack of clear 

understanding about what does or does not work for a specific sub-catchment. The fact that such a large-

scale extreme measure does not prevent the majority of the local flooding will not contribute to its 

acceptance. It shows the need for a hybrid approach including local mitigation strategies at flooding 

locations within Built-Up areas.  

 

7.2 Reflection on the Results of the Laboratory Soil 

Analysis. 

The results of the laboratory soil analysis are characterized by a huge variation, particularly in the values 

of the Saturated Hydraulic Conductivity (Ksat). A lot of the measured Ksat values equal literature Ksat 

values for gravel, while the soils are clearly not gravel. Another notable aspect is that the bulk density 

values of the samples are relatively low and the Soil Organic Matter (SOM) values relatively high. The 

extreme variation in the values prevented their use for adjusting the soil hydrologic property values in 

the model. This section critically discusses several factors that could be the reason for the extreme 

values and variation of the laboratory results. 
 

The first factor is that the samples are collected from the soil surface (upper 6cm of the soil). This is 

equal to the O horizon, while the soil hydrologic properties of the A horizon would have been more 

interesting for this research. The upper 6 centimetres of the soil consist for a significant part out of Soil 

Organic Matter (SOM), which is also shown by the measured SOM values. Particularly the Forest 

samples consist of a substantial amount of SOM with percentages up to 60 and 70%. Figure 7.1 

illustrates how the soil at the forest ground surface looks like at Sample Location 24. A sample taken at 

the soil surface (Figure 7.1b) clearly illustrates the soil profile of the upper 6 cm which consists of a lot 



68 

 

of organic material. The high SOM content of the soil samples is a likely reason for the high Ksat and 

low Bulk Density. This is in line with literature showing a huge decrease in Bulk Density for an 

increasing SOM content (Périé & Ouimet, 2007). Bulk Density values of around 400 kg/m3 are quite 

common for soils that have SOM contents of 25% or higher. These Bulk Densities are also observed 

for the Forest Samples. 
 

The second factor is the time of the year in which the samples are collected. The samples are collected 

in the winter (December 2022), while the flash flood event took place in the summer (July 2021). The 

soil was frozen the week before the collection of the samples. During the collection of the samples, the 

soils had already thawed, but the freezing and thawing of the ground probably caused macropores and 

fissures in the soil. Sometimes farmers plough the topsoil in autumn, letting it freeze and disintegrate 

into smaller aggregates so that in the spring the topsoil needs little extra tillage to prepare a seedbed. 

Ma et al. (2019) demonstrates that the Ksat significantly increases with factors of up to 20 during the 

initial 4-5 freeze-thaw cycles. This could explain the high Ksat of the Maize samples, particularly in 

relation to the Ksat of the Grassland samples, which theoretically should be of similar order of 

magnitude. 
 

The third factor is the huge spatial variation of Ksat values in general. The number of soil samples in 

this study seems to be insufficient to make any meaningful statements about the Ksat values, except for 

some general statements about the relative differences between the different LULC classes. Apart from 

the huge spatial variation, measured values always include a certain measurement error (fourth factor). 

Especially the permeameter infiltration test is quite sensitive and can result into strongly deviating 

values due to for example a crack along the side of the sample or other minor disturbances. It remains 

unclear whether certain extreme Ksat values truly represent reality or whether they are deviating values 

resulting from the collection and measurement process. This is because the sampling strategy of this 

study did not include the collection of multiple samples at the same location. 

 

 
a 

 
b 

Figure 7.1. (a) shows a picture of the ground soil surface in the Forest at Sample Location 24, (b) shows a sample that was 

not taken properly which demonstrates the soil profile of the upper 6cm in the Forest at Sample Location 24. (Photos taken 

by Jafeth Kuiper) 

The comparison between the soil sample values and the soil property values that are used in the 

OpenLISEM schematization shows large differences. Compared to the soil sample values, the model 

values show a significantly smaller SOM content, larger Bulk Density and in general a smaller Ksat. 

The porosity values show the highest degree of similarity between the soil sample and model values. 

The explanation for the differences could be that the model values are representative for the A horizon, 

while the soil samples are taken at the O horizon (ground surface). The large differences in SOM values 

are likely to cause the differences between the soil sample values and the model values. The Maize 

sample values are the most similar to the model values, because the difference in SOM values for Maize 

is the smallest. Another important difference between the soil sample values and model values is the 

spatial variation. The soil sample values show a much higher spatial variation compared to the model 

values that contain only little variation. This is because the only spatial variation that is included in the 

model values comes from SoilGrids, which is a global-scale interpolation. The soil sample values 

indicate that in reality there is a significantly higher spatial variation. 
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7.3 Reflection on the OpenLISEM Flood Schematization 

The OpenLISEM flood model schematization of the Boven Geuldal Belgium for the July 2021 flash 

flood event is a representation of the reality. This comes with a lot of assumptions in the development 

and calibration of the schematization. The following sections provide a critical reflection on the input 

data and choices that are made during the calibration process.  

 

7.3.1 Reflection on the Input Data 
In general, the available input data is quite detailed and accurate. However, input data never perfectly 

represents reality. The following sections provide a reflection on the input data that contains the most 

significant assumptions and/or induces the largest model uncertainty. 

 

River Network and Culverts 

The river network (including the channel dimensions) is a very important input significantly influencing 

how the discharge curve will look like. Based on observations, the river network is representing reality 

relatively well. Thereby, the channel dimensions of the schematization are quite comparable with the 

measured channel dimensions. The latter, however, is challenging to compare since OpenLISEM 

operates with a rectangle channel, while the real channel generally has a trapezoidal shape. It could be 

that OpenLISEM overestimates the channel cross-section, leading to insufficient water delay as a result 

of water overflowing the banks. The relatively high Channel Manning’s n (0.1) may be compensating 

for this. 

 

Another important factor that causes a significant difference between the model and the reality is the 

20 metres resolution. By rasterizing the river network to this resolution, the natural meandering of the 

river is somewhat lost, which results in water reaching the outlet point more quickly. This is probably 

one of the reasons why the relatively high Channel Manning’s n of 0.1 is required to prevent the 

discharge peaks from becoming too narrow. 

 

The maximum discharge of the culverts is currently estimated with the Chézy equation, which usually 

is an equation that should be used for open channel flow. This means that the correct friction laws are 

not taken into account. It could result in both an under- and overestimation of the maximum discharge 

depending on the characteristics of the culvert. With the application of the equation, an approximation 

of the slope is used based on the 1-metre DEM because the actual slope values are unknown. 

Additionally, a Manning’s n value for concrete was employed for culverts, although they are not always 

as smooth as concrete due to vegetation, sediment, and other factors. Thereby, sediment and other debris 

could decrease the cross-section of the culverts. The discharge capacity of the culverts is thus probably 

overestimated. A significant part of the culverts is quite large and will not form an obstruction. But the 

overestimation could still result in an incorrect flow through the culverts. Thereby, not all culverts in 

the Boven Geul are included in the schematization11. It could be that the high Channel Manning’s n 

partly compensates for this uncertainty. 

 

Soil Properties and Depth 

The soil hydrologic properties are calculated with pedotransferfunctions based on primary soil 

properties obtained from SoilGrids. The values of SoilGrids are interpolated at a 250m resolution based 

on relatively little data points, even zero within the boundaries of the Boven Geuldal Belgium. The 

available data from SoilGrids is a useful method of including spatial variation, but it is not very accurate. 

While the OpenLISEM schematization is very sensitive regarding the soil hydrologic properties. This 

induces a lot of uncertainty and is also the reason why the soil hydrologic properties played a significant 

role within the calibration of the schematization.  

 

 
11 The largest part of the culverts is included. There are some culverts that were accessible for dimension 

measurements, these are not included. 
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The soil hydrologic properties in the model result in an accurate calibration. An important difference 

with reality however is the small spatial variation that the model values have. Especially, the Ksat has 

a very high spatial variation, which also appears from the laboratory results of the soil samples. A higher 

spatial variation of the soil hydrologic properties would also result into a runoff with a higher spatial 

variation.  

 

There is a significant uncertainty in the soil depths of the OpenLISEM schematization because there is 

no available data on soil depths for this sub-catchment. The soil depths are assumed to be relatively 

shallow based on observations and the geological subsurface. Especially, the soil depth of the topsoil is 

an important model uncertainty since it significantly influences when the topsoil is saturated. The soil 

depth of the subsoil is less important because the total storage capacity of the soil is probably enough 

to infiltrate the total rainfall amount (175.5mm). Currently, the storage capacity of the (top)soil is 

mainly influenced by changing the Initial Moisture Content. It could be that the relatively high Initial 

Moisture Content compensates for the even smaller soil depths in reality. 

 

Buildings 

Buildings are not included as obstacles in the OpenLISEM schematization in order to simulate the 

number of flooded buildings. Otherwise, they would be part of the DEM, and the water will flow around 

them. Instead, they are made permeable with a high surface roughness of approximately 0.5 (default in 

OpenLISEM). Another reason for this is that OpenLISEM only knows the fraction of a grid cell that is 

covered by a building. At a 20-meter resolution, including buildings as obstacles would not be highly 

representative. However, in reality most of the buildings are impermeable forcing the water to flow 

around them. Thereby, there are many more small obstacles present in the Built-Up area that delay the 

water flow. It could be that the current manning’s n for Built-Up area is an underestimation of reality 

leading to faster runoff. 

 

Rainfall 

The radar rainfall from the KNMI is adjusted based on gauge measurements and it is the best 

approximation of the rainfall that is available. Rainfall has a major influence on the output of the 

schematization, which makes this approximation of the rainfall event still a significant model 

uncertainty. The timing difference between the discharge peaks of the measured discharge curve and 

the simulated discharge curve could for example be the result of a slight shift in the rainfall input relative 

to the actual rainfall. Furthermore, the rainfall intensity is a very important factor in flash flood 

modelling. The radar rainfall consists of hourly average rainfall values, which do not account for 

specific periods within that hour with extreme rainfall intensities. The impact of these hourly values on 

the discharge curve is expected to be somewhat limited for this flash flood event because the critical 

factor is primarily the total duration of rainfall rather than the rainfall intensity.   

 

7.3.2 Reflection on the Calibration 
The calibration of the OpenLISEM schematization of the Boven Geuldal Belgium is quite well with a 

Nash-Sutcliffe Efficiency of 0.90 for the output discharge curve, compared to the measured discharge 

curve. There are some aspects at which the curves do not match. The first is the timing of the discharge 

peaks: the simulated discharge peaks are slightly earlier than the measured discharge peaks. This could 

be the result of a slight shift in the rainfall input or a delaying process within the sub-catchment that is 

not included in the model. The second aspect are the first two simulated discharge peaks; these are 

significantly smaller than the measured discharge peaks, and they (incorrectly) return to relatively low 

discharge levels after the peaks. A possible explanation for the runoff underestimation at the start of the 

event could be that the Ksat for a part of the catchment is too high leading to an underestimation of the 

Hortanian Overland Flow.  

 

Several choices are made during the calibration process of the schematization. They are listed below, 

together with a critical reflection on this choice: 

• Initial Moisture Content of 0.5 (between Field Capacity and Saturation): the choice for this 

value really improves the calibration. However, this value indicates that the soils are quite wet, 



71 

 

while there was not a significant amount of rainfall in the period leading up to the event. It is 

possible that this value compensates for another value or process that is incorrect in the model. 

It might be the case that the soils in reality are even shallower than represented in the model. 

Which means that this initial moisture content compensates for too large soil depths. 

• Channel-specific Manning’s n of 0.1: this is quite a high value that increased the width of the 

discharge peaks. The channels are quite rough with many twists and dense vegetation along the 

bank, and even in the channels and banks at multiple locations. Despite this, the Channel 

Manning’s n value is still relatively high. It is possible that this value compensates for another 

process that delays the channel flow. There are various possibilities for which it could 

compensate. The first being the shortened meandering pattern caused by the rasterization of the 

flow network to 20-metres resolution. The second is the potential overestimation of the channel 

cross-section leading to faster runoff during extreme discharge levels. The third is the likely 

overestimation of the culvert discharge capacities and the absence of certain culverts in the 

schematization. These processes are described in more detail in the previous section. 

• Using similar primary soil properties for both soil layers: both soil layers have as input the 

primary soil properties of SoilGrids at a depth of 15-30cm. This choice is made because of the 

shallow soils. The resulting soil hydrologic property values, and in particular the relatively high 

Ksat values, improved the calibration substantially. The Ksat values are high compared to the 

Ksat values resulting from using primary soil properties of a deeper depth class of SoilGrids. 

The largest part of the soil sample Ksat values is still significantly higher. It is uncertain to what 

extent the model values accurately reflect reality.  

• The channel discharge at the outlet point as best measure for the calibration instead of the total 

discharge at the outlet point from the Boven Geul: there is a difference between the two during 

the most extreme discharge levels (see Figure 5.23 in Section 5.3.4). This is because the channel 

floods during those extreme discharge levels, causing water to leave the catchment as 

floodwater, which is not included in the channel discharge. This induces uncertainty. The 

choice to use channel discharge may lead to an underestimation of the total discharge from the 

catchment. However, it is decided to use the channel discharge for calibration because the 

measured discharge values are likely underestimations as well. These measurements are 

determined based on water level measurements and a rating curve that converts these water 

levels into discharge values. This rating curve probably does not account for these extreme 

situations and the corresponding changing wetted perimeter of the channel. Therefore, the 

channel discharge at the outlet point is selected as the best measure for the calibration. 

 

A critical note that should be mentioned related to the calibration is that the schematization is only 

calibrated to this specific rainfall event. It has not been validated for other rainfall events, for which the 

discharge curve could be less accurate. 

 

7.4 Reflection on the Flood Simulation Results  

High Infiltration in Forested Areas 

The soils under Forest infiltrate almost all rainfall and do not get saturated during the event. On the 

contrary, the topsoil under Grassland and Cropland (and the other LULC classes) reaches saturation 

after some time because the water does not percolate fast enough to the subsoil. This difference is caused 

by the internal hydrology in OpenLISEM and is likely influenced by the higher storage capacity (48.7 

mm) and Ksat (40.5 mm/h) of the topsoil under Forest compared to Grassland (38.4 mm; 19.4 mm/h) 

and Cropland (33.5 mm; 13.2 mm/h). The higher storage capacity results from the higher porosity of 

Forest soils and allows more water to be stored in the topsoil (Soil Layer 1) before saturation occurs. 

The higher Ksat facilitates faster percolation of water to the subsoil (Soil Layer 2). Furthermore, there 

is an important spatial effect related to the supply of water from upstream (run-on). The total water 

supply to a pixel can be higher than the rainfall due to the run-on. This run-on is higher for Grassland 

and Cropland than for Forest, as all the water infiltrates in the Forest. 
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Based on the simulations, Forest has a very positive impact on the runoff and outflow. An important 

nuance that should be emphasized is that the impact of Forest on runoff is highly sensitive to choices in 

the parameterization of the LULC classes. Forest could have a significantly different impact with a 

slightly different parameterization. The high Ksat of Forest is supported by the soil sample results, but 

Forest is not a homogeneous land use class. In reality there are for example also paths that are more 

compacted, leading to less infiltration. Furthermore, the effect of the Forest Scenario is only analysed 

for the rainfall event of July 2021. Forest also has a maximum capacity; it could be that the positive 

impact of Forest is significantly less for another rainfall event. 

 

High Number of Flooded Buildings in the OpenLISEM Simulations 

The flood simulations result in a much higher number of flooded buildings than what was reported 

during conversations with the municipalities (see Section 3.4 and Appendix F.2). A significant 

disclaimer should be made in this regard. The schematization makes a large overestimation in flooded 

buildings which is mainly caused by using 20-meter resolution grid cells for which an average elevation 

is taken; resulting in the lateral spread of the flooding which includes buildings. OpenLISEM is unaware 

of the existence of a building at that location; it only recognizes a fraction of a grid cell covered by a 

building. Consequently, if there is flooding at that grid cell, OpenLISEM assumes that the building is 

also flooded with the same water depth. In reality, buildings are slightly elevated compared to their 

surroundings and mostly located at the higher points of a grid cell which prevents them from being 

flooded. The OpenLISEM schematization is thus not useful in determining the amount of damage to 

buildings. Instead, it could be used as a relative indication of the flooded building area. 

 

Effect of Dam Strategies on the Peak Discharge in the Dutch part of the Geul 

The aim of the study is to explore how much the peak outflow from the Boven Geul could be reduced 

in order to reduce the peak discharge levels in the Dutch part of the Geul, particularly Valkenburg. The 

peak discharge in Valkenburg during the event was equal to 135 m3/s (Asselman & Van Heeringen, 

2023). The Geul channel in Valkenburg could handle approximately 70 m3/s without overflowing. The 

Dam Strategies have a significant impact on the outflow from the Boven Geul. Dam Strategy 2 even 

reduces the discharge peak by 23.7 m3/s. Although this is a significant decrease, it is evident that more 

mitigation strategies are needed to prevent river flooding in Valkenburg during these kinds of events. 

Besides, an important nuance that should be included here is that a certain reduction in discharge levels 

from the Boven Geul catchment may not correspond to an equivalent reduction in discharge levels in 

the Netherlands. The flattening of the discharge peaks, known as “peak attenuation”, results in lower 

discharge peaks but with a longer duration, causing the peak discharge reduction in the Netherlands to 

be smaller. 

 

Another important nuance is that it is relatively difficult to optimize the Dam Strategies for every 

rainfall event, since the amount of rainfall is not known in advance. The Dam Strategies are relatively 

effective in reducing the outflow regarding the July 2021 flash flood event. However, their effect could 

be less for a different rainfall event. 

 

Combination of Mitigation Strategies 

This study does not consider a combination of mitigation strategies. This could however have a very 

positive impact on the outflow and local flooding. A combination of afforestation and the Dam 

Strategies would lead to a substantial decrease in outflow, potentially exceeding the impact of Dam 

Strategy 2 alone. The total runoff is reduced due to the additional forest, meaning that the discharge 

capacities of the dams could be reduced, which leads to a further decrease of the peak outflow. These 

strategies could be further combined with mitigation strategies that specifically focus on local flooding. 

As long as these mitigation strategies focus on the infiltration, delay, or storage of water, it will have 

no negative impact and may even have a positive effect on the outflow. 

 

 

 



73 

 

7.5 Reflection on the Feasibility of the Dam Strategies 

The Dam Strategies significantly reduce the peak outflow, which has a positive downstream effect. Also 

within the Boven Geul, for example, related to the flooded area close to the outlet point. However, there 

is no positive effect on the local flooding within Built-Up areas (pluvial flooding). The Dam Strategies 

are thus not very advantageous for the Boven Geuldal Belgium, which complicates its implementation. 

 

Apart from the technical effects of the Dam Strategies, there is also a social perspective related to the 

feasibility of the implementation of the Dam Strategies. The land at which the dams are located is owned 

by someone, which are primarily farmers in this case. The feasibility of the implementation strongly 

depends on the willingness of these landowners to cooperate, since they need to agree with the 

implementation of the dams. Therefore, it is important to include them early in the process and ensure 

a proper compensation. In comparison to large-scale afforestation, the Dam Strategies should be much 

easier to implement, since much less land is needed for the Dam Strategies. Thereby, apart from the 

dam, most of the time, there will be no inundation of the land since the dam discharge capacities are 

focused on extreme discharge levels. Inundation will only occur during extreme rainfall events, leading 

to relatively little inconvenience for landowners. 

 

Another factor that complicates the implementation of these kinds of measures is the water management 

structure in Wallonia. A lot of different authorities need to be included in the process of river-related 

mitigation measures (Province, Walloon Region, Municipalities). Civil servants of the Municipalities 

of Kelmis and Raeren were very interested in the Dam Strategies during the interviews, and they were 

willing to consider these kinds of measures. However, they are not allowed to implement such measures 

as a municipality, since all the relevant authorities should be included in the process. On top of that, 

money is also a factor that makes the implementation challenging. 
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8 Conclusions and Recommendations  

8.1 Conclusions 

This study aims to estimate to what extent potential flood mitigation measures in the Boven Geuldal 

Belgium sub-catchment (also called “Boven Geul) could reduce the runoff contribution to the Dutch 

part of the Geul while also addressing local flood problems. First, the spatial variation of different soil 

hydrologic properties has been measured across different LULC classes (Maize land, Grassland, Forest) 

in the Boven Geul12. After which an OpenLISEM flood schematization of the Boven Geul is developed 

and calibrated to the flash floods that happened in July 2021. This schematization is then used to 

determine how the water system of the Boven Geul functioned during the flash flood event and what 

processes caused the high runoff percentage from this sub-catchment. Two extreme LULC scenarios 

(Paved Scenario, Forest Scenario) are used to increase the understanding of the Boven Geul water 

system, and to investigate what effect afforestation could potentially have on the outflow and flooding. 

Furthermore, the effects of a water storing and delaying flood mitigation measure are simulated with 

the OpenLISEM schematization. The evaluation of the so-called Dam Strategies considers their impact 

on both the outflow and the local flooding of the Boven Geul. The main conclusions per objective are 

presented in the following sections.  

 

A disclaimer should be included here: be aware that all the interpretations are based on a first setup of 

a representation of the Boven Geul which has its limitations. 

 

8.1.1 Spatial Variation in Soil Hydrologic Properties between Maize land, 

Grassland and Forest in the Boven Geuldal Belgium 
Disclaimer: these interpretations are based on 37 collected soil samples which showed quite some 

variance. The soil samples are collected from the soil surface (the upper 6cm of the soil), which contains 

substantial percentages of lightweight organic matter. 

 

In general, this study shows that the upper 6 centimetres of the soil, particularly under Forest, has a 

relatively high SOM content. This results into a low Bulk Density, high Porosity and high Ksat values. 

Flood models typically do not utilize Soil Hydrologic Property values from the soil surface. However, 

this study notably demonstrates that due to the high Porosity and Ksat, the upper 6 centimetres of the 

soil has the capacity to quickly infiltrate and store a significant volume of water. 

 

Furthermore, the results show a clear difference between the soil sample values of the Bulk Density, 

Porosity and Soil Organic Matter content across the LULC classes (Maize land, Grassland and Forest). 

The Bulk Density of the Maize samples (mean: 1113 kg/m3) generally shows higher values compared 

to the Bulk Density of the Grassland samples (mean: 943 kg/m3). The Bulk Density of both the Maize 

and Grassland samples are significantly higher than the Bulk density of the Forest samples (mean: 404 

kg/m3). The Porosity of the samples demonstrates an inverse trend, with the Forest samples having the 

highest Porosity values (mean: 0.61), and the Grassland (mean: 0.58) and Maize (mean: 0.52) samples 

having lower Porosity values. What stands out, is that the Grassland samples have a significant higher 

porosity than the Maize samples. In terms of the Soil Organic Matter (SOM) content, a similar pattern 

is observed as for the Porosity. The SOM content of the Forest samples (mean: 43%) is much higher 

compared to the Grassland (mean: 11%) and Maize (mean: 6.7%) samples. Some Forest samples even 

have SOM contents exceeding 50%. The comparison between the SOM content of Grassland and Maize 

land reveals that the Grassland samples have clearly higher SOM values than the Maize samples. 

 

 

 
12 NOTE: the resulting values are not used to adjust the soil properties in the model schematization, since the results have a 

too high variance to be able to make reasonable adjustments. 
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The spatial variation of the Saturated Hydraulic Conductivity (Ksat) is highly complex, and the results 

illustrate the extraordinary variability of this parameter. The resulting Ksat values do not show a clear 

difference between the Grassland samples and the Maize samples. Although the mean and median of 

the Ksat for the Grassland (75 mm/h; median: 3.0 mm/h) and Maize samples (mean: 2399 mm/h; 

median: 135 mm/h) is very different, both LULC classes have a substantial number of samples with 

Ksat values below 10 mm/h and even below 1 mm/h. The Ksat of the Grassland samples is remarkable 

because of its low variance compared to the Ksat of the Forest and Maize samples. The Ksat of the 

Forest samples (mean: 1733 mm/h; median: 887 mm/h) consistently exhibit high values, with 140 mm/h 

being the lowest. This suggests that the Ksat of Forest is indeed extremely high in reality. 

 

8.1.2 Functioning of the Water System of the Boven Geuldal Belgium 

during the July 2021 Flood Event 
The main conclusion regarding this objective is that the high runoff percentage (48%) and extreme 

discharge levels mainly result from the saturation of the topsoil. This leads to a large contribution of 

Grassland to the total runoff (60%) on top of the runoff from Built-Up areas (23%). 

 

The dominant parameters regarding the calibration (Nash-Sutcliffe Efficiency: 0.90) of the 

schematization are the following: 

• Saturated Hydraulic Conductivity (Ksat): the input Ksat is relatively high for both Soil Layers 

1 (mean: 21.1 mm/h) and 2 (mean: 17.9 mm/h)13.  

• Initial Soil Moisture Content: the soils contain a relatively high Soil Moisture Content at the 

start of the event (halfway between Field Capacity and Saturation). 

• Soil Depth of the Topsoil: the soil depth of the topsoil is relatively shallow (40cm) 

• Flow Resistance of the Channel: the channel-specific Manning’s ‘n’ value is relatively high 

(0.1). 

 

The dominant processes regarding the runoff and outflow in the calibrated schematization are: 

1. Saturation Overland Flow: the overland flow mechanism is Saturation Overland Flow rather 

than Hortanian Overland Flow. The Saturation Overland Flow is caused by the saturation of 

the topsoil. Important parameters determining this process are the Soil Depth of the topsoil and 

the Initial Soil Moisture Content. The saturation of the topsoil causes a large part of the rainfall 

to turn into runoff. During the initial stage of the event, before 14 July 12:00, the soil infiltrates 

72% of the rainfall: 60 millimetres of infiltration compared to 84 millimetres of rainfall. After 

this moment, only 25% of the rainfall is infiltrated into the soil: 23 millimetres of infiltration 

compared to 91 millimetres of rainfall. The saturation of the topsoil leads to Grassland 

significantly contributing to the total runoff in the Boven Geul. Grassland has a surface area 

percentage of 54%, but accounts for 60% of the total runoff. 

2. Runoff from Built-Up areas: Built-Up areas contribute significantly to the runoff in the 

catchment because of their low Ksat and their extensive coverage of impermeable surfaces and 

structures. Built-Up areas have a surface area percentage of 14% and account for 23% of the 

total runoff in the Boven Geul. 

3. Significant delay in the water system of the Boven Geul: there is a significant delay between 

the runoff and outflow from the sub-catchment, which is calibrated by the high Channel 

Manning’s n (0.1). This leads to the long duration peaks and ensures that the discharge levels 

between the peaks do not decline to lower levels.  

 

An important conclusion from this study is that Built-Up areas should certainly not be considered the 

primary cause of the high discharge in the Boven Geul. Since the Grasslands account for a substantial 

higher percentage of the total runoff. On the contrary, the Forests are an important factor that reduce 

runoff due to their extremely high infiltration. The Forests can infiltrate approximately 92% of the 

rainfall because the topsoil under Forest does not experience saturation. The Forest Scenario, which 

assumes that all Grassland and Cropland is turned into Forest, clearly shows this positive effect of 

 
13 NOTE: this Ksat is still significantly lower than the largest part of the soil sample Ksat values. 
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Forest. The Forest Scenario has a lot of infiltration (75%) resulting into a significant reduction of the 

outflow. The corresponding runoff percentage is 22% and the peak discharge equals 22.3 m3/s. This 

shows the large potential afforestation could have in reducing the outflow from the Boven Geul.  

 

The Paved Scenario, which assumes that the entire catchment is covered by hard surfaces, has zero 

infiltration which leads to a massive discharge curve. It rapidly increases to extreme discharges at the 

start of the rainfall event, and it maintains high discharges even during short periods of very low rainfall 

intensities. The difference between the discharge curve of the Paved Scenario and Reference Scenario 

clearly illustrates the substantial impacts of infiltration on reducing the outflow. Especially during the 

initial stage of the event (before 14 July 12:00), the infiltration prevents a rapid increase in discharge 

levels, averting extremes observed in the Paved Scenario. However, as the topsoil saturates, this effect 

becomes less. The discharge levels of the Reference Scenario (peak discharge: 59.9 m3/s) even start to 

resemble the discharge curve of the Paved Scenario relatively closely (peak discharge: 79.6 m3/s).  

 

Regarding the local flooding issues, the Reference Scenario leads to a significant number of 1339 

flooded buildings (in total: ~18 800 buildings), even with water depths of more than 0.5m. The Paved 

Scenario particularly increases the number of flooded buildings with water depths larger than 0.5m. 

This leads to 1364 flooded buildings, indicating that the largest part of the buildings in the Boven Geul 

is not prone to inundation from the channel. The Forest Scenario leads to a decrease of number of 

flooded buildings in all water depth classes. Although this reduction is quite significant, the total number 

of flooded buildings is still 864. Therefore, converting Cropland and Grassland to Forest mainly reduces 

the outflow and is less effective in mitigating local flooding problems within Built-Up areas. 

 

8.1.3 Effect of the Dam Strategies on the Outflow and Local Flooding of 

the Boven Geuldal Belgium 
The effects of two Dam Strategies are simulated with the calibrated OpenLISEM schematization of the 

Boven Geuldal Belgium. The strategies are explained in Sections 4.2 and 5.4.2. The effects of the Dam 

Strategies are analysed for both the outflow as well as the local flooding within the catchment.  

 

Regarding the peak outflow, the Dam Strategies lead to a significant reduction. Dam Strategy 1 reduces 

the discharge peak of the Reference Scenario from 59.9 m3/s to a discharge peak of 47.0 m3/s. Dam 

Strategy 2 reduces the peak discharge to a significantly lower discharge level of 36.2 m3/s. The results 

demonstrate that the Dam Strategies are particularly effective in reducing the extreme discharge levels, 

as this is when the dams start to store and delay the water.  The total outflow remains approximately 

the same because after the event has ended, all the water that was stored by the dams continues to flow 

out. 

 

The simulations show two effects of the Dam Strategies on flooded areas within the sub-catchment. The 

first being a maximum water depth increase along the channel upstream of the dam. Significant areas 

are inundated with maximum water depths of up to 2 meters. The increased water depths upstream of 

the dams extend for a range of 200 to 300 meters for most of the dams. These areas consist mostly of 

Forest and Grassland, and no buildings or roads are affected. The other effect is a maximum water depth 

decrease along the channel downstream of the dams. Dam Strategy 1, and especially Dam Strategy 2, 

causes a substantial decrease in maximum water depths in the inundated areas along the river channel.  

Noteworthy is that the problematic area close to the outlet point, where several houses flooded during 

the flash flood events, profoundly benefits from the Dam Strategies with a reduction of maximum water 

depths up to 1.5 metres for Dam Strategy 2.  

 

In general, the results show that the Dam Strategies decrease the total flooded surface area for all 

maximum water depth classes compared to the Reference Scenario. The same is true for the flooded 

number of buildings and length of roads. These reductions are however small. The Dam Strategies 

significantly reduce the peak outflow leading to less flooding along the river channel. They do not have 

an impact on local flooding within Built-Up areas (pluvial flooding). This demonstrates that there is a 

contradiction regarding the flood mitigation strategy between what is optimal within the Boven Geuldal 
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Belgium and what is optimal for the entire Geul catchment. The Dam Strategies mainly focus on the 

peak outflow to the Geul. Additional mitigation strategies are needed to address local flooding problems 

within Built-Up areas. 

 

Another important conclusion of the study is that the current designs of the dam strategies are not 

optimized yet. The simulations indicate that it is highly advantageous to add more dams, distributing 

both the positive and negative impacts more evenly. For example, the addition of Dams 5 and 7 in Dam 

Strategy 2 has relieved the pressure on Dams 1 and 3. Dam 3 does not even reach its maximum capacity 

in Dam Strategy 2. The design could thus easily be improved, resulting in even lower peak discharge 

levels. 

 

8.1.4 Overall Conclusion 
This study demonstrates that flood mitigation strategies can significantly reduce the (peak) outflow of 

the Boven Geul. Dam Strategy 2 reduces the peak discharge from 59.9 m3/s to a maximum of 36.2 

m3/s. And the Forest Scenario (peak discharge: 22.3 m3/s) shows that afforestation has a large potential 

to reduce the outflow. Although the strategies significantly reduce flooding along the Boven Geul 

channel, even at several critical locations, they are not effective in addressing local flooding within the 

Built-Up areas. Therefore, the main recommendation for future research is to investigate the impact of 

combining strategies (Dam Strategies, Afforestation) that further reduce the outflow with strategies that 

mitigate local flooding issues within Built-Up areas.  
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8.2 Recommendations 

Recommendations for the Execution of Laboratory Soil Analysis and Collection of Soil Samples 

• It is recommended to take the soil samples deeper in the soil (e.g., at 15-20 centimetres) 

additional to collecting soil samples in the upper 6 centimetres of the soil. This would provide 

valuable insights in the variance of the soil hydrologic properties across the soil profile, which 

would help to make reasonable adjustments to the model values. 

• It is recommended to collect soil samples in the same period as the flash flood event took place, 

as the soil hydrologic properties likely vary across the seasons. 

• It is recommended to take considerably more than 37 samples (e.g., several hundred) and to 

take more samples at the same location (at least 3). It could be that one sample was 

unintentionally taken incorrectly, resulting in for example a crack in the soil sample without 

knowing. With multiple samples taken at the same location, this outlier value can be filtered 

out. 

 

Recommendations for the Improvement of the OpenLISEM Model Schematization 

• The soil depth is a very important parameter in this schematization, influencing the storage 

capacity of the soil. More research to the exact soil depths in this catchment would thus be a 

substantial improvement of the model. 

• The soil hydrological properties are currently calibrated values. This study performs research 

to the field values of these properties, but it could not be used in adjusting the soil hydrological 

property values. More extensive research to these properties in this catchment would make it 

possible to adjust the values and create an even more realistic schematization. 

• The culverts could be included with better estimates of the maximum channel discharges. For 

example, by using equations that are suitable for closed channel flow. Thereby, the missing 

culverts could also be added. 

• The current DEM that is used in the schematization is from 2013-2014. During the research a 

more recent DEM is made available at the Wallonia Geoportal (2018-2019). Implementing this 

DEM into the schematization would improve it by providing more up to date elevation values. 

• Drainage systems may be present in the area. These are not included in the current model 

schematization. It is recommended to investigate how much drainage there is present in the 

Boven Geul catchment and whether it still works. If it is substantially present, this could be an 

important process in the model accelerating infiltrated water towards the river channels. 

 

Recommendations regarding the Dam Strategies 

• It is recommended to do more research to different designs of the current dam strategies to find 

even more optimized designs. For example, more dams could be placed, or dams could be 

placed at different locations. Also, the height of the dams (currently 2 meters) and the maximum 

discharge capacities through the culverts (currently 50% of the maximum channel discharge of 

the Reference Scenario) could be adjusted. 

• It is recommended to make the maximum discharge capacity by the culverts of the dams not 

too low. Otherwise, they will cause too frequent inundation. 

• An adjustable maximum discharge capacity is recommended for the dam culverts to adjust them 

based on the predicted intensity and duration of the rainfall event.   

• It is recommended to explore different rainfall events to analyse the effect of the dam strategies 

for those events. And to investigate how the design could be improved related to different 

rainfall events. 

• It is recommended to use multiple dams within a dam strategy. Firstly, because it distributes 

the impact of the dams and secondly, it is necessary because there is a lot of water coming from 

multiple branches of the Boven Geul. The current dam strategies show that the impact is rather 

low if the peak discharge peak is a little reduced at several locations. 

• If the proposed dam locations are not feasible to implement, it is recommended to explore what 

locations could be feasible from a social context. 
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• For these flash floods, the dams in the Hohnbach and especially the Göhl sub-catchment of the 

Boven Geul are the most effective since those branches contribute the most to the overall 

discharge. There could however be different rainfall events in the future that primarily hit the 

Grünstrasserbach or Tuljebach.  

• Dam design: the dams should be sufficiently strong, and they should be designed such that they 

do not damage when they overflow. Thereby, it is important to make them aesthetically pleasing 

such that they blend well with the landscape. 

 

Recommendations regarding the investigation of combinations of flood mitigation strategies 

• It is recommended to investigate the impact of combining the Dam Strategies and afforestation 

on runoff and outflow. 

• It is recommended to investigate the impact of combining strategies (Dam Strategies, 

Afforestation) that further reduce the outflow with strategies that mitigate local flooding issues 

within Built-Up areas. 

 

Other Recommendations 

• It is recommended to investigate the relation between a discharge reduction in the Boven Geul 

Belgium and the discharge reduction in the Dutch part of the Geul.  
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9 Appendix 
Appendix A – Fieldwork Appendices 

Appendix A.1: Locations of Photos taken during 

Fieldwork 

 

Figure 9.1. Locations of the Photos of the Boven Geul Catchment taken during Fieldwork. 
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Appendix A.2: Detailed Steps of the Soil Sampling 

Strategy 

Figure 9.2a shows the Boven Geul catchment with the three selected sample zones. Figure 9.2b-d shows 

the grids that are placed upon the sample zones. The brown dots display the sample locations resulting 

from the random grid sampling strategy. The samples that are not taken are represented with an asterisk 

behind the sample number. The steps of the random grid sampling strategy are as follows: 

1. A grid is placed on top of the different sampling locations. This is the thick grid in Figure 

9.2bcd. Every thick grid cell represents the location of one sample. The numbers represent the 

corresponding sample numbers. 

2. The thick sampling grid cells are subdivided into 9 smaller grid cells, which represent the 

numbers 1-9 (see Figure 9.3). 

3. A random number generator (random.org) is used to pick a random number (1-9) for every 

sample. This random number determines in which smaller grid cell that specific sample is taken. 

The middle of this smaller grid cell is defined as the sample location (see the brown dots in 

Figure 9.2bcd). 

4. The corresponding sample locations are then added to QGIS from which the exact coordinates 

have been extracted, by adding a longitude ($x) and latitude ($y) column.  

 

 
a 
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b 

 
c 

 
d 

Figure 9.2. a: the Boven Geul catchment with the river network in dark blue and the location of the different sampling zones; 

b-d: the three sampling zones with the sampling grid on top of it. The numbers display the corresponding sample numbers. 

The brown dots represent the sample locations resulting from the random grid sampling strategy. 

* Due to circumstances, these samples have not been collected. 

 

Figure 9.3. Numbers corresponding to the smaller grid cells inside the sampling grids 
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Appendix A.3: Detailed Steps of the Collection of Samples 

The following tools are used for taking the soil samples: 

• 2 sample boxes with each 24 soil sample rings (Ø 53x50mm, contents 100 cc). Soil sample 

rings consisting of a metal ring with a sharp and blunt edge, and 2 plastic lids to close the 

sample ring. 

• Ring holder 

• Hammer  

• Scoop 

• Spatula 

• Hacksaw 

• Marker 

 

The following steps are taken to collect each of the soil samples: 

1. Move to the coordinates of the sampling location (location saved in Google Maps). 

2. Remove any twigs or vegetation at the surface of the sample location. 

3. Take the metal ring (without plastic lids) and place the sharp, cutting edge at the ground surface. 

Push it slightly in the soil (see Figure 9.4a) 

4. Place the ring holder carefully on top of the metal ring (Figure 9.4b) and use a hammer to 

vertically move the sample ring into the soil. Do this until the mark on the ring holder is at the 

height of the soil surface. It is important to hold the ring holder and metal ring as still as possible 

while executing this step. 

5. Remove the ring holder and check if the metal ring is entirely filled with soil (otherwise proceed 

with step 3). 

6. Carefully dig up the metal ring with the scoop and remove any abundant soil with the spatula 

on either of the sides. If the soil is too hard, use a hacksaw to carefully saw off the soil. Check 

if the metal ring is entirely filled after this step. If a significant part is missing, remove all the 

soil from the metal ring and start the procedure again (step 1). 

7. Close the metal ring by putting the plastic lids at both sides of the sample.  

8. Use the marker to write the sample number on one of the plastic lids. Note the combination of 

the sample and ring number and put the sample in the sample box. 

9. Fill in the fieldwork form (see Table 9.1). 

 
Table 9.1. Fieldwork Form that is filled in for each of the samples during their collection. 

Fieldwork Form 

Date:  

Location (GPS coordinates):  

Land use class:  

Soil class:  

 

SOIL SAMPLE 

Follow the procedure 

Ring number: 

Sample box number:  

 

Deviated from procedure?  Yes / No 

If yes, how? 

 

Remarks:  

 

 

OTHER OBSERVATIONS 
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What type of place is it? (crops/grass/forest) (+ photo) 

 

 

 

What do I see at the surface? (+ photo) 

 

 

Colour of the soil:  

 

Other observations: 

 

 

 

 
a 

 
b 

Figure 9.4. Photos of the Collection of a Soil Sample in a Sample Ring. The left picture (a) shows the sample ring placed at 

the soil surface in a Maize area (location of soil sample 4). The right picture (b) shows the sample ring holder being placed 

at the ring after which it is hammered into the soil. (Photos taken by Jafeth Kuiper) 
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Appendix B – Detailed Steps of the Data 

Preparation 

Appendix B.1: Preparation of the Boven Geul Catchment 

Boundaries and DEM 

Figure 9.5 shows the flowchart of the creation of the Boven Geul Catchment Boundaries, the Outlet 

Map and the DEM. The detailed steps are described below. 

 

 

Figure 9.5. Flowchart of the Creation of Boven Geul Catchment Boundaries, the Outlet Map and the DEM. 

Adjusting the extent of the raw input DEM (in QGIS) 

1. Create a new shapefile in QGIS (called “Extent_BovenGeul”) and add a polygon. Draw a 

rectangle that completely covers the Boven Geul catchment and some area around it (see the 

rectangle in Figure 9.6). 

2. Clip the Wallonia DEM (the raw input DTM Wallonia 2013-2014) to the Boven Geul Extent 

in QGIS: Raster => Extraction => Clip by Mask Layer (“Extent_BovenGeul”). Resulting in 

the “Relief_Wallonie_clip_extentBovenGeul.tif” TIFF file (see the DEM in Figure 9.6). 

 

 

Figure 9.6. Wallonia DEM clipped to the extent of the Boven Geul (“Relief_Wallonie_clip_extentBovenGeul.tif”) 
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Preparing the DEM (in Nutshell) 

1. Resample the DEM in Nutshell to 20m resolution:  
gdalwarp Relief_Wallonie_clip_extentBovenGeul.tif dem20m.tif -t_srs EPSG:31370 -tr 20 20 -r cubic -dstnodata 0 

2. Convert the DEM from a TIFF to a MAP file in Nutshell: 
pcrcalc dem20m.map=dem20m.tif 

 

Create an outlet map (in Nutshell, except for step 7) 

1. Create a Local Drain Direction (LDD) map based on the DEM: 
pcrcalc --lddin ldd.map = lddcreate(dem20m.map, 1e6,1e6,1e6,1e6) 

2. Create a map that shows the accumulated amount of upstream pixels (ups.map) based on the 

LDD map: 
pcrcalc ups.map=accuflux(ldd.map, 1) 

3. In QGIS: overlay the ups.map on the openstreetmaps.org map and decide which pixel coincides 

with the outlet point of the Boven Geul catchment (the Kelmis measurement station). Figure 

9.7 shows this ups.map and the defined outlet point. 

4. Open the “ups.map” in the Map Editor of Nutshell and create the outlet map:  
Check the box ‘Edit an empty layer’ => Click on ‘Edit single cells’ => click on the defined outlet cell and give it 

value 1 => save this new empty layer as “outlet0.map” 

 

 

Figure 9.7. Map showing the accumulated flux or the amount of upstream pixels (“ups.map”). The location of the outlet 

point is shown in the small red box. 

Creating the Boven Geul Mask map (in Nutshell) 

1. Create an LDD map with the following parameters (this is needed to get the complete Geul 

catchment) 
pcrcalc --lddin ldd.map = lddcreate(dem20m.map, 19,1e7,1e7,1e7) 

2. Create the watershed map (“ws.map”) of the Boven Geul catchment based on the LDD and 

outlet map: 
pcrcalc ws.map = catchment(ldd.map, nominal(outlet0.map)) 

3. Create the mask map (“mask.map”) of the Boven Geul Catchment with the following statement: 
pcrcalc mask.map = if(ws.map eq 1,scalar(1)) 

4. Update the mask map to get the correct extent and scale: 
resample -C mask.map mask0.map 

5. The resulting mask0.map is converted in QGIS to a shapefile (EPSG: 31370) and used as the 

Boven Geul boundaries in this research (BovenGeul_20m_31370.shp) (see the boundaries in 

Figure 9.8). 

 

Creating the Boven Geul DEM (in Nutshell) 

6. Clip the DEM for the extent of the Boven Geul (dem20m.map) to the boundaries of the Boven 

Geul catchment: 
pcrcalc demBG.map = mask.map*dem20m.map 
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7. Then resample the DEM to make the extent and scale equal to the mask0.map: 
resample --clone mask0.map demBG.map dem0.map 

8. The resulting dem0.map is used as input for the OpenLISEM Database (‘reference DEM’) (see 

Figure 9.8). 

 

 

Figure 9.8. Boven Geul Catchment Boundaries and DEM. 

 

Appendix B.2: Preparation of the River Network 

Figure 9.9 shows the flowchart of the creation of the Boven Geul River Network. The detailed steps are 

described below. 

 

 

Figure 9.9. Flowchart of the Creation of the Boven Geul River Network. 
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Preparing river network for Belgium part of the Boven Geul 

1. Clip the RHW Troncons map in QGIS to the boundaries of the Boven Geul Catchment (result: 

“River_BelgiumBG”) 
Vector => Geoprocessing Tools => Clip (Input Layer: “RHW_Troncons”; Overlay Layer: 

“BovenGeul_20m_31370”) 

 

Preparing river network for German part of the Boven Geul (in QGIS) 

2. Create shapefile boundaries for the German part of the Boven Geul Catchment. By taking the 

difference between the Boven Geul Catchment shapefile and the shapefile of all the sub-

catchments in the Walloon region (“MESU_BV”). This results in the 

“BovenGeul_Germanpart” shapefile. 
Vector => Geoprocessing Tools => Difference  

(input layer: “BovenGeul_20m_31370”; overlay layer: MESU_BV) 

3. Clip both German river network shapefiles (one contains river with water code, the other 

contains the other flowing waters) with the boundaries of the German part of the Boven Geul 

Catchment (overlay layer: “BovenGeul_Germanpart”) 
Vector => Geoprocessing Tools => Clip  

4. Combine both clipped shapefiles in one river network shapefile for the German part of the 

Boven Geul (“River_GermanBG”): 
Vector => Geoprocessing Tools => Union 

 

Combine the river networks of the Belgium and German part of the Boven Geul Catchment into one 

shapefile: 

5. Use the Union tool in QGIS to combine “River_BelgiumBG” and “River_GermanBG” into 

“RiverBovenGeul”. See the result in Figure 9.10. 

 

 

Figure 9.10. Combined River Network of the Belgium and German part (“RiverBovenGeul”) 

Rasterize the combined river network of the Boven Geul (in QGIS) 

6. Add a column in the “RiverBovenGeul” shapefile to be used for rasterizing the river network 
In the attribute table, in field calculator: 

Output field name: ‘Raster’ (whole number (integer)) 

Expression: 1 

7. Rasterize the river network to 20m resolution 
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Raster => Conversion => Rasterize (Vector to Raster) (Input layer: “RiverBovenGeul.shp “; Field to use for a 

burn-in value: “Raster”; A fixed value to burn: 1; Output raster size units: georeferenced units; resolution: 20m; 

Output extent: calculate from layer (“BovenGeul_20m_31370”). Export as “river0.tif” 

 

Smoothening and cleaning the river network (in Nutshell) 

8. Making the extent of the river network equal to the extent of the mask0.map. 
pcrcalc river0.map = river0.tif 

resample --clone mask0.map river0.map river1.map 

9. Smoothening the river network (removing unnecessary river pixels resulting from rasterizing) 

a: creating the LDD of the channel 
pcrcalc --lddin lddchan.map=lddcreate(river1.map*dem0.map,1e6,1e6,1e6,1e6) 

b: creating the ups.map representing the number of upstream pixels for the river network 
pcrcalc ups.map=accuflux(lddchan.map,1) 

c: create a new version of the river network without the river pixels that have no upstream area 

(value 1 in ups.map) 
pcrcalc river2.map=if(ups.map gt 1,scalar(1)) 

10. Repeat step 9 another two times (in total 3 iterations), resulting in “river4.map”. See the 

difference in Figure 9.11. 

11. Removing loose parts of the river network, because OpenLISEM can not handle river parts that 

are not connected to the main river network. The result ‘river6.map’ is shown in Figure 9.12, 

the removed loose parts are shown in red. 
a: Open ‘river4.map’ in Map Edit: edit polygon => draw a polygon such that the loose river part is in it => give it 

the value 0. 

b: do this for all the 8 river parts that need to be removed and save the Map Edit as a new map ‘river5.map’ 

c: make a new river network version in which only the river pixels have a value (1). The removed parts turn into ‘no 

data’. 

pcrcalc river6.map=if(river5.map gt 0, scalar(1)) 

 

 

Figure 9.11. Versions of the Boven Geul River Network before (River1.map) and after (River4.map) smoothening the river 

network. 

Adding a missing river part (this part is present based on real life observations) (in Nutshell): 

1. Create a river network based on the DEM (‘rivDEM.map’). This map is used as a reference 

map for the missing part. 
pcrcalc rivDEM.map=if(accuflux(ldd.map,cellarea()) gt 200000,1,0)*mask0.map 

pcrcalc rivDEM.map=if(rivDEM.map gt 0,scalar(1)) 

2. Select and save the river cells from the ‘rivDEM.map’ that need to be added to the current river 

network (‘river6.map’) to fill the missing part. This part (‘addedriver_1.map’) is shown in light 

blue in Figure 9.12. 
a: Open in Map Edit ‘river6.map’ and ‘rivDEM.map’ to determine the cells that need to be added. 

b: Edit an empty map => select the cells and give them value 1 => save the empty map as ‘addedriver_1’. 

c: Make a new version of the ‘addedriver_1.map’ that only covers the cells that need to be added 

pcrcalc addedriver_1.map=if(addedriver_1.map gt 0,scalar(1)) 
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3. Combine the current river network (‘river6.map’) with the river part that needs to be added 

(‘addedriver_1.map’). Figure 9.13 shows the resulting final river network (‘river8.map’). 
a: Open in Map Edit ‘river6.map’ and ‘addedriver_1.map’ => edit an empty map and save the empty map as 

river7.map (the added part gets automatically value 0). 

b: Make a new version of the river network where all river pixels have value 1 (also the added part). 

pcrcalc river8.map=if(river7.map ge 0,scalar(1)) 

 

 

Figure 9.12. Boven Geul River Network Version 6 visualized in dark blue. The removed loose parts are shown in red. The 

river segment displayed in light blue is added to the river network in version 7. 

 

 

Figure 9.13. The Final River Network of the Boven Geul. 
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Appendix B.3: Preparation of the Soil Maps 

Figure 9.14 shows the maps that the Database Generator uses from SoilGrids (see the light green box 

in the left). The Database Generator corrects the Bulk Density and Soil Organic Carbon (SOC) content 

maps of the upper soil layer based on the Land Use Land Cover map. The Bulk Density is corrected 

with a relative bulk density factor and the SOC content is corrected by a relative addition. Table 5.3 in 

Section 5.3.3 shows the corresponding values per each of the LULC classes (columns 5 and 6).  This is 

how the infiltration capacity differs per each of the LULC classes in the OpenLISEM model 

schematization. 

 

Bilinear interpolation is applied to smoothen the soil property maps since the SoilGrids values 

correspond to the midpoint of the 250m grid cells. Then the Database Generator computes the three 

maps shown in dark green in Figure 9.14 for both the upper and lower soil layer with the help of 

pedotransferfunctions. The results of the analysis of the soil samples are not used to adjust these maps, 

since the results are too ambiguous to be able to make reasonable adjustments. 

 

 

 

Figure 9.14. Overview of Soil Input and Output in the OpenLISEM Database Generator. 
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Appendix B.4: Preparation of the Boven Geul LULC Map 

Figure 9.15 shows the flowchart of the creation of the Boven Geul LULC Map. The detailed steps are 

described below. 

 

 

Figure 9.15. Flowchart of the Creation of the Boven Geul LULC Map. 

Preparing LULC map Belgium part of the Boven Geul Catchment 

Clip the LULC map of the Province Liege to the Belgium part of the Boven Geul Catchment (in QGIS) 

1. Convert the LULC map of the province Liege (WAL_UTS_2018) to CRS projection EPSG 

31370. 
“Save features as” with CRS EPSG:31370 to “WAL_UTS_2018_31370” 

2. Clip the LULC map of the province Liege to the boundaries of the Boven Geul catchment. 
Vector => Geoprocessing Tools => Clip (Input layer: “WAL_UTS_2018_31370”; overlay layer: 

“BovenGeul_20m_31370.shp”), export as “Landgebruik_util_2018_BG” 

3. Make sure the resulting LULC map is only covering the Belgium part of the Boven Geul 

Catchment. The result is the LULC map of the Belgium part of the Boven Geul Catchment. 
Vector => Geoprocessing Tools => Difference (Input layer: “Landgebruik_util_2018_BG”; overlay layer: 

“BovenGeul_Germanpart”), export as “WG_landuse_BelgiumBG” 
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Reclassify the LULC map to the new coherent LULC classes (reclassification as is shown in Table 9.2) 

(in QGIS) 

4. Add a column ‘lucode’ with the corresponding new LULC classes to the LULC map of the 

Belgium part of the Boven Geul catchment (“WG_landuse_BelgiumBG”). 
In the attribute table, in the field calculator: add a field with Output field name ‘lucode’ and the following 

expression: 

 

case 

when MAJ_NIV1 = 2.0 or MAJ_NIV1 = 3.0 or MAJ_NIV1 = 4.0 or MAJ_NIV1 = 5.0 or WALOUSMAJ = 

'1_1_2' then 101 

when WALOUSMAJ = '1_2' or MAJ_NIV3 = '7_0_0' or MAJ_NIV3 = '7_0_1' then 506 

when WALOUSMAJ = '1_1_1_B' or WALOUSMAJ = '1_1_1_C' then 520 

when WALOUSMAJ = '1_1' or WALOUSMAJ = '1_1_1' or WALOUSMAJ = '1_1_1_A' then 521 

when MAJ_NIV1 = 6.0 or WALOUSMAJ = '1_3' then 526 

when WALOUSMAJ = '1_4' or MAJ_NIV3 = '7_0_2' then 1 

end 

 
Table 9.2. Overview of the Reclassification of the German and Belgium LULC classes into six general LULC Classes. 

LULC Classes Consisting of the following land use classes: 

Name Code German LULC map Belgium LULC map 

Water 1  Aquaculture Et Pêche (1_4), Zones 

Naturelles Aquatiques (7_0_2) 

Built-up area 101 Residential (7203) 

Industrial (7204) 

Commercial (7209) 

Recreation_ground (7211) 

Retail (7212) 

Farmyard (7228) 

 

Production secondaire (geheel ; 2) 

Production tertiaire (geheel ; 3) 

réseaux De Transport, Logistique et 

Réseaux D’Utilité Publique (geheel ;4) 

Usage Résidentiel (geheel ; 5) 

Agriculture code 1_1_2 (vaak de 

bebouwde plekken van de agriculture) 

Forest 506 Forest (7201) 

Nature_reserve (7210) 

Scrub (7217) 

 

Zones Naturelles (7_0_0, 7_0_1) 

Sylviculture (1_2) 

Cropland 520 Farmland (7229) 

Orchard (7215) 

Agriculture code 1_1_1_B en 1_1_1_C 

(kerstbomen, 1x) 

Grassland 521 Meadow (7208) 

Grass (7218) 

Heath  (7219) 

Agriculture code 1_1, 1_1_1, 1_1_1_A 

Other 526 Other (non defined) (7230) Autres Usages (geheel ; 6) 

Industries Extractives (1_3) 

 

Preparing LULC map German part of the Boven Geul Catchment 

Clip the LULC map of Köln municipality to the German part of the Boven Geul catchment (in QGIS) 

1. Use the ‘Clip’ tool in QGIS, the result is the LULC map of the German part of the Boven Geul 

catchment. 
Vector => Geoprocessing Tools => Clip (Input layer: “gis_osm_landuse_a_free_1.shp”; Overlay layer: 

“BovenGeul_Germanpart), export as “gis_osm_landuse_GermanBG” 

 

Fill in the land use gaps in the LULC map of the German part of the Boven Geul catchment. These will 

be defined as “Other” (in QGIS) 

2. Create a shapefile of the undefined parts. 
Vector => Geoprocessing Tools => Difference (Input layer: “BovenGeul_Germanpart”; Overlay layer: 

“gis_osm_landuse_GermanBG”), export as “landuse_GermanBG_undefined” 

3. Combine the shapefile of the undefined parts with the LULC map of the German part of the 

Boven Geul catchment. 
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Vector => Data Management Tools => Merge Vector layers (Input layers: “gis_osm_landuse_GermanBG”, 

“landuse_GermanBG_undefined”; Destination CRS: EPSG 31370), export as 

“gis_osm_landuse_GermanBG_complete” 

4. Define the undefined parts as a new LULC class “Other” with LULC code “7230”. 
Edit attribute table of “gis_osm_landuse_GermanBG_complete”, give code “7230” and fclass “other” to the 

undefined landuse polygon. 
 

Reclassify the LULC map to the new coherent LULC classes (reclassification as is shown in Table 9.2) 

(in QGIS) 

5. Add a column ‘lucode’ with the corresponding new LULC classes to the LULC map of the 

German part of the Boven Geul catchment (“gis_osm_landuse_GermanBG_complete”). 
In the attribute table, in the field calculator: add a field with Output field name ‘lucode’ and the following 

expression: 

 

if(code=7201 or code=7210 or code=7217,506,if(code=7203 or code=7204 or code=7209 or code=7211 or 

code=7212 or code=7228,101,if(code=7229 or code=7215,520,if(code=7208 or code=7218 or 

code=7219,521,if(code=7230,526,0))))) 

 

Combine German and Belgium LULC map to a coherent initial LULC map of the Boven Geul 

Catchment 
 

Combine both LULC maps into one LULC map (in QGIS) 

6. Merge the LULC maps “WG_landuse_BelgiumBG” and 

“gis_osm_landuse_GermanBG_complete” into one shapefile. 
Vector => Data Management Tools => Merge Vector layers (destination CRS EPSG: 31370), export as 

“landuse_BGtotaal2” 

7. Add a ‘luclass’ column with the LULC class name corresponding the the LULC class code 

column ‘lucode’. 
In the attribute table, in the field calculator: add a field with Output field name ‘luclass’ and the following 

expression: 

 

case 

when lucode=101 then 'Built-up' 

when lucode=506 then 'Forest' 

when lucode=520 then 'Cropland' 

when lucode=521 then 'Grassland' 

when lucode=526 then 'Other' 

when lucode=1 then 'Water' 

end 
 

Rasterize the resulting LULC map of the Boven Geul catchment (in QGIS) 

8. Rasterize “landuse_BGtotaal2” with a resolution of 20m (result is shown in Figure 9.16). 
Raster => Conversion => Rasterize (field to use for a burn-in value: ‘lucode’; output raster size units: 

‘georeferenced units’; resolution: 20; output extent: calculate from layer “BovenGeul_20m_31370”), export as 

“Landuse_BGtotaal2_raster” 
 

 
Figure 9.16. The Initial LULC Map of the Boven Geul. 
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Add the information from the crop parcel map of 2021 to the initial LULC map (type of cropland) 

 

Prepare the Crop Parcel Map of 2021 for the Boven Geul catchment (in QGIS) 

5. Convert the CRS of the crop parcel 2021 map of the Province Liege to EPSG: 31370. 

6. Clip the crop parcel map to the boundaries of the Boven Geul catchment. See the result in 

Figure 9.17. 
Vector => Geoprocessing Tools => Clip (Input layer: “SIGEC_PARC_AGRI_ANON_2021”; Overlay layer: 

“BovenGeul_20m_31370), export as “Parcelen_Agriculture_2021_BG” 

 

 
Figure 9.17. Map showing the type of crop per parcel for the year 2021 in the Boven Geul catchment. 

Reclassify the Crop Parcel Map (see the reclassification in Table 9.3) and make sure it covers the entire 

surface area of the Boven Geul catchment (in QGIS) 

7. Reclassify the crop parcel map into grassland (code 521) and cropland (code 520). Grassland 

consists out of ‘Meadow and forage’ (Cult_code = 6), cropland consists out of the other crop 

parcel classes. 
In attribute table, field calculator: add column ‘lucode’ (integer) with the following expression: 

case 

when CULT_COD = 6 then 521 

else 520 

end 
8. Make a difference shapefile consisting of the part of the Boven Geul catchment that is not 

covered by the Crop Parcel Map. 
Vector => Geoprocessing Tools => Difference (Input layer: BovenGeul_20m_31370; Overlay layer: 

Parcelen_Agriculture_2021_BG), export as “Difference_BG” 

9. Add a column ‘lucode’ to this shapefile with code 1. 
Attribute table, field calculator: Output Field Name ‘lucode’ (integer), expression = 1 

10. Merge the difference shapefile with the crop parcel map. 
Vector => Data Management Tools => Merge Vector Layers (Input layers: “Difference_BG”, 

“Parcelen_Agriculture_2021_BG”; destination CRS: EPSG: 31370)), export as 

“Parcelen_Agriculture_2021_BGtotaal” 

 
Table 9.3. Overview of the Reclassification of the Crop Parcel Map Classes into the general LULC Classes Grassland and 

Cropland. 

LULC Class Crop Parcel Map Class 

Code Name Code (‘CULT_COD’) Name 

520 Cropland 71 Fodder Beet 

73 Alfalfa 

85 Other sown cutlery than those already listed 

99 Other 
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201 Maize 

321 Winter barley 

883 Short rotation forest crops (very short rotation 

coppice) 

884 Miscanthus 

9732 Multi-year fruit crops (plums) – tall stems 

9742 Multi-year fruit crops – tall stems 

521 Grassland 6 Meadow and forage 

 

Rasterize the crop parcel map and add this information to the initial LULC raster map of the Boven 

Geul catchment (in QGIS) 

11. Rasterize the crop parcel map 
Raster => Conversion => Rasterize (Input layer: “Parcelen_Agriculture_2021_BGtotaal”; field to use for a burn-

in value: “lucode”; output raster size units: georeferenced units; resolution: 20; output extent: calculate from layer 

“BovenGeul_20m_31370”), export as “Parcelen_Agriculture_2021_BG_raster” 

12. Overwrite the LULC raster map with the crop information of the crop parcel map (only 

overwrite if crop parcel map has code 520 or 521). 
Raster calculator (result: “Landuse_parcel_BG_raster”), expression: 

if ("Parcelen_Agriculture_2021_BG_raster@1" = 

1,"Landuse_BGtotaal2_raster@1","Parcelen_Agriculture_2021_BG_raster@1") 

 

Add several ponds as ‘water’ to the initial LULC map 

Three ponds in the Boven Geul catchment are relatively big and close to the Geul river (see Figure 

9.18), while they are defined as Forest (code 506) in the initial LULC raster map. These pixels have 

been replaced by Water (code 1). The procedure below describes how the Casinomeer (close to Kelmis) 

has been added to the LULC map. The two ponds close to the Hammerbrücke (Hammerbrückemeren) 

have been added in the same way. Figure 9.18 shows the result (“Landusev2”), which is the final LULC 

raster map of the Boven Geul catchment. 

 

Prepare the shapefile of the Casinomeer that will be used to adjust the initial LULC map (in QGIS) 

13. Create a shapefile of the Casinomeer based on the Google Satellite image (see Figure 9.18). 
Create new shapefile layer (“Casinomeer”) => Toggle Editing => Create New Polygon Feature => draw the shape 

of the Casinomeer based on the underlying Google Satellite layer => Save Feature. 

14. Create a shapefile of the Boven Geul catchment without the Casinomeer shapefile. 
Vector => Geoprocessing Tools => Difference (Input: “BovenGeul_20m_31370”; Overlay Layer: “Casinomeer”) 

15. Merge the Casinomeer shapefile with the Difference shapefile (output of step 22) to get a 

shapefile that completely covers the Boven Geul catchment. 
Vector => Data Management Tools => Merge Vector Layers (Input layers: “Casinomeer”, “Difference”), export 

as “CasinomeerBG” 

 

Rasterize the Casinomeer shapefile (“CasinomeerBG”) and add the Casinomeer as ‘Water’ to the initial 

LULC raster map 

16. Add a column to the “CasinomeerBG” shapefile that will be used for rasterizing. 
In attribute table: add column ‘Raster’ (integer) with value 1 for the Casinomeer and value 2 for the other part of 

the Boven Geul Catchment (“Difference”) 

17. Rasterize the “CasinomeerBG” shapefile using the ‘Raster’ column (20m resolution). 
Raster => Conversion => Rasterize (Input layer: “CasinomeerBG”; Field to use for a burn-in value: “Raster”; 

Output raster size units: georeferenced units; Resolution: 20; Output Extent: calculate from layer 

“BovenGeul_20m_31370”), export as “Casinomeer_raster” 

18. Add the Casinomeer as ‘Water’ to the initial LULC raster map.  
Raster Calculator: if ("Casinomeer_raster@1"=1,1,"Landuse_parcel_BG_raster@1"), export as “Landusev1”. 
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Figure 9.18. The Final LULC Map of the Boven Geul Catchment including the visualization of the three ponds that are 

added as ‘Water’ to this map. 

 

 

Appendix B.5: Preparation of the NDVI Boven Geul Map 

Figure 9.19 shows the flowchart of the creation of the NDVI map for the Boven Geul catchment. The 

detailed steps are explained below. 

 

 
Figure 9.19. Flowchart of the Creation of the NDVI Map for the Boven Geul Catchment. 

 

Compute the NDVI map based on bands 4 and 8 of the Sentinel 2 data (in QGIS) 

1. Use bands 4 and 8 in the Raster Calculator (Export as “NDVI_20210721”): 
( " T31UGS_20210721T104031_B08@1" - " T31UGS_20210721T104031_B04@1" ) / ( 

"T31UGS_20210721T104031_B08@1" + "T31UGS_20210721T104031_B04@1" )  

 

Prepare the NDVI map for the Boven Geul catchment database 

2. Reproject the current NDVI map and convert to 20m resolution (in QGIS). 
Raster => Projections => Warp (Reproject), from EPSG 32631 to EPSG 31370 at resolution 20m. Save as 

“NDVI_20210721_31370_20m” 

3. Adjust the NDVI map to the Boven Geul extent (in Nutshell). 
pcrcalc NDVI_20210721_31370_20m.map=NDVI_20210721_31370_20m.tif 

resample --clone mask0.map NDVI_20210721_31370_20m.map NDVI__BG_20210721_31370_20m.map 

pcrcalc NDVI_BG.map = mask0.map*NDVI__BG_20210721_31370_20m.map 

 

  



105 

 

Appendix B.6: Preparation of the Building Map 

Figure 9.20 shows the flowchart of the creation of the buildings map of the Boven Geul Catchment. 

The detailed steps are explained below. 

 
Figure 9.20. Flowchart of the Creation of the Buildings Map of the Boven Geul catchment. 

Prepare the building shapefile for the Belgium part of the Boven Geul catchment (in QGIS) 

1. Clip the building shapefile of Belgium to the boundaries of the Boven Geul catchment. 
Vector => Geoprocessing Tools => Clip (Input layer: gis_osm_buildings_a_free; Overlay layer: 

“BovenGeul_20m_31370”), export as “gis_osm_buildings_31370” with EPSG 31370. 

2. Make sure the result only covers the Belgium part of the Boven Geul catchment 
Vector => Geoprocessing Tools => Difference (Input layer: gis_osm_buildings_31370; Overlay layer: 

“BovenGeul_Germanpart”), export as “gis_osm_buildings_BelgiumBG_31370”. 

 

Prepare the building shapefile for the German part of the Boven Geul catchment (in QGIS) 

3. Clip the building shapefile of Köln Municipality to the German part of the Boven Geul 

catchment. 
Vector => Geoprocessing Tools => Clip (Input layer: gis_osm_buildings_a_free; Overlay layer: 

“BovenGeul_Germanpart”), export as “gis_osm_buildings_GermanBG_31370” with EPSG 31370. 

 

Combine both building shapefiles into one complete building shapefile of the Boven Geul catchment 

(Figure 9.21) 

4. Combine both layers in QGIS: 
Geoprocessing Tools => Union (Input layer: “gis_osm_buildings_BelgiumBG_31370”; Overlay layer: 

“gis_osm_buildings_GermanBG_31370”), export as “gis_osm_buildings_BG_31370” (rename “Buildings_BG”) 
 

 
Figure 9.21. Building Map of the Boven Geul Catchment. 
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Appendix B.7: Preparation of the Roads Map 

Figure 9.22 shows the flowchart of the creation of the roads map of the Boven Geul Catchment. The 

detailed steps are described below. 

 
Figure 9.22. Flowchart of the Creation of the Roads Map of the Boven Geul Catchment. 

Prepare the roads shapefiles for the Belgium and German part of the Boven Geul catchment (in QGIS) 

1. This is done in the same way as for the building shapefiles (see the previous section), resulting 

into “gis_osm_roads_BelgiumBG_31370.shp” and “gis_osm_roads_GermanBG_31370.shp”. 

 

Combine both roads shapefiles into one complete roads shapefile of the Boven Geul catchment 

2. Merge both vector layers in QGIS: 
Data Management Tools => Merge Vector Layers (Input layers: “gis_osm_roads_BelgiumBG_31370”, 

“gis_osm_buildings_GermanBG_31370”), export as “gis_osm_roads_BG_31370” 

 

Create a new shapefile consisting only of the roads with a road class shown under ‘Included’ in TTable 

9.4 (in QGIS) 

3. Select the corresponding features of the “gis_osm_roads_BG_31370” shapefile and export this 

as “gis_osm_roads_BG_31370_selection”. 
Select features using an expression: 

'fclass='cycleway' OR "fclass"='footway' OR "fclass"='living_street' OR "fclass"='motorway' OR 

"fclass"='motorway_link' OR "fclass"='pedestrian' OR "fclass"='primary' OR "fclass"='residential' OR 

"fclass"='secondary' OR "fclass"='service' OR "fclass"='steps' OR "fclass"='tertiary' OR 

"fclass"='unclassified' OR “fclass” = ‘footway’ OR “fclass” = ‘pedestrian’ OR “fclass” = ‘steps’ 

Then “invert feature selection”, and export the selected features as “gis_osm_roads_BG_31370_selection” 

 
Table 9.4. Overview of the included and not included road classes in the road shapefile of the Boven Geul. 

Road Shapefile Boven Geul: road classes 

Included Not Included 

Cycleway, living_street, motorway, 

motorway_link, primary, residential, secondary, 

service, tertiary, unclassified 

Bridleway, footway, path, pedestrian, steps, 

track, track_grade1, track_grade2, track_grade3, 

track_grade4, track_grade5 

 

Convert the roads shapefile from a line file to a polygon file with the use of the road widths 

corresponding to each road class (see Table 9.5) (in QGIS) 
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4. Add a ‘Roadwidth’ column containing the road width corresponding to each feature (dependent 

on the road class). 
In the attribute table of “gis_osm_roads_BG_31370_selection” add a column (‘Roadwidth’, integer) with the field 

calculator using the following expression: 

case 

when fclass = 'cycleway'then 2 

when fclass = 'unclassified' then 4 

when fclass = 'living_street' or fclass = 'residential' or fclass = 'service' then 5 

when fclass = 'secondary' or fclass = 'tertiary' then 6 

when fclass = 'motorway_link' or fclass = 'primary' then 8 

when fclass = 'motorway' then 11 

else 0 

end 

5. Add a ‘Buffer’ column in the attribute table that is half of the road width (a buffer around a line 

goes in two directions) 
Add a column ‘Buffer’ (decimal number with precision 1) with the field calculator and the following expression: 

Roadwidth/2 

6. Add the buffers around the roads with the use of this ‘Buffer’ column (Result: Figure 9.23). 
Vector => Geoprocessing Tools => Buffer (Layer: “gis_osm_roads_BG_31370_selection”; Distance: Field type 

‘buffer’; End cap style: flat; Join style: round; dissolve result: yes), export as “Roads_BG” 

 
Table 9.5. Overview of the Estimated Average Road Widths per Road Class. Based on distance measurements in QGIS with 

Google Satellite. 

Road Class Roadwidth (m) 

Cycleway 2 

Living_street 5 

Motorway 11 

Motorway_link 8 

Primary 8 

Residential 5 

Secondary 6 

Service 5 

Tertiary 6 

Unclassified 4 

 

 
Figure 9.23. Roads Map of the Boven Geul. 
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Appendix B.8: Preparation of the (Other) Hard Surfaces 

Map 

Figure 9.24 shows the flowchart of the creation of the other hard surfaces map of the Boven Geul. Table 

9.6 shows the determined NDVI values per type of area within the Built-Up LULC class. The threshold 

value of 0.35 is determined based on these values. 

 

 
Figure 9.24. Flowchart of the Creation of the Other Hard Surfaces Map of the Boven Geul. 

 
Table 9.6. Average NDVI values and the range of NDVI values per type of built-up area. Based on manually sampling NDVI 

values of 20 pixels per built-up area type with the help of QGIS, Google Satellite and the NDVI Map. 

Type of area within Built-

Up LULC class 

Average NDVI Value Range of NDVI values 

Parking lots 0.19 0.08 – 0.31 

Roads/sidewalk/buildings 0.18 0.07 – 0.32 

Cemeteries 0.20 0.17 – 0.28 

Green gardens 0.61 0.41 – 0.72 

Grass 0.65 0.36 – 0.76 

 

Prepare the NDVI map and create the initial hard surfaces map 

Prepare the NDVI map at the original resolution (10m) (in QGIS) 

1. Reproject the NDVI map to EPSG 31370 at the same resolution (10m) 
Raster => Projections => Warp (Reproject), (from EPSG 32631 => EPSG 31370; resolution: 10m), export as 

“NDVI_20210721_31370_10m.tif” 

2. Clip the NDVI map to the boundaries of the Boven Geul catchment 
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Clip Raster by Mask Layer (input: “NDVI_20210721_31370_10m.tif”; mask layer: “BovenGeul_20m_31370”; 

Check box: keep resolution of input raster), export as “NDVI_20210721_31370_10m_BG” 

 

Convert NDVI map to an initial hard surfaces map (in QGIS) 

3. Create an NDVI map with values only at the LULC class Built-Up area (code: 101) (no data 

value: -1). 
Raster Calculator, expression: 

if("Landuse_parcel_BG_raster@1"=101,"NDVI_20210721_31370_10m_BG@1",-1) 

 Export as “NDVI_20210721_31370_10m_BG_builtup” 

4. Classify the hard surfaces with value 1 (NDVI value between 0 and 0.35). The other part (NDVI 

> 0.35 and no data values (-1)) of the Boven Geul catchment gets value 0. The result is the 

initial hard surfaces map at 1m resolution (see Figure 9.25a). 
Raster calculator, expression: 

if ("NDVI_20210721_31370_10m_BG_builtup@1" > 0 AND 

"NDVI_20210721_31370_10m_BG_builtup@1" <= 0.35,1,0) 

 Export as “hardsurf1_1m.tif” (with 1m resolution) 

 

Prepare the roads and buildings shapefiles in order to subtract them from the initial hard surfaces 

map 

Adjust the roads and buildings shapefiles such that they cover the entire Boven Geul catchment area (in 

QGIS) 

5. Make a ‘Difference’ shapefile between the roads shapefile (“Roads_BG”) and the Boven Geul 

catchment shapefile 
Vector => Geoprocessing Tools => Difference (Input: “BovenGeul_20m_31370”, Overlay layer: “Roads_BG”) 

6. Merge the ‘Difference’ shapefile with the roads shapefile 
Merge Vector Layers (Input layers: “Roads_BG”, “Difference”), export as “roads_extentBG” 

7. Repeat steps 5 and 6 for the buildings shapefile (“Buildings_BG”), leading to 

“Buildings_extentBG” 

 

Rasterize the roads and buildings shapefiles 

8. Add a ‘raster’ column to the roads shapefile (“roads_extentBG”) with value 2 for the roads and 

value 1 for the other part of the Boven Geul catchment. 
In attribute table, field calculator: add ‘raster’ column (integer) with expression ‘2’. Replace the ‘difference’ part 

with value ‘1’ (rasterizing does not work with zero values) 

9. Rasterize this roads shapefile at 1m resolution. 
Raster => Conversion => Rasterize (Field to Use for Burn-In Value: ‘Raster’; Output Raster Size Units: 

georeferenced units; Resolution: 1m), export as “roads_raster_1m” 

10. Subtract one from the resulting roads shapefile 
Raster Calculator, expression: "roads_raster_1m@1"-1 (result: “roads_raster_1m_01”) 

11. Repeat steps 8-10 for the buildings shapefile (“Buildings_extentBG”), leading to 

“buildings_raster_1m_01”. 

 

Create the final hard surfaces map 

Subtract the buildings and roads shapefiles from the initial hard surfaces map (in QGIS) 

12. Subtract in Raster Calculator: 
"hardsurf1_1m@1"-"buildings_raster_1m_01@1"-"roads_raster_1m_01@1" 

(export as “hardsurf2_1m”) 

13. Reclassify the values of this map to hard surfaces (value 1) and the rest (values 0 and -1 to value 

0). This is the final hard surfaces map at 1m resolution (see Figure 9.25b) 
Raster Calculator: if ("hardsurf2_1m@1"=1,1,0), export as “hardsurf3_1m” 

 

Resample the hard surfaces map to 20m resolution and calculate the hard surface fraction per cell (in 

QGIS) 

14. Resample to 20m resolution using the sum of the pixels 
Tool: r.resamp.stats (Input raster layer: “hardsurf3_1m”; Aggregation method: sum; Extent: Calculate from layer 

“BovenGeul_20m_31370”; Resolution: 20m), export as “hardsurf_resampled_20m” 

15. Calculate the hard surface fraction per cell by dividing by 400 (= cell area 20x20m). 
Raster Calculator, expression: "hardsurf_resampled_20m@1"/400  

Export as “hardsurf_frac_20m” 
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16. Convert from tif to map file in Nutshell. This is the final hard surfaces map which is used in 

the OpenLISEM Database (see Figure 9.25c). 
pcrcalc hardsurf.map = hardsurf_frac_20m.tif 

 

 
a 

 
b 

 
c 

Figure 9.25. Different versions of the Hard Surfaces Maps. (a) shows the Initial Hard Surfaces Map before the subtraction 

of buildings and roads, (b) the Final Hard Surfaces Map at 1 meter resolution, (c) the resampled Final Hard Surface Map at 

20 meter resolution that is used for the OpenLISEM schematization. 

Appendix B.9: Preparation of the Rainfall Files of the 

Boven Geul 

Figure 9.26 shows the flowchart of the creation of the rainfall files of the Boven Geul. It exists of two 

parts: (1) extracting GeoTIFF files from the NC file, and (2) preparing these GeoTIFF files for the 

Boven Geul Catchment. The coming sections provide a detailed explanation of both parts. 

 

Convert the KNMI Radar Rainfall NC File to Rainfall Raster Files (GeoTIFF) 

The KNMI Radar Rainfall File is an NC file consisting of hourly radar rainfall data of 2019-2021 within 

the boundaries of the Geul catchment. OpenLISEM needs a rainfall raster file per timestep. This 

conversion is done in Jupyter Notebook (Python 3) by using the script shown in Table 9.7. 

 

First, the NC file is opened (line 5) and the rainfall dataset from the NC file is selected (line 6). Lines 

8-15 then iterate over each timestep and convert the corresponding rainfall data to a raster file 

(GeoTIFF). This is done for the timesteps from 13 July 0.00 until 17 July 0.00 (Line 9). Lines 10-11 

adjust the time string such that it can be used in the output filename of the raster file (line 12). 

 

This results in 96 GeoTIFF files (4 days of 24 hours), Figure 9.27 shows the result for 14 July 9.00. 
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Figure 9.26. Flowchart of the Creation of the Rainfall Files for the Boven Geul Catchment. 

 

Table 9.7. Python Script used to extract the rainfall tif files from the nc file. 

Python script: extraction of rainfall tif files from nc file 
1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

 

import xarray as xr 

import rioxarray as rio 

import datetime 

 

ds2 = xr.open_dataset(C:/FILEPATH/inmaps-era5-hourly-2019-2021_mak_knmiP.nc') 

bT = ds2['precip'] 

 

for i in range(bT.shape[0]): 

    if i>=22168 and i<=22264: #22168 = 13 July 0.00; 22264 = 17 July 0.00  

        timest = time[i].values.astype(str) 

        timestr = timest.replace("-", "").replace(":", "").replace(".", "").replace("T","") 

        output_filename = f"inmaps-era5-hourly-2019- 2021_mak_knmiP/Extracted/precip{timestr}.tif" 

     

        rr = bT[i,:,:]     

        rr.rio.to_raster(output_filename)   

 

print('done') 

 

Prepare the Rainfall Raster files for the OpenLISEM Database of the Boven Geul catchment 

The KNMI Radar Rainfall files for the Geul catchment do not completely cover the boundaries of the 

Boven Geul catchment (see Figure 9.27). The missing values are defined by using the windowaverage 

function in Python. This is done by adjusting the standard python script file (lisRainfall.py) of the 

OpenLISEM Database Generator. Table 9.8 shows the lines that are added.  

 

Other mutations that are done in this script are reprojection (EPSG 4326 to 31370), changing the 

resolution (20m) and clipping the rainfall files to the extent of the Boven Geul catchment (= rectangle 

around the Boven Geul boundaries). The right picture in Figure 9.28 shows the resulting rainfall file 

which will be used in OpenLISEM. A comparison with the original rainfall file (left picture of Figure 
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9.28) shows that almost all values are the same, except for the missing values which are filled by a 

window average. 

 

 
Figure 9.27. Extracted KNMI Radar Rainfall GeoTIFF File for 14 July 9.00-10.00. 

 
Figure 9.28. KNMI Radar Rainfall at 14 July 9.00-10.00. The left picture shows the original extracted GeoTIFF file. The 

right picture shows the rainfall file that is adjusted by the Database Generator. 

Table 9.8. The lines that are added to the rainfall python file of the Database Generator (LisRainfall.py) to fill the missing 

values with a window average. 

159 

160 

161 

162 

163 

164 

165 

166 

167 

168 

169 

for link in hdflinks: 

     if link[-3:] == 'tif': 

          filename = link[:-4]+".map" 

          gpmoutName = rainOutputdir+filename 

                 

          map_ = scalar(readmap(gpmoutName))        # rainfall file (already adjusted by previous lines in this script) 

          map2 = ifthen(map_ < 1e5,map_)                       # selecting the defined values (1e5 is the no data value) 

          mapavg = windowaverage(map2,1100)              # with 1100, the entire Boven Geul catchment is covered 

          map3 = ifthenelse(map_ < 1e5,map_,mapavg) # take map2 and add the windowaverage at missing value places 

                 

           report(map3,gpmoutName) 
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Appendix C – Calibration Process 
 

Appendix C.1 – Important Steps in the Calibration 

Process 

Table 9.9 shows the parameterization of the important steps in the calibration process of the 

OpenLISEM schematization. The (relative) values of the most important calibration parameters 

illustrate the difference between the calibration step and the best calibration. These steps are not a 

complete representation of all the specific calibration steps, but they demonstrate the most important 

decisions that are taken in the calibration process. 

 
Table 9.9. Parameterization of the important steps in the calibration process of the OpenLISEM schematization. The Ksat of 

Soil Layers 1 and 2 is shown as a factor relative to the best calibration. 

Calibration Step Relative Ksat of 

Soil Layers 1 and 

2 (factor*) (-) 

Depth of Soil 

Layer 1 (cm) 

Initial Soil 

Moisture 

Content** (-) 

Channel 

Manning’s n (-) 

Step 1  0.5 60 cm 0 (FC) 0.05 

Step 2 0.5 40 cm 0 (FC) 0.05 

Step 3 0.5 40 cm 0.5 0.05 

Step 4 1 40 cm 0.5 0.05 

Best Calibration 1 40 cm 0.5 0.1 
* The Ksat maps of both Soil Layers are multiplied with this factor.  

** The Initial Soil Moisture Content in OpenLISEM is displayed as a relative value between -1 and 1, in which -1 equals the 

Wilting Point, 0 the Field Capacity (FC), and 1 Saturation. 

 

Figure 9.29 shows the discharge curves of the initial steps in the calibration process. The measured 

discharge is displayed as a reference by an orange dashed line. At first, the calibration started with a 

relatively small Ksat, a larger Soil Depth of layer 1, an Initial Soil Moisture content equal to Field 

Capacity, and a smaller Channel Manning’s n (see Table 9.9). It was not clear yet which parameters 

would give an accurate calibration and the idea was to simulate the large amount of runoff by using a 

relatively low Ksat. Resulting into a lot of Hortanian Overland Flow. The discharge curve of this initial 

calibration (yellow line in Figure 9.29) results in a peak discharge that is quite comparable with the 

peak discharge of the measured discharge. However, the discharge peaks before are not well captured 

and the total amount of runoff is much too small. Further decreasing the Ksat did not make the 

calibration any better.  

 

The measured discharge shows increasing discharge peaks over time, while the rainfall intensities do 

not become worse. Thereby, there seems to be some ‘memory’ between the discharge peaks as the 

discharge levels do not return to low discharge levels after a peak. The most important decision made 

in the calibration process to get similar patterns as the measured discharge is exploring the effect of 

Saturation Overland Flow on the discharge curve. This is first done by decreasing the Soil Depth of the 

topsoil (Step 2) and then by significantly increasing the Initial Moisture Content to a value halfway 

between Field Capacity and Saturation (Step 3) (see Table 9.9). In this way, the soil will saturate more 

quickly, leading to higher initial peaks. The focus with the Saturation Overland Flow is on the topsoil, 

since the total storage capacity of both soil layers is probably large enough to store the 175.5mm of 

rainfall. The discharge curve of Step 2 (green line in Figure 9.29) demonstrates a significant increase in 

some of the discharge peaks before the absolute peak. The increase in Initial Moisture Content has the 

largest effect and the discharge curve (purple line in Figure 9.29) shows a similar increase in discharge 

peaks as the measured discharge curve. Saturation of the topsoil seems to be the process that results 

into a discharge curve that has similar patterns as the measured discharge. 
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Figure 9.29. Discharge Curves of the Initial Steps in the Calibration Process. The Measured Discharge is shown in Orange 

(dashed). The Parameterization of the Calibration Steps is shown in Table 9.9. 

Figure 9.30 shows the discharge curves that illustrate the last choices in the calibration process. The 

discharge curve of step 3 (purple) shows similar patterns as the measured discharge curve (orange 

dashed). However, the discharge peaks are much higher. Because the Saturation Overland Flow seems 

to be more crucial than the Hortanian Overland Flow in achieving a proper calibration, the decision has 

been made to increase the Ksat in step 4 (see Table 9.9). This decision is also influenced by the presence 

of a lot of high Ksat values in the laboratory results. The resulting discharge curve (blue-green) shows 

discharge peaks that are more comparable with the measured discharge curve. One small downside is 

that the first peak (at 194.8) almost vanishes. There is probably a small overestimation of the infiltration 

at the start of the event. 
 

The last step is to increase the Channel Manning’s n from 0.05 to 0.1 to enlarge the delay in the water 

system. This decision is very important in simulating the ‘memory’ and the wide peaks that are present 

in the measured discharge curve. Apparently, there is some significant delay present in the water system 

of the Boven Geul. It leads to the discharge curve of the best calibration, shown in blue in Figure 9.30. 
 

 
Figure 9.30. Discharge Curves of the Last Steps in the Calibration Process. The Measured Discharge is shown in Orange 

(dashed). The Parameterization of the Calibration Steps is shown in Table 9.9. 
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Appendix C.2 – Impact of Important Calibration 

Parameters on the Discharge Curve 

Figure 9.31 shows the discharge curves demonstrating the impact of the Ksat on the discharge curve. 

The green curve illustrates the effect of an increase of the Ksat of both soil layers with a factor 2. The 

red curve illustrates the effect of a decrease of the Ksat of both soil layers (Ksat multiplied by 0.5). The 

decrease in Ksat leads to an increase in discharge levels, particularly for the first peak of the event (at 

194.8). During this peak, most of the water still infiltrates into the soil for the Best Calibration. The 

decrease in Ksat results into more runoff. During the extreme discharge peaks, the lower Ksat does 

result in slightly higher peaks, but not significantly higher. This is because the topsoil is largely 

saturated at that time, making the infiltration rate (Ksat) less impactful. 

 

The increase in Ksat leads to more infiltration and thus a decrease in discharge levels. Remarkable is 

that it mainly decreases the peaks in the first half of the event (until 196). The absolute discharge peak 

is still very comparable with the Best Calibration. The lower Ksat has a significant impact during the 

period when the topsoil is not yet saturated (dominantly Hortanian Overland Flow). However, its 

effectiveness decreases once the topsoil becomes saturated and Saturation Overland Flow dominates.  

 

Both an increase and decrease in Ksat would not benefit the calibration, since it either results in a further 

increase of the discharge peaks or in a significant decrease of the discharge peaks during the first half 

of the event. 

 
Figure 9.31. Discharge Curves demonstrating the impact of the Ksat on the Discharge Curve. The green and red curve show 

the effect of an increase and decrease of the Ksat respectively. The Ksat of both soil layers is multiplied with the factor 

displayed in the legend (2: increase; 0.5: decrease). 

Figure 9.32 displays the discharge curves demonstrating the impact of the Channel Manning’s n on the 

discharge curve. The yellow curve shows the discharge curve when the Channel Manning’s n would be 

0.05, instead of 0.1 for the best calibration. The Channel Manning’s n has a substantial impact on the 

discharge curve. It significantly increases the delay of the water flow which results into wider peaks 

and more ‘memory’ in the discharge curve. 
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Figure 9.32. Discharge Curves demonstrating the impact of the Channel Manning’s n on the Discharge Curve. The yellow 

curve shows the discharge curve in case the Channel Manning’s n has a value of 0.05 instead of 0.1. 

Figure 9.33 shows the discharge curves demonstrating the impact of the Initial Soil Moisture Content 

on the discharge curve.  The Initial Moisture Content is represented as an effective moisture content in 

which 0 equals Field Capacity and 1 equals Saturation. The effective Initial Moisture Content is halfway 

between Field Capacity and Saturation (0.5). The dark blue curve shows the effect of an increase of the 

effective Initial Moisture Content (0.75). This causes the topsoil to saturate more quickly, resulting in 

higher discharge levels. The most remarkable difference with the Best Calibration (blue) is the huge 

increase of the first two discharge peaks. This is because the higher Initial Moisture Content causes the 

topsoil to saturate already in the first part of the event, leading to a significant amount of Saturation 

Overland Flow from the beginning. Which is not the case for the Best Calibration. The extreme 

discharge peaks are only slightly higher compared to the Best Calibration, since in both cases most of 

the topsoil is saturated. 
 

The green curve in Figure 9.33 shows the effect of a decrease of the effective Initial Moisture Content 

(0.25). This decrease has a substantial impact on the first part of the discharge curve (until 196). Due to 

the lower Initial Moisture Content, it takes longer for the topsoil to become saturated, resulting in much 

less Saturation Overland Flow during this period. The absolute discharge peak (at 196.25) is quite 

comparable because then the largest part of the topsoil is saturated for both calibrations. 
 

Both an increase and decrease in Initial Moisture Content would not benefit the calibration, since it 

either results in a further increase of the discharge peaks or a significant decrease of the discharge peaks 

in the first half of the event. 
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Figure 9.33. Discharge Curves demonstrating the impact of the Initial Soil Moisture Content on the Discharge Curve. The 

dark blue and green curve show the effect of an increase and decrease of the effective Initial Soil Moisture Content 

respectively. The Initial Moisture Content is represented as an effective moisture content in which 0 equals Field Capacity 

and 1 equals Saturation. 

 

 

 

  



118 

 

Appendix D – Detailed Description of 

Changes in the Input Data in the LULC 

Scenarios  
Table 9.10. Description of the Changes in Input Data between the LULC Scenarios and the Reference Scenario. 

 Changes in input data compared to the Reference Scenario 

Forest Scenario • LULC Map: all cropland and grassland in the original LULC map is turned 

into forest. 

• NDVI Map: the NDVI map is not usable here and thus not used. Instead of 

this, a LULC based plant cover has been used (0.95 for forest, from (Jetten, 

2022)) 

 

Paved Scenario  • LULC Map: the entire LULC map is turned into built-up area (important for 

the surface roughness) 

• NDVI Map: the NDVI map is not usable here and thus not used.  

• (Other) Hard Surfaces Map: this map is adjusted such that it consists of hard 

surfaces at all places except for the building and road locations, since these 

are already represented in the building and road maps. 

• OpenLISEM Infiltration: in OpenLISEM the option “No Infiltration” is 

selected instead of the Green & Ampt Infiltration Model to really make sure 

there will be zero infiltration. 
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Appendix E – Photos of Dam Locations 
Figure 9.34 shows Google Earth Photos of Dam Locations 1, 2, 3, 4 and 7. Upstream and downstream 

indicates what the upstream part and downstream part of the channel relative to the dam. Dam locations 

5 and 6 are not included since Google Earth is not very clear at these locations. 

 
Dam Location 1 

 
Dam Location 2 

 
Dam Location 3 

 
Dam Location 4 

 
Dam Location 7 

Figure 9.34. Google Earth Photos of Dam Locations 1, 2, 3, 4 and 7. 

Table 9.11. Approximate Storage Capacities of the different Dams in m3. Estimated based on the DEM. 

Dam Location 1 2 3 4 5 6 7 Mean 

Approximate Storage Capacity 

[m3] 

8680 46159 21528 1700 12102 5998 13006 15596 
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Appendix F – Semi-Structured Interviews 

Appendix F.1 – Questions of the Semi-Structured 

Interviews 

Main questions at the start of the research 

• How does the water management structure in Wallonia work? What parties are involved and 

who is responsible for what tasks? 

• Where is water management in Wallonia mainly focused at? (e.g., water quality or quantity) 

Did this change after the flash flood event of July 2021? 

• How severe was the flooding in the Boven Geuldal Belgium during the flash flood event of 

July 2021? Where did flooding occur? 

• What actions were taken after the flash flood event of July 2021? What type of mitigation 

measures are you considering? 

• Do you have any idea why there was so much outflow from the Boven Geul catchment? 

• Do you know something about the soil depth within the Boven Geul? And whether there is any 

drainage system present? 

 

End of the research (related to the proposed dam strategies) 

• Who is the owner of the land at the dam locations? 

• What is needed to implement these kinds of measures? 

• Are you allowed as a municipality to implement these kinds of measures (referring to the dam 

strategies)? 

• Are there already other measures implemented in your area since the flash floods of 2021? 
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Appendix F.2 – Elaborated Results of the Semi-Structured 

Interviews 

This information is based on meetings with civil servants from the Municipality of Raeren and Kelmis 

(both in Dec 2022 and Oct/Nov 2023), and a water expert from Contrât Rivière Meuse Aval (Local 

Comité La Gueule) (in Dec 2022). 

 

Water Management in Wallonia 

The water management structure in Wallonia is significantly different from the structure in the 

Netherlands. This structure is already explained in Section 3.2 and complicates water management 

because different parties are responsible for different parts of the river, and they are not very well-

informed about each other’s activities. Thereby, the different languages that are spoken (German, 

French, Dutch) in this area make cooperation more difficult.  

 

According to a water expert from Contrât de Rivière (Local Comité la Gueule), the water management 

in the Belgium part of the Geul is mainly focused on water quality rather than water quantity. There are 

still a lot of issues regarding water quality, especially regarding wastewater. Sewerage is lacking in 

many areas, causing untreated water to flow into the Geul. This is, for example, the case in the villages 

of Einraten and Hausen in the Boven Geul catchment according to a civil servant from the Municipality 

of Kelmis. Local Comité La Gueule aims to improve problems around the river by connecting the 

different stakeholders. They try to reduce waste and trash in the Geul, fix unsafe bridges and improve 

erosion problems. 

 

The water expert from Local Comité La Gueule mentioned that there are several new laws regarding 

water management for Wallonia (since 2018/2019). The first being that farmers should have at least 6 

metres of permanent vegetation between their cropland and the river channel. Thereby, there is a new 

law that mandates new buildings to infiltrate or store rainfall water on their plot. 

 

July 2021 Flood Event in the Boven Geuldal Belgium 

According to the water expert from Local Comité La Gueule, there was not a lot of flooding in the 

Boven Geuldal Belgium. There was some severe flooding downstream in the Beneden Geuldal Belgium 

in Moresnet (30-50 buildings or more with flooding at the first floor). Within the Boven Geuldal 

Belgium, the expert mentioned only two locations where flooding occurred: (1) a severely flooded street 

in Kelmis close to the Tuljebach (picture 3 in Figure 3.9) and (2) the confluence of the main branches 

of the Boven Geul close to the outlet point (pictures 1 and 5 in Figure 3.9). 

 

The civil servant from the Municipality of Kelmis mentions the same two locations. The first location 

only experienced severe flooding of the street, no houses were affected. The second location close to 

the outlet point was more problematic. The four houses located here were all flooded with at interior 

water levels of at least 40 centimetres. One house even experienced interior water levels of 50-60cm. 

These houses had already been flooded during a previous flood in 2016, but this time, the flooding was 

much more severe. The civil servant also mentioned an old mill that was flooded during the July 2021 

event due to the runoff of rainfall (not channel overflow), and inundated gardens close to the river 

channel. Particularly the Tuljebach resulted in a lot of inundated gardens since this narrow stream runs 

through the gardens of houses. Also a lot of grassland close to the Boven Geul river inundated, but 

according to the civil servant the farmers are used to this kind of inundation during rainy winters. 

Additionally, there was some significant flooding in the Casinostrasse (picture 6 in Figure 3.9). The 

street completely flooded and the bridge under which the Tuljebach flows was severely damaged. There 

was no damage to houses. The civil servant also did not know of other houses that were damaged within 

the Boven Geul catchment, apart from the 4 houses close to the outlet point. Directly downstream of 

the outlet point, there was some other significant flooding of the Geul which caused damage to the 

riverbanks and houses. 
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The civil servants of the Municipality of Raeren pointed out that they had some flooding problems 

during the event. They were quite surprised, because they never thought it would be possible since they 

are at the start of both the Geul and Vesdre. The most critical points for them were in the village of 

Raeren, which is outside the Boven Geul catchment boundaries. They mentioned only one location 

within the Boven Geul catchment at which flooding occurred: the Eupenerstrasse in Eynatten along the 

Göhl. A lot of water came from the maize land and entered the road. At the place where two channels 

merge, there was a lot of water causing problems. These problems consisted of a flooded road and also 

some flooded basements. No houses were affected. 

 

Actions and measure related to July 2021 Flood Event in the Boven Geuldal Belgium 

According to the water expert from Local Comité La Gueule there were not a lot of measures related to 

water quantity. The July 2021 Flood Event changed this and now things are moving. The municipalities 

want to take actions. After the event, the Walloon region gave every municipality a little bit of money 

to take direct action for prevention of flooding. This amount was dependent on the amount of damage 

and whether the municipalities had a plan. The civil servant of the Municipality of Kelmis mentioned 

that a lot of residents were used to inundation to a certain extent, but not this extreme. The event made 

them consider to implement measures. 

 

In December 2022 (first meetings), both the Municipalities of Kelmis and Raeren had not taken yet any 

measures. The Municipality of Raeren was about to cooperate with the University of Aachen for a study 

related to flooding measures. In October 2023, the study has been finished and according to the civil 

servant of the Municipality of Raeren their political persons are about to decide what measures they 

want to implement. This study focused mostly on local flooding problems within the village of Raeren 

(which is outside the Boven Geul) and the critical situation along the Eupenerstrasse. They propose 

measures such as water retention basins. The Municipality of Kelmis also mentioned that they want to 

explore the possibility of implementing water retention basins. The main problem in the implementation 

of measures is however money (both mentioned by Local Comité la Gueule as well as the Municipality 

of Kelmis). 

 

In November 2023, the Municipality of Kelmis is about to officially start an international cooperation 

with the Dutch neighbors (Geul municipalities) to carry out a large-scale study, which includes work to 

prevent flood disasters in the future.  

 

Feasibility of the Implementation of the Dam Strategies 

 

Willingness of the municipalities to implement measures that reduce effects downstream 

The civil servants of both municipalities mentioned that they also feel responsible for flooding problems 

downstream and that they are willing to cooperate with measures that reduce these effects. They 

highlight that this is important since they are a part of a catchment and water does not stop at the 

(municipal) border. Thereby, they are very interested in this research and the effects of the proposed 

measures.  

 

Owners of the land at the dam locations 

The land at Dam Locations 3 and 7 is owned by farmers according to the civil servant from the 

Municipality of Raeren. The rivers are not their property, but the adjacent land is. The land consists of 

grassland which is probably used to produce grass to use as food for the cows. In general, the contact 

between the Municipality of Raeren and farmers is good. There is always someone that knows the 

landowner/farmer, or someone who is living next there. The willingness to cooperate mainly depends 

on the age of the farmers. The younger farmers are generally more willing to cooperate than the older 

farmers. 

 

Dam Location 1 (Municipality of Kelmis) is the responsibility of the forestry administration. Dam 

Location 4 is probably privately owned. 
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Actions that are needed to successfully implement the dam strategies 

 

The parties that should be included in the implementation process are the following: 

• The landowners should be contacted and included in the process. Their agreement is needed to 

be able to implement the dam strategies. There should be a financial compensation for the 

landowners.  

• The municipality is not allowed to individually implement these kinds of measures. Therefore, 

all relevant authorities should be included in the process. Which are the Province of Liege 

(responsible for measures in Category 2 rivers), Walloon Region (responsible for the course of 

the river), other municipalities and the landowners.  

 

Several actions were mentioned to be important for the success of the implementation 

• Cooperation between all relevant authorities. 

• Early and transparent communication with the landowners. 

• Compensation for landowners. 

• There should be sufficient money: this is always an issue; someone needs to take responsibility 

and take the lead. 

 

The civil servant of the Municipality of Raeren specifically mentioned that the agreement of the 

landowners depends primarily on transparent and good communication. 

 

 

Other 

 

Drainage Systems 

The water expert of Local Comité La Gueule mentioned that a very long time ago this area was 

completely different and consisted of a lot of wetlands. Over time, agriculture took over and it is likely 

that they used a lot of drainage systems. The civil servants of the Municipality of Raeren and Kelmis 

confirm that there are some drainage systems. It is however not known how much drainage is present 

and whether these systems still function. Thereby, some grasslands between Helgenrath and Kelmis 

have a very thin soil (20-30cm) where no drainage systems fit at all. 

 

Soil Depth 

The civil servants of both municipalities do not have information about soil depths within the Boven 

Geuldal Belgium. The civil servant of the Municipality of Kelmis only mentioned that the soil close to 

the Geul and under some grasslands is very shallow (20-30cm). But that there are also locations where 

it is deeper. The civil servant of the Municipality of Raeren mentioned that in the village of Raeren they 

have problems with working on pipes in the ground because in some parts they have a very rocky 

underground. They can not tell if this is also applicable for areas in the Boven Geuldal Belgium. 
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Appendix G – Overview of the Soil Sample 

Results 
Table 9.12. Soil Sample Values of the Maize Samples. 

Maize 

Sample nr Ksat (mm/h) Dry density (kg/m3) Porosity (-) SOM 

1 3.28 1139.7 0.51 7.5% 

3 0.01 1361.2 0.48 6.5% 

4 1.19 1170.8 0.52 5.9% 

5 11802.30 1040.4 0.49 7.4% 

6 135.48 910.3 0.59 12.9% 

7 8710.90 1089.5 0.53 8.5% 

8 0.22 1058.2 0.57 8.1% 

9 0.13 1283.8 0.48 5.1% 

11 7164.61 1066.6 0.51 6.3% 

12 193.60 1107.2 0.50 5.5% 

16 2457.56 1074.9 0.51 4.9% 

17 0.21 1175.9 0.54 5.3% 

18 807.10 1067.6 0.50 6.0% 

19 8.05 1117.4 0.53 5.3% 

29 4703.83 1037.2 0.53 5.7% 

 
Table 9.13. Soil Sample Values of the Grassland Samples. 

Grassland 

Sample nr Ksat (mm/h) Dry density (kg/m3) Porosity (-) SOM 

2 1.9 955.8 0.60 11.1% 

10 0.8 1036.5 0.56 8.0% 

13 0.9 956.7 0.59 8.4% 

14 228.7 917.0 0.60 10.4% 

15 9.2 974.9 0.60 9.5% 

20 0.2 954.4 0.60 11.8% 

21 3.0 788.0 0.69 11.5% 

25 2.0 1043.4 0.60 8.8% 

26 56.1 1037.7 0.58 8.1% 

30 0.0 1012.8 0.58 10.2% 

31 318.6 1002.4 0.60 12.7% 

32 13.9 922.7 0.62 13.8% 

40 339.9 660.8 0.70 16.9% 

 
Table 9.14. Soil Sample Values of the Forest Samples. 

Forest 

Sample nr Ksat (mm/h) Dry density (kg/m3) Porosity (-) SOM 

22 1002.1 238.9 0.47 66.3% 

23 140.6 270.3 0.44 64.1% 

24 334.7 281.7 0.35 63.3% 

27 6286.6 573.3 0.69 15.5% 

28 772.5 591.1 0.74 15.5% 

36 2472.5 385.3 0.73 35.6% 

37 1045.5 299.0 0.72 58.3% 
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39 621.5 521.0 0.68 23.5% 

41 1275.8 262.5 0.80 62.2% 

42 397.5 619.8 0.68 21.2% 
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Appendix H – Soil Storage Capacity and Level 

of Saturation per LULC Class 

Table 9.15 shows the average soil property values related to the infiltration and storage capacity of the 

soils under Forest, Grassland and Cropland. The average rainfall in the Boven Geul during the event 

was 175.5mm and the maximum intensity of the input rainfall data was 14.4 mm/h. Considering the 

Ksat and total storage capacity of the soils under these LULC classes (see Table 9.15), the soils should 

be able to infiltrate all rainfall. However, Figure 9.35a indicates that a large part of the topsoil (Soil 

Layer 1) gets saturated during the event. The topsoil reaches saturation in 81% of the total area of the 

Boven Geul catchment, which is mostly at places with Built-Up area, Grassland and Cropland. The 

topsoil under Forest only reaches an average saturation percentage of 84.8%14. The topsoil under 

Grassland and Cropland reaches an average saturation percentage of 100%. This is displayed in Table 

9.16. A large part of the runoff is thus caused by the saturation of the topsoil in a very significant part 

of the catchment. The topsoil under Forest does not experience this issue. This could be explained by 

the higher storage capacity and Ksat of the topsoil compared to Grassland and Cropland. The higher 

storage capacity allows for more water to be stored in the topsoil before saturation occurs. The higher 

Ksat facilitates faster percolation of water to the subsoil (Soil Layer 2). 
 

Table 9.15. Average Soil Property values related to the Infiltration and Storage Capacity of the Soil. The values are shown 

per LULC Class (Forest, Grassland, Cropland) and per Soil Layer (1: topsoil, 2: subsoil). 

 Forest Grassland Cropland 

Layer 1 Layer 2 Layer 1 Layer 2 Layer 1 Layer 2 

Ksat (mm/h) 40.5 18.4 19.4 16.6 13.2 15.6 

Initial Moisture Content (-) 0.484 0.448 0.454 0.445 0.434 0.444 

Porosity (-) 0.606 0.542 0.550 0.536 0.518 0.532 

Soil Depth (m) 0.4 2.41 0.4 2.80 0.4 2.72 

Storage Capacity* (mm) 48.7 225 38.4 254 33.5 241 
* Equal to: (Porosity - Initial Moisture Content) * Soil Depth) 
 

 
a 

 
b 

Figure 9.35. Maps Indicating the Level of Saturation of the Soils at the end of the Reference Scenario Simulation. The 

Saturation Percentages14 (0%: Wilting Point; 100%: Saturation) are shown for both Soil Layer 1 (a) and Soil Layer 2 (b) 

 

 
14 The Saturation Percentage is determined by dividing the Soil Moisture Content at the end of the Reference 

Scenario Simulation by the Porosity. 
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Table 9.16. The Average Level of Saturation of the Soils at the end of the Reference Scenario Simulation. The Saturation 

Percentages14 (0%: Wilting Point; 100%: Saturation) are displayed per LULC Class (Forest, Grassland, Cropland). 

 Saturation Percentage 

Forest Grassland Cropland 

Soil Layer 1 84.8% 99.7% 100.0% 

Soil Layer 2 89.4% 84.9% 81.6% 
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Appendix I – Maximum Water Depth Maps 

of the Dam Strategies 

 
Figure 9.36. Maximum Water Depth Map of Dam Strategy 1. 

 
Figure 9.37. Maximum Water Depth Map of Dam Strategy 2. 


